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About this guide

This guide provides service and maintenance information, technical details and configuration guidance
for the HP Z220 SFF, Z220 CMT, Z420, 2620, and Z820 Workstations.

E‘%IMPORTANT: Removal and replacement procedures are now available in videos on
the HP website.

Go to the HP Customer Self Repair Services Media Library at http://www.hp.com/go/sml.

Guide topics

Hardware overview on page 1

System management on page 39

Component Replacement Information and Guidelines on page 77

Diagnostics and troubleshooting on page 115

Configuring password security and resetting CMOS on page 158

Linux technical notes on page 162

Configuring RAID devices on page 166

System board designators on page 178

r__f/?NOTE: View the HP Z220 SFF, Z220 CMT, Z420, Z620, and Z820 Workstation Series User Guide
at http://www.hp.com/support/workstation_manuals.
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1 Hardware overview

This chapter presents an overview of workstation hardware components. It includes these topics:

Topics

HP 7220 SFF Workstation components on page 1

HP 7220 CMT Workstation components on page 8

HP 7420 Workstation components on page 15

HP Z620 Workstation components on page 23

HP 7820 Workstation components on page 30

Environmental specifications on page 37

ENERGY STAR qudlification on page 37

Ensuring proper ventilation on page 38

HP Z220 SFF Workstation components

For complete and current information on supported accessories and components for the workstation,
see http://partsurfer.hp.com.

Topics

HP 7220 SFF Workstation front panel components on page 2

HP 7220 SFF Workstation rear panel components on page 3

HP Z220 SFF Workstation chassis components on page 4

HP 7220 SFF Workstation system board component on page 5

HP 7220 SFF Workstation system board architecture on page 6

Workstation specifications on page 7

HP Z220 SFF Workstation components
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HP Z220 SFF Workstation front panel components

Figure 1-1 Front panel components

Table 1-1 Component description

Optional media card reader (shown)

1 Opfical drive 3 or optional second hard disk drive

Hard drive or optical drive activity
light

2 (I) Power button 6

3 e USB 2.0 ports (4, black) 7

Headphones connector

DR (/

Microphone or headphones connector
4 g:! n (software selectable, default mode is

microphone)
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HP Z220 SFF Workstation rear panel components

Figure 1-2 Rear panel components

a3

)
2

g

E/?NOTE: The labels for the rear panel connectors use industry-standard icons and colors.

Table 1-2 Component descriptions

1 $ RJ-45 network connector 7 1D DisplayPort (DP)

2 lolol Serial port 8 IDI VGA (monitor) (blue)

3 6 PS/2 mouse connector (green) 9 :’su/rf)lz)eyboord connector

4 Power cord connector 10 (G2 Audio line-out connector (green)
5 -~ USB 2.0 ports (2) (back) 11 (('):,4' Audio line-in connector (blue)

6 SS4<-  USB 3.0 ports (4) (blue)

%? NOTE: The DP and VGA ports are not supported when the system is configured with Intel Xeon E3-12x0 v2 processors. Also, if a discrete graphics card

is installed, these ports are disabled by default.

y NOTE: Simultaneous usage of integrated Intel HD graphics and discrete graphics cards (in order to drive more than two displays) can be enabled using

the Computer (F10) Setup Utility. However, HP recommends using only discrete graphics cards when attaching three or more displays.

HP Z220 SFF Workstation components
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HP Z220 SFF Workstation chassis components

For complete and current information on supported accessories and components for the computer, see
http://partsurfer.hp.com.

The following image shows the components of a typical computer layout. Drive configurations can vary.

Figure 1-3 Chassis components

Table 1-3 Component descriptions

1 Access panel 8  Optional media reader or second hard disk drive
2  Memory module (DIMM) 9  Speaker

3  System board 10 CPU

4  Hard disk drive 11 Heatsink

5  Power supply 12  Airflow guide

6  Chassis 13  System fan

7  Optical drive 14  Front bezel

Chapter 1 Hardware overview
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HP Z220 SFF Workstation system board component

The following illustration and table identify computer system board components.

Figure 1-4 System board component locations

®® 29 @329  ®W
| LT 1 T 1
| 1 (9)
| egll i ©
&g 2—1—4) . | | &)
| O[] @ ﬁ
| | = :l-:\J_z)
| - [0EH
| | I:I ﬁ@é»‘ ©
S,
N Memory Sockefs ‘ - ]
21) N fm —~
@8 @ o1 | (32110 ] ®
"_\\ 'I/ ) .2?"“ B —
O B—23 @1 @
cPU o
. (B)
I:,_@'_D l:l "J;r)/’
P
| | 16
] | | \
19 AR
@ (@ I | (1®)
Table 1-4 System board component descriptions
1/0 SATA Power
1 Display Port 13 AHCI 3Gb/s 20 Battery
2  Front audio 14 AHCI 6Gb/s 21 CPU power
3 Front speaker NOTE: Only the port labeled 22  Front power button/LED
eSATA is eSATA compatible.
4  Front USB 2.0 23  Main power
5 Internal USB 2.0 PCl/PCle 24 Power COMM
6  Keyboard/mouse 15 PCle2 x1 25 SATA power
7  Network/rear USB 2.0 16 PCle2 x16 (4) Security
8  Parallel (optional) 17 PCle3 x16 26 Chassis solenoid lock
9 Rear audio 18 PCl32/33 27 Hood sense
10 Rear USB 3.0 NOTE: For related expansion Service
card slot information, see
11 Serial (optional) Expansion slots on page 84 28 Clear CMOS button
12 VGA/serial Cooling 29  Crisis recovery jumper
19 Chassis fan 30 ME/AMT flash override
31  Password jumper

HP Z220 SFF Workstation components



HP Z220 SFF Workstation system board architecture

This section describes the system architectures.
The following figure shows the typical system board block diagram.

Figure 1-5 System board block diagram

Z220 SFF Block Diagram

Last Modified
on:1/11/12
‘ PCle 3.0 x16 }4— (T)— DDR3
g 1600 MHz |
ECC/NonECC
= = = =
Intel Socket EIPNE Il
LGAT155 1 BE
DDR3
ECC/NonECC

Disol FDI DM
CE—— | 1

SATA3.0 |e—(2) —> - (1) > PCI 2.3 |
SATA 2.0 4—(2)_| |_> Intel PCH

Panther Point > PCle 2.0 x1
-l 1 e 2.UX
USB3.0 |« Rear (4) > C216 0 ‘
USB2.0 |l Rear (2) > ) PCle 2.0 x4 w x16 connector ‘
A —p | RJ45
USB 2.0 |« — Front - Cabled (4) Intel
USB 2.0 "- Internal — Cabled (4) Lewisville
Lcl p| NICPHY
Intel HD
128 Mbit| | "
SPI vete
leg— Rear (1)
LPC Audio Codec | |
o Rear (1)
v |— Front Cabled \HP
Serial < () - Front Cabled CAIC

2nd Serial SIO12

leg——— Cabled (1)——p < P2 > KB
MS

Parallel ) fe——— Cabled (1)————p»

gt PS2

2»NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle
lanes routed to an expansion slot. For example, x16(8) means that the expansion slot is mechanically a
x16 length connector, with 8 PCle lanes supported.
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Workstation specifications

HP Z220 SFF

Intel® Series C216 chipset with:

e Support for the Intel® Xeon® Processor E3 v2 Family, third generation Intel Core ™) processors
up to 95W, or Pentium G640

e Integrated 2-channel memory controller

Processor
technology e  Microarchitecture improvements

e Integrated graphics (some models)

e  Advanced Vector Extensions (AVX) to increase floating point performance

e Intel DMI2 interface connecting the processor to the I/O controller

o 240W, 90% efficient, 80 PLUS Gold, compatible with ENERGY STAR Version 5 requirements
Power supply

e  Supports European Union ERP Lot 6 tier2 power limit of less than 0.5W in off mode

e  Dual inline memory modules (DIMMs) based on DDR3 1600MHz technology

e  Supports error checking and correcting (ECC) and non-ECC DIMMs

e  Two direct-attach memory channels enable low-latency access and fast data transfer for improved
Memory performance
technology

e Upto 32 GB system memory (8 GB DIMM:s)
e 1600 MHz 2, 4, 8 GB ECC unbuffered DIMM
e 1600 MHz 2, 4, 8 GB non ECC unbuffered DIMM

Supports:

e  PCle Gen3 (PCle3) bus speeds; can support dual PCle Gen2 graphics cards in mechanical PCle
x16 slots

e  Multiple graphics cards provided their total power usage is within 45W

e  Up to two displays with integrated Intel HD graphics (depending on processor type)

Graphics cards
e  Up to four 2D displays or two 3D displays

NOTE: Most supported Intel Core processors provide Intel HD Graphics 2000/2500/4000; Intel
Xeon processors with model designations that end in "~5" provide Intel HD Graphics P4000.

NOTE: To drive more than two displays, use the Computer (F10) Setup Utility to intermix integrated
Intel HD graphics and discrete graphics cards (with three or more displays, HP recommends using only
discrete graphics cards).

e RAID configurations for SATA RAID levels O, 1

e  Supports eSATA (3.0 Gbps) using an optional adapter
1/0 technology e  Six external and four internal USB 2.0 ports

e  Four external USB 3.0 poris

e  Parallel and serial headers that can be used with an optional PCl bulkhead connector

HP Z220 SFF Workstation components



HP Z220 CMT Workstation components

For complete and current information on supported accessories and components for the computer, see
http://partsurfer.hp.com.

Topics

HP 72220 CMT Workstation front panel components on page 9

HP Z220 CMT Workstation rear panel components on page 10

HP Z220 SFF Workstation chassis components on page 4

HP Z220 SFF Workstation system board component on page 5

HP 7220 SFF Workstation system board architecture on page 6
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HP Z220 CMT Workstation front panel components

Figure 1-6 Front panel components

Table 1-5 Component descriptions

1 Optical drive

USB 3.0 ports (2) (blue)

2 I Power button
O

({{)

Hard drive activity light

SS<
n Headphone connector

. Microphone connector

4 2 USB 2.0 ports (1) (black)

78 1394a FireWire connector (optional
= and plugged unless configured)

HP 2220 CMT Workstation components
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HP Z220 CMT Workstation rear panel components

Figure 1-7 Rear panel components

Table 1-6 Component descriptions

1 Power cord connector 9 Power supply BuiltIn Self Test (BIST) LED
2 PS/2 keyboard connector (purple) 10 6 PS/2 mouse connector (green)

3 ||‘1_n_n! DVIH connector 11 Universal chassis clamp opening

4 ID Display Port (DP) connector 12 Cable lock slot

USB 2.0 ports (4) (black) 13 Padlock loop

-~
6 SS<— USB 3.0 ports (2) (blue) 14 $ RJ-45 network connector

Microphone connector (pink) 15 (('):,4' Audio line-in connector (blue)

8 (&2 Audio line-out connector (green)

2 NOTE: The DP and DV ports are not supported when the system is configured with Intel Xeon E3-12x0 v2 processors. Also, if a discrete graphics card
— s installed these ports are disabled by default.

%%NOTE: Simultaneous usage of integrated Intel HD graphics and discrete graphics cards (in order to drive more than two displays) can be enabled using

the Computer (F10) Setup Utility. However, HP recommends using only discrete graphics cards when attaching three or more displays.

10 Chapter 1 Hardware overview



HP Z220 CMT Workstation chassis components

The following figure shows the chassis components of a typical HP Z220 CMT Workstation layout.
Drive configurations can vary.

Figure 1-8 Chassis components

Table 1-7 Workstation component descriptions

Item Description Item Description
1 Power supply 8  Memory module (DIMM)
2 Side access panel 9 PCle card
3 Rear system fan 10 PCl card
4 Optical drive 11 Speaker
5  CPU heatsink 12 Hard disk drive
6 CPU 13 Front bezel
7 System board 14 Chassis

HP Z220 CMT Workstation components
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HP Z220 CMT Workstation system board component

12

The following illustration and table identify workstation system board components.

Figure 1-9 System board component locations

= ——
© o
@
©) CPU
. I
1S
N %% ghg Joe
@ — ——c
]
1
=
@ 1 5—4—3—2
l‘“ll‘“ll“ﬂl‘“@
- T
e
849
® ) @
Table 1-8 System board component descriptions
1/0 SATA Power
1 Display Port 15 AHCI 3Gb/s 27  Battery
2 DVI video 16 AHCI 6Gb/s 28 CPU power
3  Front audio PCl/PCle 29  Front power button/LED
4  Front speaker 17 PCle2 x8 (4) 30 Main power
5  Front USB 2.0/3.0 18 PCle3 x16 Security
6 Internal USB 2.0 19 PCle2 x1 31 Chassis solenoid lock
7  Internal USB 2.0 20 PCle2 x16 (4) 32 Hood sense
8 Internal USB 2.0 21 PCle2 x1 Service
9 Keyboard/mouse 22 PClI32/33 33 Clear CMOS button
10  Network/rear USB 2.0 23 PCI32/33 34  Crisis recovery jumper
11 Parallel (optional) Cooling 35 ME/AMT flash override
12 Rear audio 24 CPUfan 36  Password jumper
13 Rear USB 2.0/3.0 25  Front fan NOTE: For related expansion card slot
information, see Expansion slots
14  Serial (optional) 26 Rearfan

on page 84
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HP Z220 CMT Workstation system board architecture

The following figure shows the typical system board block diagram.

Figure 1-10 System board block diagram

Z220 CMT Block Diagram

44— PS2

PCle 3.0 x16 (1) —— DDR3
¢ 1600 MHz
PCle 2.0 x4 w/ x16 Intel Socket ECC/NenECC
e 2.0 x4 w/ x ntel Socke
—> TGS
DDR3
- 1600 MHz
ECC/NonECC
Display DI DMI
~—— I
sorss oLy e[ aE ]
>
SATA 2.0 |— (4) > Intel PCH
I— Panther Point - (2) _»4 PCle 2.0 x1 ‘
USB 3.0 |e——— Rear (2) —P C216
USB 2.0 |la——Rear (4) — ! — (1) —{ PCle 2.0 x4 w/ x8 Connector |
USB 3.0 |« Front - Cabled (2) > A i
———p
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USB 2.0 <@ Internal — Cabled (5) LCl —p Lewisville
NIC PHY
. Intel HD
128SI|\>/}|0|? Audio Rear (1)
leg—Rear (1)
LPC Audio Codec |
1
TPM Rear (])
A l— Front Cabled
Front Cabled
|«¢——— Cabled (1) ——p»| SIO12 ———— P52 ——————
o —

|'1_':{"’49NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle

lanes routed to an expansion slot. For example, x16(8) means that the expansion slot is mechanically a
x16 length connector, with 8 PCle lanes supported.

HP 2220 CMT Workstation components
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Workstation specifications
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HP Z220 CMT

Intel® Series C216 chipset with:

Support for the Intel® Xeon® Processor E3 v2 Family or 3nd generation Intel Core(TM)
processors up to 95W

Integrated 2-channel memory controller

Processor
technology e  Microarchitecture improvements

e Integrated graphics (some models)

e  Advanced Vector Extensions (AVX) to increase floating point performance

e Intel DMI2 interface connecting the processor to the /O controller

e 400W, 90% efficient, 80 PLUS Gold, compatible with ENERGY STAR Version 5 requirements
Power supply

e  Supports European Union ERP Lot 6 tier2 power limit of less than 0.5W in off mode

e  Dual inline memory modules (DIMMs) based on DDR3 1600MHz technology

e  Supports error checking and correcting (ECC) and non-ECC DIMMs

e  Two directattach memory channels enable low-latency access and fast data transfer for improved
Memory performance
technology

Up to 32 GB system memory (8 GB DIMMs)
1600 MHz 2, 4, 8 GB ECC unbuffered DIMM
1600 MHz 2, 4, 8 GB non ECC unbuffered DIMM

Graphics cards

Supports:

PCle Gen3 (PCle3) bus speeds; can support dual PCle Gen2 graphics cards in mechanical PCle
x16 slots

Multiple graphics cards provided their total power usage is within 150W
Up fo two displays with integrated Intel HD graphics (depending on processor type)

Up to four 2D displays or two 3D displays

NOTE: Most supported Intel Core processors provide Intel HD Graphics 2000,/2500/4000; Intel
Xeon processors with model designations that end in "~5" provide Intel HD Graphics P4000.

NOTE: To drive more than two displays, use the Computer (F10) Setup Utility to intermix integrated
Intel HD graphics and discrete graphics cards (with three or more displays, HP recommends using only
discrete graphics cards).

1/0 technology

RAID configurations for SATA RAID levels O, 1
Supports eSATA (3.0 Gbps) using an optional adapter
Six external and four internal USB 2.0 ports

Four external USB 3.0 ports

Parallel and serial headers that can be used with an optional PCl bulkhead connector

Chapter 1 Hardware overview



HP Z420 Workstation components

For complete and current information on supported accessories and components for the computer, see
http://partsurfer.hp.com.

Topics

HP 7420 Workstation front panel on page 16

HP Z420 Workstation rear panel on page 17

HP Z420 Workstation chassis components on page 18

HP Z420 Workstation system board components on page 19

HP Z420 Workstation system board architecture on page 20

HP 7420 Workstation specifications on page 21

HP Z420 Workstation components 15
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HP Z420 Workstation front panel

Figure 1-11 Front panel components

Table 1-9 Component descriptions

1 Optical drive 5 S8S<—  USB 3.0 poris (2, blue)
2 ‘ I ’ Power button 6 n Headphone connector
3 3 Hard drive activity light 7 U Microphone connector

USB 2.0 port (black) 8 IEEE-1394a connector

b

16 Chapter 1 Hardware overview



HP Z420 Workstation rear panel

Figure 1-12 Rear panel components
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Table 1-10 Component descriptions

Power supply BuiltIn Self Test

.\\ . oA
1 (BIST) LED 9 ((+5»  Audio line-out connector (green)
2 Universal chassis clamp opening 10 E‘z Microphone connector (pink)
3 6 PS/2 mouse connector (green) 11 $ AMT-enabled R}-45 network
connector (orange)
4 e USB 2.0 poris (4, black) 12 8§~ USB 3.0 poris (2, blue)
78
5 Security slot 13 (@) I[EEE-1394a connector (white)
PS/2 keyboard connector
6 Padlock loop 14 (purple)
7 ((3*  Audio line-in connector (blue) 15 (I) Rear power button
8 Graphics card connector 16 Power cord connector

HP Z420 Workstation components
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HP Z420 Workstation chassis components

Figure 1-13 Chassis components

Table 1-11 Component descriptions

1 Power supply 9 CPU

2 Side access panel 10 Memory module (DIMM)
3 Rear system fan 11 System board

4 Memory airflow guide 12 PCle card

5 Hard disk drive 13 PCl card

6 Hard disk drive 14 Speaker

7 Optical drive 15 Front bezel

8 Heatsink 16 Chassis

18 Chapter 1 Hardware overview



HP Z420 Workstation system board components

Figure 1-14 System board component locations

@ @ @
[=] [} 1
@ |o L
® R -
@ g
® ¢ = iC
® ¥
®
CPU O
g
® I:I HutL 5
“ I
| | .
@ — ® s
@ E— G
RO = @
@ I |-/.
— T ®
(- I Il | e o | I I
0 301 0
@ ® ® @ —— !
Table 1-12 System board component descriptions
1/0 SATA (SAS optional) Cooling Security
1 Front 1394a 14 AHCI 3Gb/s 25 CPUO fan 34 Chassis solenoid lock
2 Front audio 15 AHCI 6Gb/s 26 Front fan 35 Chassis intrusion sensor
3 Front speaker 16 HDD LED 27 Memory fan Service
4 Front USB 2.0 17 SCU 3Gb/s 28 Rear fan 36 Clear CMOS button
5 Front USB 3.0 18 SAS (optional) Power 37 ME/AMT flash override
6 Internal USB 2.0 PCI/PCle 29 Battery 38 Password jumper
7 Keyboard/mouse 19 PCle2 x4 (1) 30 Front power button/LED
8 Network 20 PCle3 x16 31 Main power
9 Rear 13%94a 21 PCle2 x8 (4) 32 CPU/MEM power
10 Rear audio 22 PCle3 x8 33 Rear power button/LED
11 Rear USB 2.0 23 PCle3 x16 For related expansion card slot information, see Expansion
slots on page 84
12 Rear USB 3.0 24 PCl32/33
13 Serial (optional)

HP Z420 Workstation components
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HP Z420 Workstation system board architecture

Figure 1-15 HP Z420 Workstation system board block diagram
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@NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle
lanes routed to an expansion slot. For example, x16(8) means that the expansion slot is mechanically a
x16 length connector, with 8 PCle lanes supported.
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HP Z420 Workstation specifications

Processor technology

Intel® Series C602 chipset with:

Support for the Intel® Xeon™ Processor E5-1600 Series and E5-2600 Series,
including processors up to 150W

Integrated 4-channel memory controller
Microarchitecture improvements
Large L3 cache for superior performance

Intel QuickPath Interconnect (QPI) connects processors and 1/O controller with speeds
up to 8 GT/s

HP Liquid Cooling option is available for all Z420 processors and is required on the
E5-2687W processor model.

Power supply

600W Gold, 90% efficient, wide-ranging, active Power Factor Correction, two
auxiliary dongles on two separate 12V rails, ERP 0.5W, Built-in-Self Test (BIST)

Memory technology

Dual indine memory modules (DIMMs) based on DDR3 1600 MHz technology
Error checking and correcting (ECC)-protected

Four direct-attach memory channels enable low-latency access and fast data transfer
for improved performance

Up to 64 GB system memory (8 GB DIMM:s)
1600 MHz 2, 4, 8 GB ECC unbuffered DIMMs

NOTE: Do not mix any of the different types (unbuffered, registered, and load reducing
DIMMs) of memory. The system will not boot and will produce a memory error.

NOTE: Distribute DIMMs across all memory channels for optimal performance.

Graphics cards

Supports:

PCle Gen3 (PCle3) bus speeds; can support two PCle Gen3 graphics cards in PCle3
x16 slots

Up to 225W graphics or compute card in the primary graphics slot
A second graphics card in the second PCle3 x16 slot
Third and fourth 2D graphics cards in additional PCle2 slots

Combined power consumption of all cards cannot exceed 270W (subject to overall
system power limitations and configuration restrictions)

1/0 technology

SATA RAID 0/1/5/10 on either AHCI or SCU

SAS RAID 0/1/10 on SCU (requires PCle SAS Controller)

Ten SATA porits (2 AHCI 6 Gb/s, 4 AHCI 3 Gb/s, 4 SCU 3 Gb/s)
Two ports capable of optional eSATA

Four external USB 3.0 ports (2 front, 2 rear)

Five external USB 2.0 ports (1 front, 4 rear)

Six internal USB 2.0 ports

Serial Attached SCSI (SAS) drives supported with 9212-4i plug-in card

HP Z420 Workstation components
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e  Standard configuration: 13.2 kg (29.2 Ib)
Weight e  Minimum configuration: 12.5 kg (27.5 Ib)
e  Maximum configuration: 17.7 kg (39.4 Ib)

Tower configuration: Desktop configuration:

e  Height: 44.76 cm (17.62 in) e  Height: 17.78 cm (7.00 in)
Chassis dimensions

e  Width: 17.78 cm (7.00 in) o  Width: 44.76 cm (17.62 in)

e  Depth: 44.50 cm (17.53 in) e  Depth: 44.50 cm (17.53 in)

22 Chapter 1 Hardware overview



HP Z620 Workstation components

For complete and current information on supported accessories and components for the computer, see

http://partsurfer.hp.com.

Topics

HP Z620 Workstation front panel on page 23

HP Z620 Workstation rear panel on page 24

HP Z620 Workstation chassis components on page 25

HP Z620 Workstation system board components on page 26

HP 72620 Workstation system board architecture on page 27

HP 7620 Workstation specifications on page 28

HP Z620 Workstation front panel

Figure 1-16 Front panel components

Table 1-13 Component descriptions

1 Optical drive 5 SS< USB 3.0 ports (2, blue)

2 (I) Power button 6 n Headphone connector

3 g Hard drive activity light 7 E‘g Microphone connector
7%

4 = USB 2.0 port (black) 8 IEEE-1394a connector

HP Z620 Workstation components
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HP Z620 Workstation rear panel

Figure 1-17 Rear panel components

Table 1-14 Component descriptions

1 Power cord connector 8 ((«3» Audio line-out connector (green)

2 6 PS/2 mouse connector (green) 9 E‘a Microphone connector (pink)

3 &< USB 2.0 poris (4, black) 10 SS4<= USB 3.0 poris (2, blue)
RJ-45 network connectors (orange) Y

4 $ 11 (@) IEEE-1394a connector (white)
Bottom connector is AMT enabled =

5 (%  Audio line-in connector (blue) 12 PS/2 keyboard connector (purple)

6 Graphics card connector 13 (I) Rear power button

7 Security slot 12 Power supply BuiltIn Self Test (BIST)

LED

Chapter 1
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HP Z620 Workstation chassis components

Figure 1-18 Chassis components

Table 1-15 Component descriptions

1 Side access panel 13 Second CPU memory module (DIMM) (optional)
2  Second CPU module rear guide bracket 14 CPU

3 Memory fans 15 Second CPU module (optional)
4  Rear system fans 16 PCle card

5  Power supply 17 PCl card

6  Speaker 18 Card guide and front fan

7  Side access panel key lock 19 Hard disk drive

8  Second CPU heatsink (optional) 20 Hard disk drive carrier

9  Second CPU (optional) 21 Optical drive

10  CPU heatsink 22 External bay filler

11 Memory module (DIMM) 23 Chassis

12  System board

HP Z620 Workstation components
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HP Z620 Workstation system board components

Figure 1-19 System board component locations
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Table 1-16 System board components descriptions

I/0 PCl/PCle Power
1 Front 1394a 13 PCle2 x4 (1) 25 Battery
2  Front audio 14 PCle3 x16 26 CPU and memory power
3 FrontUSB 2.0 15 PCle2 x8 (4) 27 Front power button, LED, speaker
4  Front USB 3.0 16 PCle3 x8 28 Main power
5 Internal USB 2.0 17 PCle3 x 16 29 Rear power button/LED
6 Keyboard/mouse 18 PCl 32/33 SATA (SAS optional)
7  Network Cooling 30 AHCI 3Gb/s
8 Rear 1394a 19 CPUO memory fan 31 AHCI 6Gb/s
9 Rear audio 20 CPUT memory fan 32 Hard disk drive LED
10 Rear USB 2.0 21 Front fan 33 SCU 3Gb/s
11 Rear USB 3.0 22 CPUO memory fan 34 SAS (optional)
12 Serial (optional) 23 CPUT memory fan (optional) Service

24 Rear fans 35 Clear CMOS button

For related expansion card slot information, see Expansion slots 36 ME/AMT flash override
on page 84

37 Password jumper
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HP Z620 Workstation system board architecture

Figure 1-20 System board block diagram
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HP Z620 Workstation specifications
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Intel® Series C602 chipset with:

Processor
technology °

Support for the Intel® Xeon™ Processor E5-1600 Series and E5-2600 Series
Integrated 4-channel memory controller

Microarchitecture improvements

Large L3 cache for superior performance

Intel QuickPath Interconnect (QPI) connects processors and |/O controller with speeds up to 8
GT/s

Power supply

800W Gold, 90% efficient, wide-ranging, active Power Factor Correction, two auxiliary dongles
on two separate 12V rails, ERP 0.5W, Built-in-Self Test (BIST)

Memory °
technology

Dual in-line memory modules (DIMMs) based on DDR3 1600MHz technology
Error checking and correcting (ECC)-protected

Eight direct-attach memory channels (four per CPU) enable low-latency access and fast data
transfer for improved performance

Configurations with one CPU have eight DIMM slots; a second CPU adds four more DIMM slots
With one processor, up to 64 GB system memory (8 GB DIMMs)

With second processor, up to 96 GB system memory (8 GB DIMMs)

1600 MHz 2, 4 GB ECC unbuffered DIMMs

1600 MHz 4, 8 GB ECC registered DIMMs

NOTE: Do not mix any of the different types (unbuffered, registered, and load reducing DIMMs) of
memory. The system will not boot and will produce a memory error.

NOTE: For maximum performance, on workstations with two CPUs, install the same number of
DIMMs per CPU and install them in pairs of the same size.

NOTE: Distribute DIMMs across all memory channels for optimal performance.

Graphics cards

PCle Gen3 (PCle3) bus speeds; can support two PCle Gen3 graphics cards in PCle3 x16 slots
Up to 225W graphics or compute card in the primary graphics slot

A second graphics card in the second PCle3 x16 slot

Third and fourth 2D graphics cards in additional PCle?2 slots

Combined power consumption of all cards cannot exceed 300W (subject to overall system
power limitations and configuration restrictions)

1/0 technology

SATA RAID 0/1/5/10 on either AHCI or SCU

SAS RAID 0/1/10 on SCU

Ten SATA ports (2 AHCI 6 Gb/s, 4 AHCI 3 Gb/s, 4 SCU 3 Gb/s)
Two ports available for optional eSATA

Four external USB 3.0 ports (2 front, 2 rear)

Five external USB 2.0 ports (1 front, 4 rear)

Six internal USB 2.0 ports

Chapter 1
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Weight

Standard configuration: 17.9 kg (39.4 Ib)
Minimum configuration: 15.5 kg (34.2 Ib)
Maximum configuration: 22.6 kg (49.9 Ib)

Chassis
dimensions

Height: 44.45 cm (17.50 in)
Width: 17.15 c¢m (6.75 in)
Depth: 46.48 cm (18.30 in)

HP Z620 Workstation components

29



HP Z820 Workstation components

For information on supported accessories and components, see http://partsurfer.hp.com.

Topics

HP Z820 Workstation system board architecture on page 34

HP 7820 Workstation chassis components on page 32

HP 7820 Workstation front panel on page 30

HP 7820 Workstation rear panel on page 31

HP Z820 Workstation system board components on page 33

HP 7820 Workstation specifications on page 35

HP Z820 Workstation front panel

Figure 1-21 Front panel components

Table 1-17 Component descriptions

1 Optical drive 5 SS<= USB 3.0 ports (2, blue)

2 (I) Power button 6 n Headphone connector

3 g Hard drive activity light 7 S‘! Microphone connector
78
4 e USB 2.0 port (black) 8 (@) IEEE-1394a connector
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HP Z820 Workstation rear panel

Figure 1-22 Rear panel components

Table 1-18 Component descriptions

1 Power cord connector 9 S8S4<— USB 3.0 ports (2, blue)
2 6 PS/2 mouse connector (green) 10 o<~ USB 2.0 ports (4, black)
3  ((<* Audio linein connector (blue) 11 ((«3»  Audio line-out connector (green)

$ RJ-45 network connectors (2, orange)

4 12 E‘z Microphone connector (pink)
Top connector is AMT enabled
78 :
5 IEEE-1394a connector (white) 13 PS/2 keyboard connector (purple)
6 Security slot 14 (I) Rear power button
7 Graphics card connector(s) 15 IL";\)Ner supply Builtin Self Test (BIST)
8 lolol  Serial connector (teal blue)

HP Z820 Workstation components
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Figure 1-23 Chassis components

HP Z820 Workstation chassis components

Table 1-19 Component descriptions

1 CPU/memory fans 12  Processor (CPU) heatsink

2 Power supply 13  Processor (CPU)

3 Optical drive 14  Chassis

4 Side access panel 15  Processor (CPU) liquid cooling unit (optional upgrade
to standard heatsink)

5 Side access panel key lock 16  PCl Retainer

6 Rear system fans 17  PCle card

7 Memory module (DIMM) 18 PClcard

8 Front bay filler (optional) 19  Hard disk drive carrier

9 Second processor (CPU) heatsink (optional) 20  Hard disk drive

10 Second processor (CPU) (optional) 21 Front system fan (two fans with 1125W power supply)

11 System board 22  Speaker

Hardware overview



HP Z820 Workstation system board components

Figure 1-24 System board component locations
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Table 1-20 System board component descriptions

170 PCI/PCle Power
1 Front 1394a 16 PCle3 x8 (4) — CPUO 31 Battery
2  Front audio 17 PCle3 x16 — CPUO 32 CPUO power
3 Front USB 2.0 18 PCle3 x16 (8) — CPU1 33 CPU1 power
4q Front USB 3.0 19 PCle3 x16 — CPU1 34  Front power button /LED/
speaker
5 Internal USB 2.0 20 PCle2 x8 (4) — CPUO 35 Main power
6  Keyboard/mouse 21 PCle3 x16 — CPUO 36 Memory power
7 Rear audio 22 PCl32/33 — CPUO 37  Rear power button /LED
8  Rear USB 2.0/Network Cooling Service
9  Rear USB 3.0/13%94a 23  Auxiliary fan 1 (front) 38 Clear CMOS button
10 Seridl 24  Auxiliary fan 2 (rear) 39  Crisis recovery jumper
SAS/SATA 25 CPU/memory fans 40 ME/AMT Flash override
11 AHCI 6Gb/s 26 Frontfan 1 (top) 41 Password jumper
12 Hard disk drive LED 27  Front fan 2 (bottom)
13 SAS/SATA 6Gb/s 28 Lliquid cooling O power NOTE: For related expansion card
slot information, see Expansion slots
14  SAS (optional) 29 Liquid cooling 1 power on page 84.
15 SCU 3Gb/s 30 Rear chassis fans

HP Z820 Workstation components

33



HP Z820 Workstation system board architecture

Figure 1-25 System board block diagram

[ DORE__J«+[ DDORZ_ J+—sfom cole—e[  DOR3__ |~-[ DDRZ__]
[ DDRS_Jo—s[__DDRZ _Jo—sfor , el - T yomel onfe—e_DDRS _Je—{__DDR3__]
on 2on
[ DDRS Jo—s DDRE Jo—+lc® series |, |, “series ale—=[_DDRT__Jo—{__DDRS ]
[ DORZ _ J«—s DDR3  Je—nfci gl lopcss oo 8f—{OORT e ODRT]

Ti1 L

xlé

| PCle3 x16 T

x4 4 Lsi 8x SAS (6Gb/'s)
[ PCle3xi6 FJJ == )

| PCle3 x8* (4)

= SATA: 4x SCU (3Gb/s), 2x AHCI (6Gb/s)

L

| USB2.0: 4x Rear, &x Internal, 1x Front
| PCI-32/33M F—— el 602 USB3.0: 2x Rear, 2x Internal
Pl PCH
Front - o l TPM T(HY [ PCle3 xB* (4)
Rear <] 139%4a = ' LPC 2 PCle3 x16
T Ti US83.0 L . sor2 3 PCle3 x16 (8)
x4 ! [lZ540 4= PCle3 x14
X
PCle2 x8* (4 }_—‘ T 5 PCle2 x8* (4)
| e %1 ! LAN 6 PCled x16
GhE 7 PCH32/33M
| PCle3 x16 I" * openended connector
LAN with 2nd CPU
[ PCle3x16(8) | GbE

2»NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle
lanes routed to an expansion slot. For example, x16(8) means that the expansion slot is mechanically a
x16 length connector, with 8 PCle lanes supported.
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HP Z820 Workstation specifications

Processor
technology

Intel® Series C602 chipset with:

Support for the Intel® Xeon™ Processor E5-2600 Series, including processors up to 150W
Integrated 4-channel memory controller

Microarchitecture improvements

Large L3 cache for superior performance

Intel QuickPath Interconnect (QPI) connects processors and 1/O controller with speeds up to 8.0

GT/s

NOTE: HP Liquid Cooling option is available for all Z820 processors.

Power supply

850W Silver, 88% efficient, wide-ranging, active Power Factor Correction, two auxiliary dongles
on two separate 12V rail, ERP 0.5W, Built-in-Self Test (BIST)

1125W Gold, 90% efficient, wide-ranging, active Power Factor Correction, three auxiliary
dongles on three separate 12V rails, ERP 0.5W, Built-in-Self Test (BIST)

China’s Energy Conservation Program (CECP) configurations

European Union ErP LOT6 2013 power limit of 0.5W in off mode

Memory
technology

Dual indine memory modules (DIMMs) based on DDR3 1600MHz technology
Error checking and correcting (ECC)-protected

Eight direct-attach memory channels (four per CPU) enable low-latency access and fast data
transfer for improved performance

Configurations with one CPU have eight DIMM slots; a second CPU adds eight more DIMM slots
With one processor, up to 256 GB system memory (32 GB DIMMs)

With second processor, up to 512 GB system memory (32 GB DIMMs)

1600 MHz 2, 4 GB ECC unbuffered DIMM

1600 MHz 4, 8, 16 GB ECC registered DIMM

1333 MHz 32 GB ECC Load Reducing DIMM (available second half of 2012)

NOTE: Do not mix any of the different types (unbuffered, registered, and load reducing DIMMs) of
memory. The system will not boot and will produce a memory error.

NOTE: For maximum performance, on workstations with two CPUs, install the same number of
DIMMs per CPU and install them in pairs of the same size

NOTE: Distribute DIMMs across all memory channels for optimal performance

Graphics cards

PCle Gen3 (PCle3) bus speeds; can support three PCle Gen3 graphics cards in PCle3 x16 slots
Up to one 160W or two 75W graphics cards with 850W power supply

Up to two 300W or three 225W graphics cards with optional 1125W power supply (other
configuration restrictions may be required)

HP Z820 Workstation components
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1/0 technology

SATA RAID 0/1/5/10 on SCU

SAS RAID O/1/10 on LSI SAS 2308 controller

Six SATA ports: four SCU (3 GB/s); two AHCI (6 GB/s)
Eight SAS ports (6 GB/s)

Two poris (6.0 GB/s) available for optional eSATA
Four external USB 3.0 ports

Five external and six internal USB 2.0 ports

Standard configuration: 26.6 kg (58.7 |b)

Weight Minimum configuration: 24.0 kg (52.9 Ib)
Maximum configuration: 32.0 kg (70.5 Ib)
Height: 44.4 cm (17.5 in)

Chassis Width: 20.3 cm (8.0 in)

dimensions

Depth: 52.5 cm (20.7 in)
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Environmental specifications

The following table lists the environmental specifications of HP Workstations.

Table 1-21 HP Workstation environmental specifications

Operating: 5 to 35°C (40 to 95°F)

Temperature Non-operating: -40 to 60°C (-40 to 140°F)

1,524m (5,000 ft).

NOTE: Derate by one degree C (1.8 degrees F) for every 305m (1,000 ft) altitude over

Humidity

Operating: 8 to 85% Relative Humidity (RH), non-condensing

Non-operating: 8 to 90% Relative Humidity, non-condensing

Operating: 0 to 3,048m (10,000 f)
Altitude
Non-operating: O fo 9,144m (30,000 ft)

Operating: V2sine: 40g, 2-3ms
Non-operating:
Shock e  Vasine: 160 cm/s, 2-3ms (~100g)

e square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive shock events.

Operating Random: 0.5g (rms), 5-300 Hz
Vibration Non-Operating: random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.

ENERGY STAR qualification

HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S.
Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA ENERGY
STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, Hewlett-Packard
Company has determined the products marked with the ENERGY STAR logo are ENERGY STAR
qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo

appears on all ENERGY STAR qualified computers.

ENERGY STAR
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Ensuring proper ventilation

Proper ventilation for the system is important for workstation operation. Follow these guidelines:
e  Operate the workstation on a sturdy, level surface.

e Provide at least 15.24 c¢m (6 inches) of clearance at the front and back of the workstation.
(Workstation models vary.)

Figure 1-26 Proper workstation ventilation

k=

15.24 cm (6 in)

15.24 ¢cm (6 in)

e  Ensure that the ambient air temperature falls within the environmental specifications listed in this
document.

r__":"‘/f’NOTE: The ambient upper limit of 35°C (95°F) is only good up to 1524 m (5000 ft) elevation.
There is a 1°C (33.8°F) per 304.8 m (1000 ft) derating above 1524 m (5000 f). So, at 3,048 m
(10,000 ft), the upper ambient air temperature limit is 30°C (86°F).

e  For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient
temperature within the cabinet does not exceed specified limits.

e  Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air
intakes, as shown in the following figure.

Figure 1-27 Proper workstation placement

o 1

: =
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2 System management

This section describes the tools and utilities that provide system management for the workstation. It
includes these topics:

Topics

Power management and performance features on page 39

BIOS ROM on page 41

The Computer Setup (F10) Utility on page 42

Desktop management on page 60

Power management and performance features

ERP compliance mode

This computer provides ERP compliance mode capability.

When enabled, the computer shuts down to the lowest possible power state. The computer must then be
turned on with the power button. One of the effects is that "wake on LAN" is disabled.

When disabled, the computer powers down conventionally.

1. Press F10 during startup.

2. Using the arrow keys, select the Power > Hardware Power Management > S5

Enabling ERP compliance Maximum Power Savings, then select Enable.
mode
3. Press F10 fo accept the change.

4. Select File > Save Change and Exit, and then press Enter to accept the change.

1. Press F10 during startup.

2. Using the arrow keys, select Power > Hardware Power Management > S5

Disabling ERP compliance Maximum Power Savings, then select Disable.
mode
3. Press F10 fo accept the change.

4. Select File > Save Change and Exit, and then press Enter to accept the change.
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Hyper-Threading Technology (HTT)

This computer supports HTT, an Intel-proprietary technology that improves processor performance
through parallelization of computations (doing multiple tasks at once).

The operating system treats an HTT-enabled processor as two virtual processors, and shares the
workload between them when possible. This feature requires that the operating system support multiple
processors and be specifically optimized for HTT.

Use the Computer Setup (F10) Utility to enable HTT.

Go to http://www.hp.com/go/quickspecs to determine if your CPU supports HTT.

SATA Power Management

SATA Power Management enables or disables SATA bus and/or device power management.

Intel Turbo Boost Technology

The HP Z Workstation series supports Intel® Turbo Boost Technology.

This feature enables the CPU to run at a higher than normal rate. When all CPU cores are not
necessary for the workload, inactive cores are turned off and power is diverted to the active cores to
increase their performance.

Turbo Boost is enabled and disabled with the Computer Setup (F10) Utility.

Go to http://www.hp.com/go/quickspecs to determine if your CPU supports Turbo Boost.

HP Cool Tools

40

HP workstations and computers installed with Windows include additional software tools. To access or
learn more about these tools that can enhance the computer experience:

1. Double<click the HP Cool Tools icon on the desktop.

2. To learn more about an HP Cool Tool application, just click on the application's "Learn More"

link.

3. Toinstall or launch the applications, select the appropriate application and follow the instructions
given.
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Non-Uniform Memory Access (NUMA)

Non-Uniform Memory Access (NUMA\) is available on some Z series Workstations. NUMA can improve
memory bandwidth and latency for multi-process or multithreaded applications or workloads.
Observed performance improvements depend on the operating system, customer workload, system
configuration, and the degree to which the applications used are designed to be NUMA-aware/
efficient.

NUMA requires that both processor sockets be populated. Installed memory should be balanced
between both processors for maximum performance.

NUMA is enabled if Memory Node Interleave is disabled in the system BIOS. To do this, press F10
during startup to enter the Computer Setup (F10) Utility. Select Advanced > Chipset/Memory. Use
the arrow keys to set Memory Node Interleave to Disable. Press F10 to exit the menu, then select
File > Save Changes and Exit. NUMA is enabled when the system is restarted.

BIOS ROM

The BIOS ROM is a collection of machine language applications stored as firmware in ROM. It includes
functions such as Power on Self Test (POST), PCI device initialization, Plug and Play support, power
management, and the Computer Setup (F10) Utility.

Go to http://www.hp.com/go/quickspecs to review the latest BIOS ROM specifications.
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The Computer Setup (F10) Utility

This section includes these topics:

Topics

Computer Setup (F10) functionality on page 42

Accessing the Computer Setup (F10) Utility on page 43

The Computer Setup (F10) Utility menu on page 44

Computer Setup (F10) functionality

42

The Computer Setup (F10) Utility enables you to:

Update BIOS using a USB device.

Change factory default settings and set or change the workstation configuration, which might be
necessary when you add or remove hardware.

Determine if all devices installed on the workstation are recognized by the system and functioning.
Determine information about the operating environment of the workstation.

Solve system configuration errors that are detected but not fixed during the Power-On Self-Test
(POST).

Establish and manage passwords and other security features.
Establish and manage energy-saving time-outs.

Modity or restore factory default settings.

Set the workstation date and time.

Set, view, change, or verify the workstation configuration, including settings for CPU, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of installed mass storage devices such as SATA, optical disk drives and
network drives.

Configure the boot priority of SATA hard-drive controllers.

Enable or disable Network Server Mode, which enables the workstation to start the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the workstation, the keyboard and mouse remain locked until the power-on
password is entered.

Enable or disable POST Messages to change the display status of POST messages. POST
Messages suppresses most POST messages, such as memory count, product name, and other
nonerror text messages. If a POST error occurs, the error is displayed regardless of the mode
selected. To manually switch to POST Messages Enabled during POST, press any key except F1
through F12.

Specify an Ownership Tag, which appears when the workstation is powered on or restarted.
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e  Specify the Asset Tag or property identification number assigned by the company to this
workstation.

e Enable power-on password prompts during system restarts (warm-starts) and power on.

e Hide or show the integrated /O functionality, including serial, USB, or parallel ports, audio, or
embedded NIC. Hidden devices are inaccessible, which increases system security.

e Enable or disable removable media boot ability.
e Enable or disable removable media write ability (if supported by hardware).

e Replicate the workstation setup by saving system configuration information on CD and restoring it
on workstations.

e  Execute selftests on specified SATA hard disk drives (if supported by the drive).

Accessing the Computer Setup (F10) Utility

To access the Computer Setup (F10) Utility:
1. Power on or restart the workstation.

2. When the display is active and Press the ESC key for Startup Menu appears at the bottom
of the screen, press F10 or Esc.

If you do not press F10 or Esc at the appropriate time, try again. Turn the workstation off, then on,
and press F10 again to access the utility. You can also press Cirl + Alt + Delete before starting if
you miss the opportunity to press F10.

3. Select the language from the list and press the Enter key.

In the Computer Setup (F10) Utility menu, five headings are displayed: File, Storage, Security,
Power, and Advanced.

@NOTE: The option for selecting the language is available on first boot only.

4. Use the left and right arrow keys to select the appropriate heading, use the up and down arrow
keys to select an option, and then press Enfer.

5. Choose from the following:

e To apply and save changes, select File > Save Changes and Exit, then press Enter to
accept the changes.

e To remove changes you have made, select Ignore Changes and Exit, then press Enter to
acknowledge the cancellation.

e To reset to factory seftings, select File > Default Setup > Restore Factory Settings as
Default. Press Enter to accept the changes, and then select Apply Defaults and Exit.
This restores the original factory system defaults.

/\ CAUTION: Do not power off the workstation while the ROM is saving the Computer Setup (F10)
Utility changes, because the Complementary Metal-Oxide Semiconductor (CMOS) nonvolatile storage
could become corrupted. After you exit the F10 Setup screen, you can disconnect power from the
workstation.
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The Computer Setup (F10) Utility menu

The following tables describe the functions available in the Computer Setup (F10) (BIOS) utility menu.

2»NOTE: With new BIOS releases, the following content is subject to change, so the menu might be

different than shown.

Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT

Workstations

Heading Option Description

File System Information Displays the following system characteristics:

Product Name

SKU Number

Processor Type

Processor Speed

Processor Stepping (stepping designation and patch number)
Cache Size (L1/12/13)

Memory Size (Channel A, Channel B)

Integrated MAC (onboard NIC)

System BIOS

Chassis Serial Number

Asset Tracking Number

ME (Infel Management Engine) Firmware Version

ME Management Mode

About Displays copyright information.

Set Time and Date Lets you set system time and date. Use the keyboard Tab and arrow keys to make
changes.

Flash System ROM Lets you upgrade the BIOS from a ROM image on optical media or USB.

Replicated Setup Provides these options:

Save to Removable Media—Saves the computer configuration, including
CMQOS, to a USB storage device. The saved configuration file is named
cpgsetup.ixt.

Restore from Removable Media—Restores the computer configuration from a
USB storage device.

Default Setup Provides these options:

Save Current Settings as Default—Saves the current settings as default settings
for the next operation.

Restore Factory Settings as Default—Restores the factory seftings as the default
settings for the next operation.

Apply Defaults and Exit  Restores the default settings defined in Default Setup.
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Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT
Workstations (continued)

Heading Option Description
Ignore Changes and Exits computer setup without applying or saving changes.
Exit
Save Changes and Exit  Saves changes fo system configuration and exits the computer setup.
Storage Device Configuration Lists installed storage devices and provides specific information about each device:

e  Hard Disk—Provides information about the hard disk drives.

e  CD-ROM—Provides information about the optical disk drives.

Storage Options

Provides these options:

e  eSATA Port—Displays the internal SATA port(s) that are configured to operate
as eSATA. Changing this to None provisions the pori(s) as internal SATA.

e  SATA Emulation—Sefs the SATA emulation mode with the following options:

o RAID + AHCI—both the RAID and AHCI OPROMs execute. This
emulation mode is the default and offers the best performance and most
functionality.

o IDE—offers standard SATA support. Some higher-numbered SATA ports
may not be available in this mode.

e  Removable Media Boot (Enabled/Disabled)—Enabling allows the workstation
to boot from removable media, such as a USB flash drive.

e  Max eSATA Speed—Configures eSATA port speeds:
o Gen 2 (3.0 Gbps)
o Gen 1(1.5 Gbps)

DPS Selftest

Select a drive—Lets you execute self-tests on SATA hard drives capable of
performing Drive Protection System (DPS) selftests.

NOTE: This selection appears only when the system has one or more drives
capable of performing the DPS selftests.

Boot Order

Lets you configure the boot order by physically reordering the menu entries. The
default boot order is:

e  EFI Boot Sources
o USB Floppy/CD
o USB Hard Drive
o ATAPI CD/DVD Drive
e Llegacy Boot Sources
o ATAPI CD/DVD Drive
o USB Floppy/CD

The Computer Setup (F10) Utility
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Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT

Workstations (continued)

Heading Option Description
o Hard Drive
o Network Controller
You can take the following actions:
e  Press Enfer to drag a device with the arrow keys to a preferred place, then
press Enter again to drop the device in place.
e  Press F5 to remove the device from consideration as a bootable device.
e  You must confirm changes by selecting File>Save Changes and Exit and then
press Enter. The computer then stores boot order changes in the physical
ROM.
To temporarily override the boot order and boot from a device other than the
default device specified in Boot Order:
1. Restart the computer.
2. Press F9 when the F9=Boot Menu message appears on the screen.
3. Wiait for POST to finish and for the list of bootable devices to display.
4. Use the arrow keys to select the preferred boot device.
5. Press Enter. The computer then starts from the selected nondefault device. (This
does not change the default boot device.)
Security Setup Password Lets you set and enable a setup password for the administrator.

If you create a setup password, you must use it to change computer setup options,
to flash the ROM, and to make changes to certain Plug and Play seftings under
Windows.

Power-On Password

Let you set and enable the power-on password.

Password Options

This option becomes available depending on the presence of setup or power-on
passwords. It provides these options:

Lock Legacy Resources (Enabled/Disabled)—Prevents the operating system
from changing resources to serial, parallel, or diskette controller. (Appears if a
setup password is set.)

Setup Browse Mode (Enabled/Disabled)—Lets you view but not change the
F10 Setup Options without having to enter the setup password. (Appears if a
setup password is set.)

Password prompt on F9 and F12 (Enabled/Disabled)—Lets you access menus
without entering the setup password.

Network Server Mode (Disabled/Enabled)—Enables network server mode.
(Appears if a power-on password is set.)

Smart Cover

Lets you enable/disable the cover removal sensor'.
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Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT

Workstations (continued)

Heading Option

Description

Device Security

Makes the following devices available or hidden to the computer:
o  Embedded Security Device (hidden by default)

e  System Audio

e  Network Controller

e  SATA ports

With the exception of Embedded Security Device (TPM), Device Available is the
default setting for all devices (allows the operating system to access the device).
Device Hidden disables the device by the BIOS so that the operating system can no
longer enable the device.

NOTE: An entry for enabling Drivelock appears in the setup menu if the computer
has a Drivelock-compatible hard disk drive.

USB Security

Set workstation USB ports to Enabled/Disabled:
e  Front USB Ports
e  Rear USB Ports

e Internal USB Ports

Slot Security

Lets you disable any PCl or PCl Express slot.

Network Boot

Lets you enable/disable the ability to boot from the network using the F12 key or
the boot order.

System IDs

Provides these options:
e  Asset Tag—A usereditable, 16-byte string identifying the computer.

e  Ownership Tag—A user-editable, 80-byte string identifying ownership of the
computer. This tag appears on the screen during POST.

e  Universal Unique Identifier (UUID)—An ID number set in the factory that
uniquely identifies the computer.

e  Keyboard—Lets you set the keyboard locale for System ID entry.

Master Boot Record
(MBR) Security

When MBR Security is enabled, the BIOS prevents any changes being made to the
MBR of the current bootable disk while in MS-DOS or Windows Safe Mode—
(Enable or Disable).

NOTE: Most operating systems control access to the MBR of the current bootable
disk; the BIOS cannot prevent changes that may occur while the operating system is
running.

The Computer Setup (F10) Utility

47



48

Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT

Workstations (continued)

Heading Option

Description

System Security

With the exception of the first option, Data Execution Prevention, changing any of
these system security settings and choosing File > Save Changes and Exit will
result in the computer performing a global reset, automatically turning itself off and
then back on. Note also that these options are hardware dependent and may not

be available on some models:

e  Data Execution Prevention (Enabled/Disabled)—Helps prevent operating
system security breaches.

e  Virualization Technology (VTx)' (Disabled/Enabled)—Controls the
virtualization features of the processor.

e Virualization Technology Directed I/O (VTd)' (Disabled/Enabled)—Controls
virtualization DMA remapping features of the chipset.

e Intel TXT(LT) Support' (Enabled/Disabled)—Controls the underlying processor
and chipset features needed to support a virtual appliance. To enable this
feature you must enable:

> Virtualization Technology (VTx)
> Virtualization Technology Directed 1/0 (VTd)
o Embedded Security Device

e  Embedded Security Device' (Disabled/Enabled)—Permits activation and
deactivation of the Embedded Security Device.

NOTE: Embedded Security Device must be set to Device Available in the
Device Security menu, and you must create a Setup Password, in order to
configure the Embedded Security Device.

e  Reset fo Factory Settings' (Do not reset/Reset)—Restores factory defaults and
erases all security keys.

CAUTION: Choosing Reset to Factory Settings may result in significant data
loss. The embedded security device is a critical component of many security
schemes. Erasing the security keys prevent access to data protected by the
Embedded Security Device.

e  OS Management of Embedded Security Device' (Disabled/Enabled)—Limits
operating system control of the Embedded Security Device.

e  Reset of Embedded Security Device through OS' (Enabled/Disabled)—Limits
the operating system ability to request a Reset to Factory Settings of the
Embedded Security Device.

NOTE: You must create a Setup Password to use this option.

Drive Lock Security

Lets you assign or modify a master password or user password for hard drives.
When enabled, this feature prompts the user to provide one of the Drivelock
passwords during POST. If the user does not successfully enter one of the
passwords, the hard drive remains inaccessible until one of the passwords is
successfully entered during a subsequent cold-boot sequence.

NOTE: This selection appears only when the system includes at least one drive
that supports the Drivelock feature.
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Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT
Workstations (continued)

Heading Option Description
Power OS Power Enables or disables:
Management
e  Runtime Power Management
e Idle Power Savings: Extended (default) or Normal; extended mode reduces
processor power consumption when the CPU is idle
e ACPI S3 PS2 Mouse Wakeup
e  Unique Sleep State Blink Rates
Hardware Power Enables or disables:
Management
e  SATA Power Management
e S5 Maximum Power Savings
Thermal Lets you set the minimum speed of the system fan when the CPU is idle.
Advanced? Power-On Options Sets the following:

POST Mode:
° QuickBoot—Do not clear memory or perform a memory test.
o FullBoot—Memory test (count) on cold boot. Clears memory on all boots.

o Clear Memory—No memory test (count) on cold boot. Clears memory on
all boots.

o FullBoot Every x Days—Memory count on first cold boot on or after the
Xth day and no more memory counts until that boot occurs. Clears
memory on all boots.

POST Messages (Enabled/Disabled)
Press the ESC key for Startup Menu (Enabled/Disabled)

Option ROM Prompt (Enabled/Disabled)—Enabling this feature causes the
computer to display a message before loading option ROMs.

After Power Loss—Lets you specify computer behavior after a power loss:

o Power Off —Computer remains powered off when power is restored

(default).

o Power On—Computer automatically powers on when power is
restored. (This lets you power on the computer using a power strip switch,
if the computer is connected to an electric power strip.)

o Previous state—Computer powers on automatically when power is
restored only if computer was on when power was lost.

The Computer Setup (F10) Utility
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Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT

Workstations (continued)

Heading Option

Description

NOTE: If you turn off power to the computer using a power strip, you
cannot use the suspend/sleep feature or the Remote Management
features.

e  POST Delay (None (default), 5, 10, 15, 20 seconds)—Delays start of the
POST process. You might need a delay to:

o Allow time for some hard disk drives to spin up before POST is finished.

o Give yourself more time to select F10 to enter the Computer Setup (F10)
Utility.

e  Remote Wakeup Boot Source (Local Hard Drive/Remote Server). Sets the boot
device for the workstation when it is started using Remote Wakeup (takes
precedence over the Boot Order menu setting).

e  Bypass F1 Prompt on Confirmation Changes (Enabled/Disabled)—Prevents
display of a confirmation prompt when you make changes to the system.

BIOS Power-On

Lets you disable or specify a weekday and time for BIOS power-on.

Onboard Devices

Lets you disable or set resources (IRQ, DMA, /O Range) for onboard system
devices such as the serial port and parallel ports. Operating system parameters
generally override Onboard Devices settings.

Bus options

Enable/disable these options:

e  PCl SERR# Generation (Enabled/Disabled)—Controls PCI SERR# generation
for ill-behaved PCl add-in cards (that can generate SERR# spuriously).

e  PCI VGA Palette Snooping (Disabled/Enabled)—Controls PCI VGA Palette

Snooping for compatibility purposes.

e  PCl Llatency Timer (32/64/96/128/160/192/224/248). 128 PCl Clocks is
the default.

Device Options

Enable/disable the following device options:

e S5 Wake-on-lAN (Enabled/Disabled)

e  Printer Mode (EPP+ECP, Output Only, Bi-Directional)
e  Num Lock State at Power-On (On/Off)

e Integrated Video' (Enabled/Disabled)

e  IGD (Integrated Graphics Device) Memory—Displayed when Integrated Video
is Enabled. Sets the maximum amount of system memory that can be allocated

as graphics memory (32, 64 (default), 128, 256, 512 MB)'
e Infernal Speaker (Enabled/Disabled)
e  NIC Option ROM? Download (PXE/Disabled)
e  SATA RAID Option ROM? Download (Enabled/EFl/Disabled)
e  UEFI Option ROM Support (Enabled/Disabled)
e  Multi-Processor (Enabled/Disabled)
e  Hyperthreading' (Disabled/Enabled)
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Table 2-1 Computer Setup (F10) Utility menu descriptions for the HP Z220 SFF and Z220 CMT
Workstations (continued)

Heading Option Description
Slot Settings Lets you Enable/Disable Option ROM Download for each slot. Selective disabling
of Option ROM downloads can help manage limited Option ROM space.
Management Lets you set the following AMT (Intel Active Management Technology) configuration
Operations options:

e  AMT (Enabled/Disabled)—Allows for remote discovery, repair and protection
of networked workstations. Enabling the AMT function also enables the
Network Controller (required for AMT to function correctly).

e  Unconfigure AMT/ME (Disabled/Enabled)?—Restores AMT/ME defaults.
When you save and exit after enabling this option, you will be prompted to
complete the process upon restart. A Setup Password (even if one is set) does
not need to be entered to complete the process.

NOTE: Information about Intel AMT can be found at wwwe.intel.com.
e  Hide Un-configure ME Confirmation Prompt—(Enabled/Disabled).
e  WatchDog Timer (Enabled/Disabled)—OS and BIOS WatchDog Timers can

be set independently (in minutes):
o OS WatchDog Timer—Sets the OS WatchDog Timer.

o BIOS WatchDog Timer—Sets the BIOS WatchDog Timer.

T *Available on selected models.
2 *These options should be used by advanced users only.
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820

Workstations
Heading Option Description
File System Information  Displays the following system characteristics:

e  Product Name

e Memory Size

e  SKU Number

e Integrated MAC 1

e Integrated MAC 2

e  System BIOS

e  Boot Block Date

e  Chassis serial number
e  Asset Tracking Number
e  ME Firmware Version

e  ME Management Mode
e  Processor Type

e  Processor Speed

e  Processor Stepping

e  Cache Size

e DIMMs

About

Displays copyright information.

Set Time and Date

Enables you to set system time and date.

Flash System ROM

Enables you to upgrade the BIOS from a ROM image on diskette, CD, or USB.

Replicated Setup

Provides these options:

e  Save to Removable Storage Device—Saves the workstation configuration, including
CMOS, in the gsetup.ixt file. This file can be saved to a USB device or other storage
media.

e  Restore from Removable Storage Device—Restores the workstation configuration from
a USB device or other storage media.

Default Setup

Provides these options:

e  Save Current Settings as Default—Saves the current setftings as default settings for the
next operation.

e  Restore Factory Settings as Default—Restores the factory settings as the default settings
for the next operation.

Apply Defaults
and Exit

Restores the default settings defined in Default Setup.

Ignore Changes
and Exit

Exits workstation setup without applying or saving changes.
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820
Workstations (continued)

Heading Option Description
Save Changes Saves changes fo system configuration and exits the workstation setup.
and Exit
Storage Device Lists installed non-SCSI storage devices (except SATA devices) and provides options for

Configuration

obtaining specific information about each device:
e  CD-ROM SATAO—Shows the ODD default settings.
o  Default Values (SATA defaults)—

o Translation Mode—Enables the BIOS to determine the translation mode used to
configure a formatted SATA or USB mass storage device. This prevents you from
needing fo know how the mass storage device was formatted. Options are
Automatic, Bit Shift, LBA Assisted, User (Cylinders, Heads, Sectors), and Off.
Automatic is the default.

Ordinarily, you should not change the translation mode selected by the BIOS. If
the selected translation mode is not compatible with the translation mode that
was active when the drive was partitioned and formatted, the data on the disk is
inaccessible.

Storage Options

Provides these options:

e  Removable Media Boot—Enables and disables the ability to start the workstation from
removable media.

e  SATA Mode—Sets the SATA emulation mode with the following options:

> RAID + AHCI—Both the RAID and AHCI OPROMs execute. This emulation mode
is the default and offers the best performance and most functionality.

o IDE —Offers standard SATA supports (four ports only).

e  Serial-ATA Controller—Enhanced, Compatable, or Disabled. The default is Enhanced.
This option is only available when in IDE-mode.

Boot Order

Enables you to configure the boot, diskette drive, and hard disk drive orders by physically
reordering the menu entries. The following is the default boot order presented in the menu:

e  EFI Boot Sources
o USB Floppy/CD
o USB Hard Drive
o ATAPI CD/DVD Drive
e  Llegacy Boot Service
o ATAPI CD/DVD Drive
o USB Floppy/CD
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820

Workstations (continued)

Heading Option

Description

° Hard Drive
° Network Controller

Press Enter to drag a device to a preferred place. Press F5 to remove the device from
consideration as a bootable device. Press F10 to accept.

MS-DOS drive lettering assignments might not apply after an operating system other than
MS-DOS has started.

Boot devices can be disabled in the boot order process. These order changes are stored in
the physical ROM when the F10 Setup changes are confirmed with File>Save Changes
and Exit.

You can temporarily override the boot order. To start one time from a device other than the
default device specified in Boot Order, restart the workstation and press F9 when the
F9=Boot Menu message appears on the screen. After POST completes, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press
Enter. The workstation then starts from the selected nondefault device for this one time.

DPS Selftext

Select a drive—Lets you execute self-tests on SATA hard drives capable of performing Drive
Protection System (DPS) self-tests.

NOTE: This selection appears only when the system has one or more drives capable of
performing the DPS self-tests.

Security Setup Password Enables you to set and enable a setup password for the administrator.
If you create a setup password, you must use it to change workstation setup options, to
flash the ROM, and to make changes to certain Plug and Play seftings under Windows.
Power-On Enables you to set and enable the power-on password.
Password

Password Options

This option becomes available when you create a setup and/or power-on password. It
provides these options:

e  Lock Legacy Resources—Prevents the operating system from changing resources fo
serial, parallel, or diskette controller.

e  Setup Browse Mode—Enables read-only functionality for password info.
e  Password Prompt on F9 & F12—Enables a password prompt on a warm boot.

e  Network Server Mode—Enables network server mode.
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820
Workstations (continued)

Heading

Option

Description

Device Security

Makes the following devices available or hidden to the workstation:
e  Embedded Security Device

e  SAS Controller

e  SCU Controller

e  USB3 Controller

e Intel High Definition (HD) Audio
e 1394 Controller

e  NIC Controller

e NIC1 Controller (select models)
e SATAO

e SATAI

e  Serial Port A

For each device, Device Available is the default setting and allows the operating system to
access the device. Device Hidden makes the device unavailable; it is disabled by the BIOS
and cannot be enabled by the operating system.

NOTE: An entry for enabling Drivelock appears in the setup menu if the workstation has
a Drivelock-compatible hard disk drive.

USB Security

Set workstation USB ports to Enabled/Disabled:
o Front USB Ports—(1-3)

o Rear USB Ports—(1-6)

o Internal USB Ports—(1-6)

Slot Security

Lets you enable or disable any PCI or PCI Express slot.

Network Boot

Enables or disables the ability to boot to the network using the F12 key or the boot order.

System IDs

Provides these options:
o  Asset Tag—A 16-byte string identifying the workstation.

e  Ownership Tag—An 80-byte string identifying ownership of the workstation. This tag
appears on the screen during POST.

e  Universal Unique Identifier (UUID)—Can only be updated if the current chassis serial
number is invalid. (These ID numbers are normally set in the factory and are used to
uniquely identify the workstation.)

e  Keyboard—Enables you fo set the keyboard locale for System ID entry.

Master Boot
Record Security
(MBR)

Enable or Disable—When MBR Security is enabled, the BIOS prevents any changes being
made to the MBR of the current bootable disk while in MS-DOS or Windows Safe Mode.

Most operating systems control access to the MBR of the current bootable disk; the BIOS
cannot prevent changes that may occur while the operating system is running.
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820

Workstations (continued)

Heading Option

Description

System Security

Provides these options:

Data Execution Prevention—Enables or disables Data Execution Prevention mode in
the CPUs. This mode prohibits code from running in pages that were set up as data
pages, and prevents attacks such as buffer overflows. Operating system support is
required for this feature.

Virtualization Technology (VTx)—Enables or disables Intel® Virtualization Technology
to increase workstation performance.

Intel® (VTd)—(Enabled or Disabled) Controls the underlying processor and chipset
features needed to support a virtual appliance.

Interrupt Remapping—Enables or disables—Only available when Intel®(VTx) is
enabled.

Coherency Support—Enables or disables—Only available when Intel® (VTx) is
enabled.

ATS Support—Enables or disables—Only available when Intel® (VTx) is enabled.

Passthrough DMA—Enables or disables—Only available when Intel(R) (VTx) is
enabled.

Embedded Security Device—This option becomes available if Embedded Device is set
to Available under Device Security.

NOTE: Embedded Security Device must be set to Device Available in the Device
Security menu, and you must create a Setup Password, in order to configure the
Embedded Security Device.

Embedded Security Device (Hidden or Available) turns the Trusted Platform
Mechanism (TPM) on and off. Device Hidden is the default. If this option is made
available, the following options become available:

o Power-On Authentication Support—Enables and disables an authentication
feature that requires you to enter a TPM user key password to start the
workstation. This feature uses the TPM to generate and store the authentication
password.

0 Reset Authentication Credential—Resets the authentication functionality and
clears authentication credentials.

To enable the Embedded Security Device and to access any security features
associated with the device, you must enter a setup password.

Sefting a device to Available enables the operating system to access the device.
Hidden makes the device unavailable. It is disabled by the BIOS and cannot be
enabled by the operating system.
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820
Workstations (continued)

Heading

Option

Description

CAUTION: Choosing Reset to Factory Settings may result in significant data loss.
The embedded security device is a critical component of many security schemes.
Erasing the security keys prevent access to data protected by the Embedded Security
Device.

e  OS Management of Embedded Security Device—Enables or disables the ability of the
operating system to control the TPM device, including turning it on and off, initializing
it, and resefting it.

o Reset of Embedded Security Device through OS—Enables or disables the ability
of the operating system to reset the TPM. Available only when OS Management
of Embedded Security Device is enabled.

Drivelock Security

Lets you assign or modify a master password or user password for hard drives. When
enabled, this feature prompts the user to provide one of the Drivelock passwords during
POST. If the user does not successfully enter one of the passwords, the hard drive remains
inaccessible until one of the passwords is successfully entered during a subsequent cold-
boot sequence.

NOTE: This selection appears only when the system includes at least one drive that
supports the Drivelock feature.

Power

OS Power
Management

Enables or disables:
e  Runtime Power Management—(Enable or Disable)
e  Turbo Mode—(Enable or Disable)

e Idle Power Savings—Extended (default) or Normal; extended mode reduces processor
power consumption when the CPU is idle.

e  Unique Sleep State Blink Rates—(Enable or Disable)

Hardware Power

Enables or disables:

Management
e  SATA Power Management
e S5 Maximum Power Savings
Thermal Enables you to set the rate of the system fan when the CPU is in idle (Fan Idle Mode).
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820

Workstations (continued)

Heading Option

Description

Advanced? Power-On Options

Enables you to set the following:
e  POST Messages—Enables or disables the splash screen during POST.
e  Press the ESC key for Startup Menu.

e  Option ROM!' prompt (Enable or Disable)—Enabling this feature causes the
workstation to display a message before loading options ROMs.

e  After Power Loss (On, Off, Last State)—Enabling this option directs the previous state

to be the default.

e  POST Delay (in seconds) (5, 10, 15, 20, None)—Adds a specified delay to the POST

process. This delay is sometimes needed for hard disk drives on some expansion

cards that spin up slowly (so slowly that they are not ready to start by the time POST

is finished). The POST delay also gives you time to select F10 to enter the Computer
Setup (F10) Utility.

e  Remote Wakeup Boot Source—Enables you to set the remote wakeup boot source as:

° Local Hard Drive
° Remote Server

e  Bypass F1 Prompt on Configuration Changes.

BIOS Power-On

Enables you to disable or specify a weekday and time for BIOS power-on.

Onboard Devices

Enables you to set resources (IRQ, DMA, 1/O Rate) for or disable onboard system devices
such as serial port and diskette controller. Operating system parameters generally override

Onboard Devices seftings.

Bus Options

Configures graphics cards per workstation slots. In multi-graphics card configurations, this

option designates one card as primary graphics, and the other card as secondary
graphics.

e Numa—(Enable or Disable)

e  SERR# Generation (Enabled/Disabled)—Controls PCI SERR# generation for ill-
behaved PCl add-in cards (that can generate SERR# spuriously)

e  VGA Palette Snoop (Disabled/Enabled)—Controls PCl VGA Palette Snooping for
compatibility purposes

e  PCl Latency Timer—(32/64/128/160/192/224/248). 128 PCl Clocks is the
default.
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Table 2-2 Computer Setup (F10) Utility menu descriptions for the HP Z420, Z620, and the Z820
Workstations (continued)

Heading Option Description

Device Options Enables you to set the following device options:
e Num Lock State at Power-On (On or Off)
e S5 Wake-on-lAN (Enable or Disable)
e Internal speaker—(Enable or Disable)
e  NIC Option ROM' Download (Enable or Disable)
e NIC1 Option ROM' Download (Enable or Disable)
e  SATA RAID Option ROM' Download (Enable/EFI/Disable)

e  SAS Option ROM' Download (Enable/EFl/Disable) (Not available on some
workstations.)

e  SCU Option ROM Download (Enable/EFl/Disable) (Not available on some
workstations.)

e  Multiprocessor (Activates a single core.)—(Enable or Disable)

e  Active Processor Cores—Selects a single core, or multiple cores per socket
e  Hyper-Threading—(Enable or Disable)

e  CECP Mode—(Enable or Disable)

Slot Settings Enable/disable the PCle and PCl slots (1 - 7).
AMT Lets you set the following AMT (Intel Active Management Technology) configuration
Configuration options:

e  AMT (Enabled/Disabled)—Allows for remote discovery, repair and protection of
networked workstations. Enabling the AMT function also enables the Network
Controller (required for AMT to function correctly).

e Unconfigure AMT/ME (Disabled/Enabled) 2—Restores AMT/ME defaults. When you
save and exit after enabling this option, you will be prompted to complete the process
upon restart. A Setup Password (even if one is set) does not need to be entered to
complete the process.

NOTE: Information about Intel AMT can be found at www.intel.com.

e  WatchDog Timer (Enabled/Disabled)—OS and BIOS WatchDog Timers can be set
independently (in minutes):

o OS WatchDog TimerTimer—Sets the OS WatchDog Timer

o BIOS WatchDog Timer—Sefs the BIOS WatchDog Timer

1 Available on selected models
2 These options should be used by advanced users only
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Desktop management

This section summarizes capabilities, features, and key components of computer management,
including:

Topics

Initial computer configuration and deployment on page 61

Installing a remote system on page 61

Copying a setup configuration to another computer on page 62

Updating and managing software on page 63

HP Client Management Solutions on page 63

Altiris Client Management Solutions on page 63

HP SoftPag Download Manager on page 64

System Software Manager on page 64

ROM Flash on page 64

FailSafe Boot Block on page 64

Workstation security on page 65

Fault notification and recovery on page 75

Programmable power button on page 76

I%NOTE: Support for specific features described in this guide can vary by model and software version.
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Initial computer configuration and deployment

The computer includes a preinstalled system software image. After a brief software unbundling process,
the computer is ready to use.

If you prefer to replace the preinstalled software image with a customized set of system and application
software, you can deploy a customized software image by:

e Installing additional software applications after unbundling the preinstalled software image
e Using a disk cloning process to copy the contents from one hard disk drive to another

The HP Recovery Manager DVDs, ROM-based setup, and ACPI hardware provide further assistance
with recovery of system software, configuration management and troubleshooting, and power
management.

Support for specific features described in this guide can vary by model and software version.

The best deployment method depends on the information technology environment and processes.

Installing a remote system

Remote system installation enables starting and setting up the computer using software and
configuration information on a network server. This feature is usually used for system setup and
configuration and can be used to:

e Deploy a software image on new PCs

e Format a hard disk drive

e Install application software or drivers

e Update the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the
lower right corner of the HP logo screen. Follow the onscreen instructions to continue the installation
process. The default boot order is a BIOS configuration setting that can be changed to always attempt
a network boot.
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Copying a setup configuration to another computer
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This section provides information about replicating the computer setup.

/\ CAUTION: Setup configuration is model-specitic. File system corruption can result if source and
target computers are not the same model.

To copy a setup configuration:
1. Select a setup configuration to copy, and then restart the computer.

2. As soon as the computer powers on, press and hold F10 until you enter the Computer Setup (F10)
Utility. If necessary, press Enter to bypass the title screen.

E%?NOTE: It you do not press F10 at the appropriate time, you must restart the computer, and then
press and hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select File > Replicated Setup > Save to Removable Storage Device. Follow the
instructions on the screen to create the configuration file cpgsetup.txt and write it to a USB storage
device.

4. Power off the computer you are configuring and insert the removeable USB media device
containing the configuration file.

5. Power on the computer you are configuring.

6. Press and hold the F10 key until you enter the Computer Setup (F10) Utility. If necessary, press
Enter to bypass the title screen.

7. Select File > Replicated Setup > Restore from Removable Storage Device, and then
follow the instructions on the screen.

8. Restart the computer when the configuration is complete.
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Updating and managing software

HP provides several tools for managing and updating software on desktops and computers:

HP Client Manager Software
Altiris Client Management Solutions
HP SoftPaq Download Manager

System Software Manager

HP Client Management Solutions

HP Client Management Solutions (CMS), available for download from http://www.hp.com/go
easydeploy, are standards-based solutions for managing and controlling computers in a networked
environment.

HP Client Management Solutions offers these services:

Detailed views of hardware inventory for asset management

PC health-check monitoring and diagnostics

Proactive notification of changes in the hardware environment

Web-accessible reporting of business-critical details such as thermal warnings and memory alerts
Remote updating of system software such as device drivers and ROM BIOS

Remote changing of boot order

Configuration of system BIOS settings

Altiris Client Management Solutions

Altiris and HP have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs.

The HP CMS is the foundation for additional Altiris Client Management Solutions that address the
following topics.

Inventory and asset management
Deployment and migration
Help desk and problem resolution

Software and operations management

Go to http://www.hp.com/go/Altiris_Solutions for information about:

How HP CMS works

Which solutions are compatible with the operating system

How to download a fully functional, 30-day evaluation version of Altiris solutions
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HP SoftPaq Download Manager

HP SoftPaq Download Manager is a free, easy-o-use interface for locating and downloading software

updates for the HP client PC models in your environment. By specifying your models, operating system,

and language, you can quickly locate, sort, and select the softpags you need. For more information, go
to http://www.hp.com/go/sdm.

System Software Manager

System Software Manager (SSM) is a utility available on Windows computers that enables you to
update system-level software on multiple systems simultaneously. When executed on a PC client system,
SSM detects hardware and software versions and then updates the software from a central repository,
known as a file store. Driver versions supported by SSM are noted with a special icon on the software,
the driver download website, and on the Support Software CD.

To download the utility or to obtain more information about SSM, see http://www.hp.com/go/ssm.

ROM Flash

BIOS settings are stored on a programmable flash ROM. By establishing a setup password in the
Computer Setup (F10) Utility, you can protect unauthorized users from modifying the BIOS settings. This
function is important to ensure the operating integrity of the computer.

To upgrade the BIOS, download the latest SoftPaq images from http://www.hp.com/support/
workstation_swdrivers.

Remote ROM Flash

Remote ROM Flash allows system administrators to safely upgrade the ROM on remote HP computers
from a centralized network management console, resulting in a consistent deployment of, and greater
control over, HP PC ROM images over the network.

To use Remote ROM Flash, the computer must be powered on, or turned on using Remote Wakeup.

For more information about Remote ROM Flash and HPQFlash, see the HP Client Manager Software or
System Software Manager sections at http://www.hp.com/go/ssm.

HPQFlash

The HPQFlash utility is used to locally update or restore the system ROM on PCs using a Windows
operating system. For more information about HPQFlash, see http://www.hp.com/go/ssm, and enter
the name of the computer.

FailSafe Boot Block

64

The FailSafe Boot Block enables BIOS recovery in the unlikely event of a ROM flash failure. For
example, if a power failure occurs during a ROM upgrade, the Boot Block uses a flash-protected
section of the ROM to verify a valid system ROM flash when power is restored to the computer.

If the system ROM is valid, the computer starts normally.
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If the system ROM fails the validation check, the FailSafe Boot Block provides enough support to start
the computer from a BIOS image CD created from a SoftPaq. The BIOS image CD programs the system
ROM with a valid image.

When Boot Block detects an invalid system ROM, the computer power LED blinks red eight times and
the computer beeps eight times; then the computer pauses for two seconds. On some models, a Boot
Block recovery mode message appears.

In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image
CD or USB key.

Recovering the computer from Boot Block Recovery mode

To recover the computer after it enters Boot Block recovery mode:
1. Remove any media such as USB keys or disks in the optical disk drives.

2. Insert a BIOS image CD into the DVD drive. You can also use USB media such as an HP DriveKey.

3. Power off, then power on the computer.

If no BIOS image CD or USB media is found, you are prompted to insert one and restart the
computer.

If a setup password has been established, the Caps Lock light illuminates and you are prompted
for the password.

4. Enter the setup password.

If the computer starts from the boot media and successfully reprograms the ROM, three keyboard
lights illuminate and a risingtone series of beeps signals successful recovery.

Remove the boot media and power off the computer.

6. Restart the computer.

Workstation security

This section provides information about providing system security through asset tracking, password
security, hard disk drive locking, and chassis locks.
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Asset tracking

Asset tracking features provide asset tracking data that can be managed using HP Systems Insight
Manager (HP SIM), HP Console Management Controller (CMC), or other systems-management
applications.

Seamless, automatic integration between asset tracking features and these products enables you to
choose the management tool that is best suited to the environment and to leverage investments in
existing tools.

HP also offers several solutions for controlling access to valuable components and information:

e  HP ProtectTools Embedded Security prevents unauthorized access to data, checks system integrity,
and authenticates third-party users attempting system access.

e  Security features such as ProtectTools and the Smart Cover Sensor (side access panel sensor) help
prevent unauthorized access to the data and to the internal components of the computer.

e By disabling parallel, serial, or USB ports, or by disabling removable-media boot capability, you
can protect valuable data assets.

e  Memory Change and Side access panel sensor (Smart Cover Sensor) alerts can be forwarded to
system management applications to deliver proactive notification of tampering with a computer’s
internal components.

ProtectTools, the Smart Cover Sensor, and the side access panel solenoid lock (Hood Lock) are
available as options on select systems.

You can manage security seftings:
e  Locally with the Computer Setup (F10) Utility

e  Remotely with HP CMS or HP System Software Manager (SSM), which enable the secure,
consistent deployment and control of security settings from a simple command line utility

For more information about the Computer Setup (F10) Utility, see The Computer Setup (F10) Utility
menu on page 44.

The following Computer Setup (F10) Utility features let you manage computer security.

Table 2-3 F10 security features overview

Feature Purpose
Removable Media Boot Control Prevents booting from removable media drives
Serial, Parallel, USB, or Infrared Prevents transfer of data through the integrated serial, parallel, USB, or infrared
Interface Control interface

Prevents use of the computer until the password is entered (applies to initial system

Power-On Password
startup and restarts)

Prevents reconfiguration of the computer (through the Setup utility) until the

Setup Password ;
up s password is entered

Network Server Mode Provides unique security features for computers used as servers
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SATA hard disk drive security

HP computers include the HP Drivelock facility for SATA hard disk drives to prevent unauthorized
access to data.

/\ WARNING! Enabling Drivelock can render a SATA hard disk drive permanently inaccessible if the
master password is lost or forgotten. No method exists to recover the password or access the data.

Drivelock has been implemented as an extension to Computer Setup (F10) functions. It is only available
when hard disk drives that support the ATA security command set are detected. On HP computers, it is
not available when the SATA emulation mode is RAID+AHCI or RAID.

Drivelock is for HP customers for whom data security is a paramount concern. For such customers, the
cost of a hard disk drive and the loss of the data stored on it is inconsequential when compared to the
damage that could result from unauthorized access to its contents.

To balance this level of security with the need to address the issue of a forgotten password, the HP
implementation of Drivelock employs a two-password security scheme. One password is intended to be
set and used by a system administrator, while the other is typically set and used by the user.

No "back door" can be used to unlock the drive if both passwords are lost. Therefore, Drivelock is
most safely used when the data contained on the hard disk drive is replicated on a corporate
information system or is regularly backed up.

If both Drivelock passwords are lost, the hard disk drive is rendered unusable. For users who do not fit
the previously defined customer profile, this might not be acceptable. For users who fit this profile, it
might be a tolerable risk, given the nature of the data stored on the hard disk drive.
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DriveLock applications

The most practical use of Drivelock is in a corporate environment. The system administrator would be
responsible for configuring the hard disk drive, which involves setting the Drivelock master password
and a temporary user password. If you forget the user password or if the equipment is passed on to

another employee, the master password can be used to reset the user password and regain access to

the hard disk drive.

HP recommends that corporate system administrators who enable Drivelock also establish a corporate
policy for setting and maintaining master passwords. This should be done to prevent a situation where
an employee sets both Drivelock passwords before leaving the company. In such a scenario, the hard
disk drive is unusable and requires replacement. Likewise, by not setting a master password, system
administrators might find themselves locked out of a hard disk drive and unable to perform routine
checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling Drivelock. Users in
this category include personal users, or users who do not maintain sensitive data on their hard disk
drives as a common practice. For these users, the potential loss of a hard disk drive resulting from
forgetting both passwords is much greater than the value of the data Drivelock protects.

Access to Computer Setup (F10) and Drivelock can be restricted through the setup password. By
specifying a setup password and not giving it to users, system administrators can restrict users from
enabling Drivelock.

Using Drivelock
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When hard disk drives that support the ATA security command set are detected, Drivelock appears
under the Security menu in the Computer Setup (F10) menu. You are presented with options to set the
master password and to enable Drivelock. You must provide a user password to enable Drivelock.
Because the initial configuration of Drivelock is typically performed by a system administrator, a master
password should be set first.

HP encourages system administrators to set a master password whether they plan to enable Drivelock
or not. This gives the administrator the ability to modify Drivelock settings if the drive is locked in the
future. After the master password is set, the system administrator can enable Drivelock or leave it

disabled.

If a locked hard disk drive is present, POST requires a password to unlock the device. If a power-on
password is set and it matches the device’s user password, POST does not prompt the user to re-enter
the password. Otherwise, the user is prompted to enter a Drivelock password.

For a cold start, use the master or user password. For a warm start, enter the same password used to
unlock the drive during the preceding cold start.

Users have two aftempts to enter a correct password. During cold start, if neither attempt succeeds,
POST continues but the drive remains inaccessible. During a warm-start or restart from Windows, if
neither attempt succeeds, POST halts and the user is instructed to cycle power.
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Enabling Drivelock

To enable and set the Drivelock user password:

1.
2,

Power on or restart the computer.

As soon as the computer is powered on, repeatedly press the F10 key until you enter the
Computer Setup (F10) Utility.

If you do not press F10 at the appropriate time, you must restart the computer, then repeatedly
press F10 again to access the utility.

Select Security > DriveLock Security.
For each Drivelock-capable drive, select a drive by pressing F10 to accept.

Under Enable/Disable Drivelock options, select Enable, and then press F10 to enable Drivelock
for a specific drive.

@NOTE: To set the Drivelock master password, select Master.

/\ CAUTION: If you forget the Drivelock password, the drive is unusable.

6.
7.

8.

Enter a new user password (1 to 32 characters long), and then press F10 to accept.

Enter the password again in the Enter New Password Again field. If you forget this password, the
drive is rendered permanently disabled.

Select File > Save Changes and Exit, and then press Enter to accept the changes. After you
press Enter, the computer performs a cold start before invoking the Drivelock function.

When the computer starts, you are prompted to enter the Drivelock password for each Drivelock-
capable drive for which you have set a password. You have two attempts to enter the password
correctly. If the password is not entered correctly, the computer attempts to start anyway.

However, the boot process most likely fails because data from a locked drive cannot be accessed.

In a single drive computer, if the drive has Drivelock enabled, the computer might not be able to
boot to the operating system, and might try to boot from the network or from another storage
device (depending on the boot ordering options). Regardless of the outcome of the start attempts,
the drive-locked drive remains inaccessible without the Drivelock password.

In a two-drive computer that has a boot drive and a data drive, you can apply the Drivelock
feature to the data drive only. In this case, the computer can always start, but the data drive is
accessible only when the Drivelock password is entered.

Cold starts require that you enter Drivelock passwords. However, Drivelock passwords are also
required for warm starts. For example, if you boot to DOS and press Cirl+Alt+Del, you must enter
the Drivelock password before the computer completes the next start cycle. This warm-start
behavior is consistent with the Drivelock feature.

Desktop management

69



Password security

The power-on password prevents unauthorized use of the computer by requiring entry of a password to
access applications or data when the computer is powered on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override fo the power-on password. When prompted for the power-on password, entering the setup
password instead enables access to the computer.

You can establish a network-wide setup password to enable the system administrator to log in to all
network systems to perform maintenance without needing to know the power-on password.

Establishing a setup password using Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
computer (through the use of the Computer Setup (F10) Utility) until the password is entered.

To establish a setup password using the Computer Setup (F10) menu:
1. Power on or restart the computer.

2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the computer, and then press and
hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
Select Security > Setup Password and then follow the onscreen instructions.

4. Before exiting, select File > Save Changes and Exit.
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Establishing a power-on password using computer setup

Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
computer when power is connected, unless you specify the password. When a power-on password is
set, the Computer Setup (F10) Utility presents Password Options in the Security menu. The password
options include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, you must enter the password when the computer is powered
on, when the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, you
must enter the password. The password must also be entered each time the computer is restarted.
When Network Server Mode is enabled, the password prompt is not presented during POST, but an
attached PS/2 keyboard remains locked until you enter the power-on password.

To enable Network Server Mode, you must set a power-on password under Advanced > Password
Options. This option enables the computer to start without requiring the power-on password, but the
keyboard and mouse are locked until you enter the password. The keyboard LEDs rotate constantly
when the computer is in locked mode.

To establish a power-on password through the Computer (F10) menu:
1. Power on or restart the computer.

2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the computer and then press and
hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
Select Security > Power-On Password and then follow the onscreen instructions.

Before exiting, select File > Save Changes and Exit.

Entering a power-on password

To enter a power-on password:

1. Restart the computer.

2. When the key icon appears on the monitor, enter the current password, and then press Enter.
Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you will enter the F10 setup screen with read-only permission. (See the Setup Browse Mode option
under the Power-On options.)
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Entering a setup password

If a setup password has been established on the computer, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.

To enter a setup password:
1. Restart the computer.

2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the computer and press and hold
F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
3.  When the key icon appears on the monitor, enter the setup password, and press Enter.
Type caretully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the computer before you can continue.

Changing a power-on or setup password

To change a power-on or setup password:
1. Restart the computer.
2. To change the power-on password, go to step 4.

3. To change the setup password, as soon as the computer is powered on, press and hold F10 until
you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the computer, and then press and
hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

4. When the key icon appears, enter the current password, a slash (/) or alternative delimiter
character, the new password, another slash (/) or alternative delimiter character, and the new
password again as shown:

current password/new password/new password

For information about the alternative delimiter characters, see National keyboard delimiter
characters on page 73.

Type carefully. For security reasons, the characters you enter do not appear on the screen.
5. Press Enter.
The new password takes effect the next time you power on the computer.

The power-on and setup passwords can also be changed using the Security options in the Computer
Setup (F10) Utility.
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Deleting a power-on or setup password

To delete a power-on or setup password:
1. Power on or restart the computer.
2. Choose from the following:
e To delete the power-on password, go to step 4.

e To delete the setup password, as soon as the computer is powered on, press and hold F10
until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.

If you do not press F10 at the appropriate time, you must restart the computer and then press
and hold F10 again to access the utility.

Use the appropriate operating system shutdown process.

3. When the key icon appears, enter the current password followed by a slash (/) or alternative
delimiter character: current password/.

For information about the alternative delimiter characters see the following section.

4. Press Enter.

National keyboard delimiter characters

Each keyboard meets country-specific requirements. The syntax and keys you use for changing or
deleting passwords depend on the keyboard included with the computer.

Table 2-4 National keyboard delimiter characters

Language Delimiter Language Delimiter Language Delimiter
Arabic / Greek - Russian /
Belgian = Hebrew . Slovakian
BHCSY " - Hungarian - Spanish

Brazilian / ltalian - Swedish/Finnish /
Chinese / Japanese / Swiss
Czech - Korean / Taiwanese /
Danish - Latin American - Thai /
French ! Norwegian - Turkish
French Canadian é Polish - U.K. English /
German - Portuguese - U.S. English /

Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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Clearing passwords

If you forget the password, you cannot access the computer.

For instructions about clearing passwords, see Configuring password security and resetting CMOS
on page 158.

Chassis security

Smart Cover Sensor (optional)

The optional Smart Cover Sensor is a combination of hardware and software technology that alerts you
if the interior or the computer is accessed (provided the sensor has been configured in the Computer
Setup (F10) Utility). The sensor alerts you when the side panel is removed.

Three levels of protection are available:

Table 2-5 Smart Cover Sensor protection levels

Level Setting Description

Level O Disabled Sensor " is disabled (default).

When the computer restarts, a message indicates that the computer has been

Level 1 Notify U
eve oty Hser opened or the access panel has been removed.

When the computer restarts, a message indicates that the computer has been
Level 2 Setup Password opened or the access panel has been removed. You must enter the setup
password fo continue.

Smart Cover Sensor settings can be changed using the Computer Setup (F10) Utility.

Setting the protection level

To set the Smart Cover Sensor protection level:
1. Power on or restart the computer.

2. During startup, press and hold the F10 key until you enter the Computer Setup (F10) Utility. Press
Enter to bypass the title screen, if necessary.

E%?NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer,
and then press and hold the F10 key again to access the Computer Setup (F10) Utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security > Smart Cover > Cover Removal Sensor, and follow the onscreen
instructions.

4. Before exiting, select File > Save Changes and Exit.
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Side access panel solenoid lock (HP Z420 Workstation only)

The side access panel solenoid locks the side access panel to the chassis. The solenoid is controlled by
a local or remote signal.

To lock the solenoid, set a password for the solenoid lock in the Computer Setup (F10) Utility. To unlock
the solenoid, remove the solenoid lock password in the Computer Setup (F10) Utility.

The solenoid lock FailSafe Key (available from HP) is is a device for manually disabling the solenoid
lock. You will need the FailSafe Key in case of forgotten password, power loss, or computer
malfunction.

Cable lock (optional)

To prevent theft, you can attach a keyed cable lock to the rear chassis panel. This cable lock attaches
to the chassis and secures it to the work area.

Fault notification and recovery

Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network that is managed by HP CMS, the computer sends a fault
notice to the network management application. With HP CMS, you can also remotely schedule
diagnostics to run on managed PCs and create a summary report of failed tests.

Drive Protection System

The Drive Protection System (DPS) is a diagnostic tool built into hard disk drives and is installed in select
HP computers. The DPS helps diagnose problems that might result in unwarranted hard disk drive
replacement.

When HP computers are built, each installed hard disk drive is tested using the DPS, and a permanent
record of key information is written onto each drive. Every time the DPS is run, test results are written to
the hard disk drive. The service provider can use this information to help diagnose conditions that
required you to run the DPS software.

ECC fault prediction
When the computer encounters an excessive number of error checking and correcting (ECC) memory
errors, it displays a local alert message. This message contains information about the errant DIMM,

enabling you to take action before you experience noncorrectable memory errors. ECC DIMMs are
standard on this computer.

Thermal sensors

Several thermal sensors in the HP workstation regulate computer fans to maintain an acceptable,
efficient chassis temperature.
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Programmable power button

With ACPI (Advanced Configuration and Power Interface) enabled, you can customize the behavior of
the power button so that rather than powering down, the workstation enters sleep mode (low power
state), or hibernate mode (very low power state). This lets you go to standby without closing
applications, and then return to the same operational state without any data loss.

Changing the power button configuration (Windows only)

To change the power button configuration:

1. Select Start, and then select Control Panel > System and Security > Power Options.
2. In Power Options Properties, select Choose What the Power Button Does.

3. Select the desired options.

If you choose sleep or hibernate, you can press the power button to go to standby, then press it again
to enter full power state. To completely power down the workstation, select Start > Shut Down.

2»NOTE: If the computer is unresponsive, press and hold the power button for four seconds to
completely turn off power to the computer.

/\ CAUTION: Do not use the power button to power off the computer unless the system is not
responding, as data loss can occur.
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Component Replacement
Information and Guidelines

This chapter provides warnings, cautions, information, and guidelines for removal and replacement
procedures. It does not document the step-by-step procedures.

E'%IMPORTANT: Removal and replacement procedures are now avadilable in videos on
the HP website.

Go to the HP Customer Self Repair Services Media Library at http://www.hp.com/go/sml.

This chapter includes these topics:

Topics

Warnings and cautions on page 78

Service considerations on page 79

Product recycling on page 81

Component replacement guidelines on page 81
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Warnings and cautions

78

/\ WARNING! These symbols on any surface or area of the equipment indicate the following:

& Presence of a hot surface or hot component. If this surface is contacted, the potential for injury
exists. To reduce the risk of injury from a hot component, let the surface cool before touching.

A Presence of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not
open any enclosed area marked with this symbol.

%l% Product must always be liffed by two persons to avoid personal injury due to product weight.

/\ WARNING! To reduce the risk of electric shock or damage to your equipment:
— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

/\ WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes
proper computer setup, posture, health, and work habits for computer users, and provides important
electrical and mechanical safety information. This guide is located at http://www.hp.com/ergo.

/\ WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the
computer. Lifting the computer from the front bezel, or lifting it incorrectly, could cause the computer to
fall, causing possible injury to you and damage to the computer. To properly and safely lift the
computer, lift from the bottom of the computer.

/\ CAUTION: Static electricity can damage the electronic components of the computer. To prevent
damage to the computer, observe the following Electrostatic Discharge (ESD) precautions while
servicing the computer:

— Discharge static electricity by briefly fouching a grounded metal object before you begin.
— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your
body to the ground.

— Create a common ground for the equipment you are working on by connecting the staticfree mat,
static strap, and peripheral units to that piece of equipment.

@NOTE: HP accessories are for use in HP products. They have been extensively tested for reliability
and are manufactured to high quality standards.
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Service considerations

Tools and software requirements

The tools necessary for computer component removal and installation are:
e Torx T-15 driver
e  Flat blade and cross+ip screwdrivers

e Diagnostics software

Electrostatic discharge (ESD) information

Generating static  Different activities generate different amounts of static electricity through electrostatic discharge

(ESD). Static electricity increases as humidity decreases.

CAUTION: Static electricity in the amount of 700 volts might degrade a product.

Relative humidity

Event
55% 40% 10%
Walking across carpet 7,500V 15,000V 35,000V
Walking across vinyl floor 3,000V 5,000V 12,000V
Motions of bench worker 400V 800V 6,000V
Removing bubble pack from PCB 7,000V 20,000V 26,500V
Packing PCBs in foam-lined box 5,000V 11,000V 21,000V
Preventing ESD Many electronic components are sensitive to ESD. Circuitry design and structure determine the
equipment degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage damage to electric components and accessories:

e  Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand
contact.

e  Protect electrostatic parts and assemblies with nonconductive or approved containers or

packaging.
o  Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.
e  Place items on a grounded surface before removing them from containers.

e When handling or touching a sensitive component or assembly, ground yourself by touching
the chassis.

e Avoid contact with pins, leads, or circuitry.

e  Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
nonconductive foam.
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Personal
grounding
methods and
equipment

Use the following items to help prevent ESD damage:

e  Wrist straps — These are flexible straps with a maximum of one megohm + 10% resistance
in the ground cords. To provide a proper ground, wear the strap against bare skin. The
ground cord must be connected and fit snugly into the banana plug connector on the

grounding mat or computer.

e Heel straps, toe straps, and boot straps — These can be used at standing computers
and are compatible with most types of shoes or boots. On conductive floors or dissipative
floor mats, use them on both feet with a maximum of one megohm + 10% resistance between

the operator and ground.

Static shielding
materials

Static shielding materials provide the following levels of protection.

Method
Antistatic plastic
Carbon-loaded plastic

Metalized laminate

Voltage
1,500V
7,500V
15,000V

Grounding the
work area to
prevent static

e  Cover the work surface with approved
static-dissipative material. Use a wrist
strap connected to the work surface, and

Disconnect power and input signals before
inserting and removing connectors or test
equipment.

damage properly grounded tools and equipment. ) ) )
Use fixtures made of static-safe materials

e  Use static-dissipative mats, foot straps, or when fixtures must directly contact
air ionizers to give added protection. dissipative surfaces.

e  Handle electrostatic-sensitive Keep work area free of nonconductive
components, parts, and assemblies by materials, such as plastic assembly aids and
the case or PCB laminate. Handle them Styrofoam.
only in static-free work areas.

Use field service tools (such as cutters,
screwdrivers, and vacuums) that are
conductive.

Recommended e Antistatic tape Static awareness labels

ESD prevention
materials and
equipment

e  Antistatic smocks, aprons, and sleeve
protectors

e  Conductive bins and other assembly or
soldering aids

e  Conductive foam

e  Conductive tabletop computers with a
ground cord of one megohm + 10%
resistance

e  Staticdissipative table or floor mats with
a hard+ie to ground

e Field service kits

Wrist straps and footwear straps providing
one megohm + 10% resistance

Material-handling packages
Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opagque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes
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Product recycling

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.

Component replacement guidelines

This section provides information and guidelines for removal and replacement procedures. It does not
document the step-by-step procedures.

E‘%IMPORTANT: Removal and replacement procedures are now available in videos on
the HP website.

Go to the HP Customer Self Repair Services Media Library at http://www.hp.com/go/sml. In Media
Selection, choose the Desktops & Workstations product category and the Personal
Workstations product family, then choose your platform

This chapter provides guidelines for removal and replacement procedures. Topics include:

Battery on page 81

Cable management on page 82

CPU (processor) and CPU heatsink on page 83

Expansion slots on page 84

Hard disk drives and optical disc drives on page 94

Memory on page 101

Power supply specifications on page 107

System board on page 109

Battery

The battery that comes with the computer provides power to the realtime clock and has a minimum
lifetime of about three years. Observe the following warning and caution when replacing the battery.

/\ WARNING! HP Z series Workstations use lithium batteries. There is a risk of fire and chemical burn
if the battery is handled improperly. Do not disassemble, crush, puncture, short external contacts,
dispose of in water or fire, or expose battery to temperatures higher than 60°C (140°F).

/\ CAUTION: Before removing the battery, back up the CMOS settings in case they are lost when the
battery is removed. Use the the Computer Setup (F10) Utility to back up the settings.

E%?NOTE: Do not dispose of batteries, battery packs, and accumulators with general household waste.
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Cable management

Proper routing of the internal cables is critical to the operation of the workstation. Follow good cable
management practices when removing and installing components.

e Handle cables with care to avoid damage.

e  Apply only the tension required to seat or unseat cables during insertion or removal from the
connector.

e When possible, handle cables by the connector or pull-strap.

e  Route cables in such a way that they cannot be caught or snagged by parts being removed or
replaced.

e Keep cables away from direct contact with major heat sources, such as the heatsink. (Some air
flow guides have a cable guide that lets you route cables safely around the heatsink.)

e Do not jam cables on top of expansion cards or DIMMs. Circuit cards and DIMMs are not
designed to take excessive pressure.

e Keep cables clear of movable or rotating parts (such as the power supply and drive cage) to
prevent them from being cut or crimped when the component is lowered into its normal position.

e Inall cases, avoid bending or twisting the cables. Do not bend any cable sharply. A sharp bend
can break the internal wires.

e Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.
e Never crease a SATA data cable.

e Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves or in the cable
guides and chassis areas designed for cable routing.

When removing the power supply power cable from the connector on the system board, always follow
these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector.

2. Grasp the cable end of the connector and pull it straight out.

/\ CAUTION: Always pull the connector — NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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CPU (processor) and CPU heatsink

/\ CAUTION: Observe the following cautions when removing or replacing the heatsink.

— When removing the heatsink, loosen all screws a little at a time to ensure the CPU remains level. Do
not fully loosen one screw, and then move on to the next.

— After you remove the CPU heatsink from the chassis, use alcohol and a soft cloth to clean the thermal
compound residue from the CPU and the heatsink, allowing the alcohol on the CPU and CPU heatsink
to dry completely.

— If you are reusing the original heatsink, apply thermal compound to the center of the CPU top
surface.

— If you are using a new CPU heatsink, do not apply thermal compound to the CPU because the new
heatsink already has thermal compound applied to the heatsink surface. Instead, remove the thermal
compound protective liner from the bottom of the new heatsink.

— Do not overtighten the heatsink screws. Overtightening can strip the threads in the chassis.

— Do not fully tighten one screw and then move on to the next. Instead, tighten all screws a little ot a
time, ensuring that the CPU remains level.

CAUTION: Observe the following cautions when removing or replacing the CPU.
— If you are installing a second CPU, it must be of the same type as the first CPU.

— Internal components might be powered even when the computer is off. To prevent damage,
disconnect the computer power cord before you remove or install a component.

— The CPU socket contacts and pads are extremely fragile. Do not touch the CPU socket contacts or
the gold pads underneath the CPU. Use extreme care and handle the CPU only by the edges.

— The CPU socket contacts are delicate and bend easily. To avoid bending the contacts, use extreme
care when installing the CPU in the socket.

— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller
or service provider to install the processor. If you plan to install the processor yourself, view the entire
remove and replace video before you begin.

— Failure to follow the computer preparation instructions can result in an improperly installed
processor, causing extensive computer damage.
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Expansion slots

This section identifies and describes computer expansion card slots, and presents card configuration
information.

Go to http://www.hp.com/go/quickspecs to learn which graphics cards are supported in the
workstation, how much memory each graphics card includes, and graphics card power requirements.

Card configuration restrictions for power supplies

CAUTION: To prevent damage, the overall power consumption of the computer (including I/O
P 9 P P P 9
cards, CPU, and memory) must not exceed the maximum rating of the computer power supply. For
power supply information, see Power supply specifications on page 107.

Choosing an expansion card slot

Whenever possible, use the following tips to help you select the proper slot for an expansion card:

e  Use the PCle x16 slot for the primary graphics card. If you do not use this slot for the graphics
card, only cards certified as After Market Options are supported.

e Install a second graphics card in the other PCle x16 slot.

e Install a card in a slot that most closely matches its interface technology:

o

o

o

o

o

Install a PCle Gen1 x16 or a PCle Gen1 x8 card in the PCle Gen2 x16 slot.
Install a PCle Gen1 x4 card in the PCle Gen1 x4 slot.

Install a PCle Gen1 x1 card in the PCle Gen1 x1 slot.

Install a PCl card in the PCl slot.

Whenever possible, install a PCle x1 card in an x1 slot.

e Leave as much space as possible between cards (especially graphics cards) to allow heat to
dissipate more efficiently.

e  For best operational efficiency, select a slot that:

o

o

o

Electrically matches the number of PCle card lanes (for example, x1 in an x1 slot).
Has more lanes electrically.

Has fewer lanes, but is closer to your needs. For example, place an x16 card in an x4 slot,
and an x4 card in a an x1 slot.

e An x1 connector supports an x1 card only. While an x1 card can be inserted into a larger slot,
this may limit potential future card placement.
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HP Z220 SFF Workstation slot identification and description

Maximum power used by all slots must not exceed total system power and is subject to configuration
limitations.

Figure 3-1 Identifying expansion card slots

| I4)

Table 3-1 PCl slots

Slot Type Mechanical compatibility Electrical compatibility
1 PCle2 x1 x1 x1
2 PCle2 x16 (4) x16 x4
3 PCle3 x16 x16 x16
4 PCl 32/33 PCI PCI

E”/{’NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle

lanes routed to an expansion slot. For example, x16 (8) means that the expansion slot is mechanically

a x16 length connector, with 8 PCle lanes supported.

HP Z220 SFF Workstation installation sequence recommendations

Table 3-2 Slot Installation sequence

::::r Card description Slot 1 Slot 2 Slot 3  Slot 4

1 PCle graphic card Only

2 Second PCle graphic card Only

3 PCle audio card Tst 2nd

4 PCle NIC card 1st 2nd

5 PCle 1394a card 1st 2nd

6 PCle Wireless card 1st 2nd

7 Second serial port kit 1st 2nd

8 Parallel port kit 1st 2nd

9 eSATA bulkhead kit 1st 2nd 3rd

NOTE: Slot sequenced from the rear /O aperture fo the board edge.
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HP Z220 CMT Workstation slot identification and description

Maximum power used by all slots must not exceed total system power and is subject to configuration

limitations.

Figure 3-2 Identifying expansion card slots
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Table 3-3 PCl slots

Slot Type Mechanical compatibility Electrical compatibility
1 PCle2 x8 (4) x8 x4
2 PCle3 x16 x16 x16
3 PCle2 x1 x1 x1
4 PCle2 x16 (4) x16 x4
5 PCle2 x1 x1 x1
6 PCl 32/33 PCI PCI
7 PCl 32/33 PCI PCI

2»NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle
lanes routed to an expansion slot. For example, x16 (8) means that the expansion slot is mechanically
a x16 length connector, with 8 PCle lanes supported.

Slot two is the primary graphics slot; slot four is the secondary graphics slot.

Slots one, two, and four use open-ended PCle connectors, so a PCle x16 card can be inserted.
Graphics cards greater than 75 watts require the use of an auxiliary power cable adapter.
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HP Z220 CMT Workstation installation sequence recommendations

Table 3-4 Slot installation sequence

Load

order Card description Slot 1 Slot 2 Slot 3 Slot 4 Slot 5 Slot 6 Slot 7
1 PCle graphic card Only
2 Second PCle graphic card Only
3 PCle NIC card Tst 3rd 2nd
4 PCle 1394 card 1st 3rd 2nd
5 PCle USB3.0 card Tst 2nd
6 PCle audio card 1st 2nd 3rd
7 eSATA bulkhead kit 3rd 2nd Tst
8 Parallel port kit Only
9 Second serial port kit 2nd 1st

NOTE: Slot sequenced from the rear /O aperture fo the board edge.
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HP Z420 Workstation slot identification and description

Maximum power used by all slots must not exceed total system power and is subject to configuration

limitations.

Figure 3-3 Identifying expansion card slots
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Table 3-5 PCl slots

Slot Type Mechanical compatibility Electrical compatibility
1 PCle2 x4 (1) x4 x1
2 PCle3 - x16 x16 x16
3 PCle2 - x8 (4) x8 x4
4 PCle3 x8 x8 x8
5 PCle3 x16 x16 x16
6 PCl 32/33 PCl PCI

2»NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle
lanes routed to an expansion slot. For example, x16 (8) means that the expansion slot is mechanically
a x16 length connector, with 8 PCle lanes supported.

Slot two is the primary graphics slot; slot five is the secondary graphics slot.

Slots one, three, and four use open-ended PCle connectors, so a PCle x16 card can be inserted.
Graphics cards greater than 75 watts require the use of an auxiliary power cable adapter.
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HP Z420 Workstation installation sequence recommendations

Table 3-6 Slot installation sequence

Load

order Card description Slot 1 Slot 2 Slot 3 Slot4  Slot5 Slot 6
1 First PCle graphic card Only
2 e Orly
3 Third PCle graphic card Only
4 Fourth PCle graphic card Only
5 SAS card 2nd 1st 3rd
6 PCle 1394b card 1st 2nd
7 PCle audio card Tst 2nd 3rd 4th
8 PCle NIC card (LAN) 1st 2nd 3rd 4th
9 e-SATA bulkhead kit 2nd 3rd 1st
10 Second serial port kit 2nd 3rd 1st

NOTE: Slot sequenced from the rear /O aperture fo the board edge.
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HP Z620 Workstation slot identification and description

Maximum power used by all slots must not exceed total system power and is subject to configuration

limitations.

Figure 3-4 Identifying expansion card slots

I%NOTE: Slot 1 is not available in dual processor configurations.

Table 3-7 PCl slots

Slot Type Mechanical compatibility Electrical compatibility
1 PCle2 x4 (1) x4 x1
2 PCle3 - x16 x16 x16
3 PCle2 - x8 (4) x8 x4
4 PCle3 x8 x8 x8
5 PCle3 x16 x16 x16
6 PCl 32/33 PCl PCI

2»NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle
lanes routed to an expansion slot. For example, x16 (8) means that the expansion slot is mechanically
a x16 length connector, with 8 PCle lanes supported.

I%NOTE: Slots two, four, and five are PCle GEN3 slots. Slot two is the primary graphics slot; slot five is
the secondary graphics slot.

Slots three and four use open-ended PCle connectors, so a PCle x16 card can be inserted. This allows
the workstation to support more PCle x16 expansion cards. A x16 card typically trains and runs at the
maximum lane width available by the expansion slot. The card runs at the reduced lane width, with a

corresponding performance decrease. Graphics cards greater than 75 watts require the use of an

auxiliary power cable adapter.
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HP Z620 Workstation installation sequence recommendations

Table 3-8 Slot installation sequence

::::r Card description Slot 1 Slot 2 Slot 3 Slot 4 Slot 5 Slot 6
1 (Sézz:;d System Board Only
2 First PCle graphic card Only
Second PCle graphic card
3 or High Performance GPU Only
Compute card
4 PCle 1394b card Only
5 Third PCle Graphics card Only
6 Fourth PCle Graphics card Only
7 Controller card 1st 2nd 3rd
8 PCle audio card 4th 1st 2nd 3rd
9 PCle Network (LAN) card 4th 1st 2nd 3rd
10 eSATA bulkhead kit 4th 1st 2nd 3rd
11 Serial port bulkhead 3rd 2nd 1st

NOTE: Slot sequenced from the rear /O aperture fo the board edge.
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HP Z820 Workstation slot identification and description

92

Maximum power used by all slots must not exceed total system power and is subject to configuration
limitations.

Figure 3-5 Identitying expansion card slots
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Table 3-9 Expansion card slot description and compatibility

Slot Type Mechanical compatibility Electrical compatibility
1 PCle3 x8 (4) — CPUO x8 x4
2 PCle3 x16 — CPUO x16 x16
3 PCle3 x16 (8) — CPU1 x16 x8
4 PCle3 x16 — CPU1 x16 x16
5 PCle2 x8 (4) — CPUO x8 x4
6 PCle3 x16 — CPUO x16 x16
7 PCl 32/33 — CPUO PCl PCl

2»NOTE: The PCle designators indicate the mechanical connector size and number of electrical PCle
lanes routed to an expansion slot. For example, x16(8) means that the expansion slot is mechanically a
x16 length connector, with 8 PCle lanes supported.

2»NOTE: Slots one and five use open-ended PCle connectors, so a PCle x16 card can inserted. This
allows the workstation to support more PCle x16 expansion cards. A x16 card typically trains and runs
at the maximum lane width available by the expansion slot. The card runs at the reduced lane width,
with a corresponding performance decrease.

I%NOTE: A eighth slot opening in the chassis has no corresponding expansion connector on the system
board. This slot opening is provided for devices that do not require system board card plug-in
capability.

@NOTE: It is normal for the expansion card retention clamp to have a slight (5-10 degree) angle when
closed. If the angle is greater than this, open the clamp and ensure that all cards are properly seated
and all the brackets are mated to the chassis, then re-close the clamp.
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HP Z820 Workstation installation sequence recommendations

Table 3-10 Slot installation sequence

Load . Slot Slot Slot *Slot * Slot Slot
order Card description Type 0 1 2 3 4 Slot 5 Slot 6 7

1st high performance GPU  PCle-

1
] Compute card x16 2nd Tst
2nd high performance
GPU Compute card PCle-
2 (requires 2nd CPU and x16 Only
1125w PSU)
. PCle-
3 1st PCle graphics card <16 Only
4 2nd PCle graphics card z(]:l)e- 2nd Tst!
3rd PCle graphics PCle-
> (requires 2nd CPU) «16 2nd Tst
4th PCle graphics PCle.
6 (requires 2nd CPU and ]66 Only
1125w PSU) *
. PCle-
7 Graphics test card <16 1st 2nd
8 Controller card )F:gle- 2nd 5th 4th 3rd Tst 2
9 Controller card with PCle- ond 5ih 4th 3rd 152
battery x8
10 PCle 1394 card PCle- Only
x1
n PCle audio card PCle- Tst 4th 5th 2nd 3rd
x1
12 PCle Network (LAN) PCle- 1st 4th 5th 2nd 3rd
x1
13 Mini SAS-4x bulkhead kit~ N/A 1st 2nd
14 eSATA bulkhead kit N/A 1st 2nd

* Slots 3 and 4 require second CPU.

1: If a second graphics card is used with a High Performance GPU Compute card, place the High Performance GPU
Compute card in Slot 6 and the second graphics in the alternate slof(s).

2: If a Controller card is being used with a High Performance GPU Compute card or second graphics card, place the
High Performance GPU Compute card/graphics card in Slot 6 and the RAID card in the alternate slof(s).

NOTE: Slot sequenced from the rear |/O aperture to the board edge.
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Hard disk drives and optical disc drives

Carefully handle hard disk drives

/\ CAUTION: Take proper precautions when handling hard disk drives to prevent loss of work and
damage to the computer or drive.

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are mounted in the computer.

e  Always shut down the operating system, turn off the power, and unplug the power cord. Never
remove a drive while the computer is on or in standby mode.

e Before handling a drive, make sure you discharge static electricity. While handling a drive, avoid
touching the connector.

e Handle a drive carefully. Do not drop it from any height.

e To prevent possible ESD damage when the drive is installed, connect the drive power cable before
connecting the data cable. This discharges accumulated static electricity through the drive power
cable to the computer chassis.

e Do not use excessive force when inserting a drive.

e Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

e If you must mail a drive, use a bubble-pack mailer or other protective packaging and label the

package “Fragile: Handle With Care.”

Removal and replacement tips

e To verify the type, size, and capacity of the storage devices installed in the computer, run the
Computer Setup (F10) Utility.

e Adding a new drive may require that you make new connections from the drive to the system
board. Note that:

o The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

o Connect a secondary hard drive to SATA.
o Connect SATA optical drives to the black SATA2 connector.

o Connect an optional eSATA adapter cable to the black ESATA connector on the system
board.

o Connect a media card reader USB cable to the USB connector on the system board labeled
MEDIA. If the media card reader has a 1394 port, connect the 1394 cable to the 1394 PCI
card.

94 Chapter 3 Component Replacement Information and Guidelines



Drive installation and cabling scenarios

This section presents cabling guidelines for the most common maximum storage configurations. If you
add or remove drives, HP recommends you follow these guidelines for highest drive performance and

efficient cable routing.

HP Z220 SFF Workstations — SATA cable connection guidelines

Configuration / SATA O SATA 1 SATA 2 SATA 4
PCA SATA
connector
HDD x1 ODD x1 1st HDD 1st ODD e-SATA
HDD x2 ODD x1 1st HDD 2nd HDD 1st ODD e-SATA

HP Z220 CMT Workstations — SATA cable connection guidelines

Table 3-11 SATA cable connection guidelines

Configuration / PCA SATAO0 SATA1 SATA2 SATA3 SATA4 SATAS
SATA connector
HDD x1 ODD x1 1st HDD 1st ODD e-SATA
HDD x1 ODD x2 1st HDD 1st ODD  2nd ODD e-SATA
HDD x2 ODD x1 1stHDD 2nd HDD  1st ODD e-SATA
HDD x2 ODD x2 1stHDD 2nd HDD 1stODD  2nd ODD eSATA
HDD x3 ODD x1 1stHDD 2nd HDD 3rd HDD  1st ODD e-SATA
HDD x3 ODD x2 1stHDD 2nd HDD 3rd HDD 1stODD 2nd ODD  e-SATA
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HP Z420 Workstations — Intel AHCI SATA controller guidelines

See HP Z420 Workstation system board components on page 19 to determine the location of system
board connectors.

@NOTE: Port O is the default port for the boot drive (the default port can be changed manually in the
BIOS).

System board Drive configuration scenarios

connector 1 2 3 4
SATA O SATAHDD 1 SATA HDD 1 SATA HDD 1 SATAHDD 1
SATA1 SATA HDD 2 SATA HDD 2 SATA HDD 2 SATA HDD 2
SATA 2 ODD 1 ODD 1 ODD 1 ODD 1
SATA 3 ODD 2 SATA HDD 3 SATA HDD 3 SATA HDD 3
SATA 4 eSATA (top) ODD 2 SATA HDD 4 eSATA (top)
SATA 5 eSATA (bottom) — ODD 2 eSATA (bottom)
SCUO — — — —
SCU1 — — — —

SCU 2 — — — —
SCU 3 — — — —

eSATA = external SATA (2 ports per cable assembly)
HDD = hard disk drive
ODD = optical disc drive

NOTE: Only the most common configurations are shown here.
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HP Z420 Workstations — LSI 9212-4i RAID controller guidelines

See HP 72420 Workstation system board components on page 19 to determine the location of system

board connectors.

E/?NOTE: Hard disk drives attached to RC J8 are designated by the 9212-4i BIOS to be boot devices. If
the hard disk drive connected to RC J8 is a member of a RAID array, the RAID array is the boot device.

RAID card (RC) or
system board (SB)

Drive installation scenarios

connector 1 2 3
RC J8 SAS HDD 1 SAS HDD 1-B SATA HDD 1-B
RCJ7 SAS HDD 2 SATA HDD 2-D SAS HDD 2-D
RCJ6 SAS HDD 3 SATA HDD 3-D SAS HDD 3-D
RCJ5 SAS HDD 4 SATA HDD 4-D SAS HDD 4-D

SB SATA O - - -

SB SATA 1 — — —

SB SATA 2 ODD 1 ODD 1 ODD 1

SB SATA 3 ODD 2 ODD 2 ODD 2

SB SATA 4 €SATA (iop) €SATA (iop) €SATA (iop)

SB SATA 5 eSATA (bottom) eSATA (bottom) eSATA (bottom)

SB SCU O — — —

SBSCU 1 — - —

SB SCU 2 — — —

SB SCU 3 - - -

eSATA = external SATA (2 ports per cable assembly)
HDD = hard disk drive

ODD = optical disc drive

NOTE: Only the most common configurations are shown here.
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HP Z620 Workstations — Intel AHCI SATA controller guidelines

See HP Z620 Workstation system board components on page 26 to determine the location of system
board connectors.

@NOTE: Port O is the default port for the boot drive (the default port can be changed manually in the
BIOS).

System board Drive installation scenarios

connector 1 2 3
SATA O SATA HDD 1 SATA HDD 1 SATA HDD 1
SATA1 SATA HDD 2 SATA HDD 2 SATA HDD 2
SATA 2 ODD 1 ODD 1 ODD 1
SATA 3 SATA HDD 3 SATA HDD 3 SATA HDD 3
SATA 4 SATA HDD 4 ODD 2 eSATA (top)
SATA 5 — — eSATA (bottom)
SCUO — — —
SCU1 — — —

SCU 2 — — —
SCU 3 — — —

eSATA = external SATA (2 ports per cable assembly)
HDD = hard disk drive
ODD = optical disc drive

NOTE: If there are fewer than three hard drives in the configuration, the cables from HDD bays 1 and 2
are pre-plugged to the system board SATA poris.

NOTE: Only the most common configurations are shown here.
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HP Z620 Workstations — LSI 9212-4i RAID controller guidelines

See HP 2620 Workstation system board components on page 26 to determine the location of system

board connectors.

E/?NOTE: Hard disk drives attached to RC J8 are designated by the 9212-4i BIOS to be boot devices. If

the hard disk drive connected to RC J8 is a member of a RAID array, the RAID array is the boot device.

RAID card connector
(RC) or system board

Drive installation scenarios

connector (SB) 1 2 3

RC )8 SAS HDD 1 SAS HDD 1-B SATA HDD 1-B
RCJ7 SAS HDD 2 SATA HDD 2-D SAS HDD 2-D
RC J6 SAS HDD 3 SATA HDD 3-D SAS HDD 3-D
RC J5 SAS HDD 4 SATA HDD 4-D SAS HDD 4-D

SB SATA O — — -

SB SATA'1 - - -

SB SATA 2 ODD 1 ODD 1 ODD 1

SB SATA 3 ODD 2 ODD 2 ODD 2

SB SATA 4 eSATA (top) eSATA (top) eSATA (top)

SB SATA 5 eSATA (bottom) eSATA (bottom) eSATA (bottom)

SBSCUO - - -

SB SCU 1 - - -

SB SCU 2 — — —

SB SCU 3 — — —

eSATA = external SATA (2 ports per cable assembly)

HDD = hard disk drive
ODD = optical disc drive

NOTE: If there are fewer than three hard drives in the configuration, the cables from HDD bays 1 and 2

are pre-plugged to the RAID card adapter ports.

NOTE: Only the most common configurations are shown here.
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HP Z820 Workstation cabling guidelines

See HP 7820 Workstation system board components on page 33 to determine the location of system
board connectors.

@NOTE: Port O is the default port for the boot drive (the default port can be changed manually in the

— BIOS).
Drive configuration scenarios
System board 5 6
connector 1 2 3 4 SATA RAID SATA RAID
5 only 5 only
SAS O HDD 1 HDD 1 eSAS 2 HDD 1 - -
SAS 1 HDD 2 HDD 2 eSAS 2 HDD 2 — -
SAS 2 HDD 3 HDD 3 eSAS 2 HDD 3 — —
SAS 3 HDD 4 HDD 4 eSAS 2 HDD 4 — —
SAS 4 HDD 5 eSAS 1 eSAS 1 HDD 5 - -
SAS 5 HDD 6 eSAS 1 eSAS 1 HDD 6 — —
SAS 6 — eSAS 1 eSAS 1 ODD 1 ODD 1 —
SAS 7 — eSAS 1 eSAS 1 ODD 2 ODD 2 —
SATA O ODD 1 ODD 1 ODD 1 eSATA eSATA ODD 1
SATA 1 ODD 2 ODD 2 ODD 2 eSATA eSATA ODD 2
SCU O — — HDD 1 — HDD 1 HDD 1
SCU 1 — — HDD?2 — HDD 2 HDD 2
SCU 2 — — HDD3 — HDD 3 HDD 3
SCU 3 — — HDD4 — HDD 4 HDD 4

eSAS 1/ eSAS 2 = external SAS (HP external SAS back panel or PCl bracket — 4 ports per cable assembly)
eSATA = external SATA (2 ports per cable assembly)

HDD = SATA or SAS hard disk drive

ODD = optical disc drive

NOTE: Only the most common configurations are shown here.
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Memory

Supported DIMM configurations

E’%NOTE: Mirroring and DIMM sparing are not supported.

Table 3-12 Supported DIMM configurations

Platform Configuration

e  Four DIMM slots
HP Z220 SFF o  Unbuffered ECC/nECC DIMMS only

e  Maximum capacity: 32 GB

o  Four DIMM slots
HP Z220 CMT o« Unbuffered ECC/nECC DIMMS only

e  Maximum capacity: 32 GB

e  Eight DIMM slots
HP Z420 e  Unbuffered ECC DIMMS only

e Maximum capacity: 64 GB

e  Eight DIMM slots (single CPU) or 12 DIMM slots (dual CPU)

e  Unbuffered or registered ECC DIMMS

HP Z620 e Maximum capacity: 64 GB (single CPU), 96 GB (dual CPU)
e In dual processor configurations, the workstation can be configured for NUMA or non-NUMA
modes

e 16 DIMM slots
e  Both Unbuffered ECC and Registered DIMMs

HP 2820 e  Maximum capacity: 512 GB
e In dual processor configurations, the workstation can be configured for NUMA or non-NUMA
modes

Component replacement guidelines 101



BIOS errors and warnings

The BIOS generates warnings/errors on invalid memory configurations:

If the BIOS can find a valid memory configuration by disabling plugged-in memory, it does so and
reports a warning during POST. the workstation can still be started. The warning will indicate the
location of the failed DIMM on the system board.

If there is no way for the BIOS to obtain a valid memory configuration by disabling plugged-in
memory, the BIOS halts with a diagnostics 2006 code for memory error (five beeps and blinks).

DIMM installation guidelines

Install only HP-approved DDR3 DIMMs

/\ CAUTION: HP ships only DIMMs that are electrically and thermally compatible with this

workstation. Because third-party DIMMs might not be electrically or thermally compatible, they are
not supported by HP.

Install only HP-approved DDR3 DIMMs. See http://www.hp.com/go/quickspecs to find DIMMs
that are compatible with the workstation.

Do not intermix DIMMs of different technologies. ECC Unbuffered DIMMs (UDIMMs), Registered
DIMMs (RDIMMs), and Load Reduced DIMMs (LRDIMMs) are supported on HP Z series
Workstations. Supported DIMM configurations on page 101 specifies which technologies are
supported on each platform.

/\ CAUTION: DIMMs and their sockets are keyed for proper installation. To prevent socket or DIMM
damage, align these guides properly when installing DIMMs.
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HP Z220 SFF Workstation DIMM installation order

Install DIMMs in this order.

2 NOTE: If you install DIMMs of different sizes, load them in order of size, starting with largest and
finishing with the smallest (largest in DIMM 1, smallest in last loaded DIMM).

Figure 3-6 DIMM installation order

HP Z220 CMT Workstation DIMM installation order

Install DIMMs in this order.

[ NOTE: If you install DIMMs of different sizes, load them in order of size, starting with largest and
finishing with the smallest (largest in DIMM 1, smallest in last loaded DIMM).

Figure 3-7 DIMM instfallation order
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HP Z420 Workstation DIMM installation order

Install DIMMs in this order.

2»NOTE: If you install DIMMs of different sizes, load them in order of size, starting with largest and
finishing with the smallest (largest in DIMM 1, smallest in last loaded DIMM).

Figure 3-8 DIMM installation order

CPU O
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HP Z620 Workstation DIMM installation order

Install DIMMs in this order.

2»NOTE: If you install DIMMs of different sizes, load them in order of size, starting with largest and
finishing with the smallest (largest in DIMM 1, smallest in last loaded DIMM).

Figure 3-9 Single processor DIMM installation order

CPU O
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Figure 3-10 Dual processor DIMM installation order
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HP Z820 Workstation DIMM installation order

Install DIMMs in this order.

2»NOTE: If you install DIMMs of different sizes, load them in order of size, starting with largest and
finishing with the smallest (largest in DIMM 1, smallest in last loaded DIMM).

Figure 3-11 Single-processor DIMM installation order
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Power supply

Power supply specifications

All power supplies have these specifications:

e  Wideranging, active Power Factor Correction (PFC)

e ENERGY STAR® qualified (configuration dependent)

e  FEMP Standby Power compliant @115V (<2W in S5 - Power Off)

e  Surge tolerant (withstands power surges up to 2000V)

E‘/?"NOTE: HP Z820 Workstation configurations in which the power load is over 900W and the power
source is between 90V and 115V require special power consumption and cooling considerations.
Refer to the Site Preparation Guide at http://www.hp.com/support/workstation_manuals.

Table 3-13 Power supply specifications

2220 SFF 7220 CMT 2420 7620 7820
Power supply 240W 90% | 400W 90% | 600W 90% | 800W 90% | 850W 88% | 1125W 90%
efficient efficient efficient efficient efficient efficient *
Operating 90-264 VAC | 90-269 VAC | 90-269 VAC | 90-269 VAC | 90-269 VAC | 90-269 VAC
voltage range
100 VAC
100-127 VAC
f;:e‘i voltage | 150 240 VAC | 100-240 VAC | 100-240 VAC | 100-240 VAC 115 VAC
9 200-240 VAC | 500-240
VAC
Rated line 50-60 Hz 50-60 Hz 50-60 Hz 50-60 Hz 50-60 Hz 50-60 Hz
frequency
Operating line
frequency 47-63 Hz 47-66 Hz 47-66 Hz 47-66 Hz 47-66 Hz 47-66 Hz
range
12A
11A @ @100VAC,
Rated input A 5.5A @ 8A @ 9.7A@ 100127V ]]125’: g";
current 100-240 VAC | 100-240 VAC | 100-240 VAC 55 @ VAC. 108 @
200-240V 200-240
VAC
Heat
dissipation,
typical ?]0;1'25“’;“/ lh/r ‘(5]3%28*’;”/ :’/' 1365 btu/hr | 1972 btu/hr | 2142 btu/hr | 2773 btu/hr
(configuration b < b V| (344 keal/hr) | (497 keal/hr) | (540 keal/hr) | (699 keal/hr)
and software
dependent)
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Table 3-13 Power supply specifications (continued)

Z220 SFF Z220 CMT Z420 Z620 Z820
Heat Max1: 3878
dissipation, btu/hr (977
maximum 646.6 btu/hr | 899.1 btu/hr 2354 biu/hr 3139 biu/hr Max: 3335 keal/hr)

(163.0 kcal/ (226.6 kcal/ 503.92 keal/h 701 keal/h btu/hr (840
(configuration hr) hr) (593.2 keal/hr) | cal/hr) keal/hr) Max2: 5002
and software btu/hr (1260
dependent) kcal/hr)
Power supply

ne fan, ne fan, ne fan, ne fan, Two fans,

fon One f One f One f One f f oy fans,
Al fans are 92mm x 25mm | 92mm x 25mm | 92mm x 25mm | 92mm x 25mm | 80mm x 25mm Q;nmmmx
variable speed
LBEJIIDh-m Self Test No Yes Yes Yes Yes Yes
Power
Consumption in
sleep mode (as <3W <4W <6W <15W <15W <35W
defined by
ENERGY STAR)
80 .PFUS. Gold Gold Gold Gold Silver Gold
certification

*The 1125W power supply can also supply 1275W of output power when the input voltage is greater
than 105V. If the input voltage is less than 105V, but greater than 90V for any reason, the maximum
power that can be drawn is 1125W. An uninterruptible power supply (UPS) is highly recommended if
1275W output power is desired.
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Power consumption and heat dissipation

Power consumption and heat dissipation specifications are available for multiple configurations. To
review available specifications, see http://www.hp.com/go/quickspecs.

To reach zero power consumption, unplug the workstation from the power outlet or use a power strip
with an on/off switch. For additional information about power-saving features, see the operating system
installation instructions.

This product is in compliance with U.S. Executive Order 13221.

Resetting the power supply

It an overload triggers the power supply overload protection, power is immediately disconnected.
To reset the power supply:
1. Disconnect the power cord from the workstation.

2. Determine what caused the overload and fix the problem. For troubleshooting information, see
Diagnostics and troubleshooting on page 115.

3. Reconnect the power cord and restart the workstation.

When you power off the workstation through the operating system, power consumption falls below
what is considered low power consumption but does not reach zero. This low power consumption
feature extends the life of the power supply.

System board

If you replace the system board:
e  Make a note of the cable connections before disconnecting them from the system board.

e Follow good cable management practices. See Cable management on page 82.

The following tables show system cabling for the workstations.
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System cabling

HP Z220 SFF Workstation system cabling

See HP 7220 SFF Workstation components on page 1 to determine the location of system board

connectors.
Cable To Cable designator on system
board
PSU cable PCA (Main power) P1 (White)
PSU cable PCA (PWR COMM) P2 (White)
SATA power cable PCA (CPU power) P3 (White)
SATA power cable HDD/ODD P160 (Black)
SATA power cable First HDD D4
SATA power cable First ODD D6
Speaker PCA P6 (White)
Cooler fan cable PCA P9 (Brown)
Front audio cable PCA P23 (Blue)
LED/Power button cable PCA P5 (Black)
Front USB 2.0 cable-1 PCA P24 (Yellow)
Front USB 2.0 cable-2 PCA P25 (Green)
Serial cable PCA P52
Chassis solenoid lock PCA P124
SATA cable First HDD P60 (Blue)
SATA cable Second HDD P61 (Blue)
SATA cable First ODD P62 (Black)
SATA power cable First HDD D4
SATA power cable Second HDD D5
SATA power cable First ODD D6
eSATA bracket cable First External SATA device P64 (black)

(optional)
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HP Z220 CMT Workstation system cabling

See HP 2220 CMT Workstation system board component on page 12 to determine the location of

system board connectors.

Cable designator on system

Cable To board
PSU cable PCA (Main Power) P1 (White)
PSU cable PCA (CPU Power) P3 (White)
PSU cable First hard drive (Bay 6) P8 (Black)
PSU cable Second hard drive (Bay 5) P9 (Black)
PSU cable Third hard drive (Bay 4) P10 (Black)
PSU cable First optical drive (Bay 1) P12 (Black)
PSU cable Second optical drive (Bay 2) P13 (Black)
PSU cable Other drive (Bay 3) P14 (White)
PSU cable First graphics card Pé (Black)
Speaker PCA P6 (White)
Cooler fan cable PCA P71 (White)
System fan cable PCA P8 (Brown)
Front fan cable (optional) PCA P9 (Brown)
Front audio cable PCA P28 (Black)
Front LED/Power button PCA P5 (Black)
cable
Front USB 2.0/3.0 cable PCA P24 (Black)
Serial cable (optional) PCA P52 (Block)
Parallel cable (optional) PCA P126 (Black)
Hood sense PCA P125 (White)
Chassis solenoid lock PCA P124 (Black)
SATA cable First HDD P60 (Blue)
SATA cable Second HDD P61 (Blue)
SATA cable Thrird HDD P62 (Black)
SATA cable First ODD P63 (Black)
SATA cable Second ODD P64 (Black)
eSATA bracket cable First external SATA device P65 (Black)

(optional)
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HP Z420 Workstation system cabling

See HP Z420 Workstation system board components on page 19 to determine the location of system
board connectors.

Cable designator on system

Cable To board
PSU cable PCA (Main PWR) P1
PSU cable PCA (PWR MEM) P2
PSU cable First hard drive (Bay 6) D1
PSU cable Second hard drive (Bay 5) D2
PSU cable Third hard drive (Bay 4) D3
PSU cable First optical drive (Bay 1) D4
PSU cable Second optical drive (Bay 2) D5
PSU cable Other drive (Bay 3) D6
PSU cable First graphics card Gl
PSU cable Second graphics card G2
Speaker PCA P6 (SPKR) white
Cooler fan cable PCA P8 (CPUO FAN) white
System fan cable PCA P95 (REAR FAN) white
Memory fan cable PCAXx P92 (MEM FAN) white
Front audio cable * PCA P28 (FRONT AUD) black
Front 1394 cable PCA 112 1394, White
LED/Power button cable PCA P5 (PB/LED) black
Front USB 3.0 cable PCA P29 (USB 3.0) blue
Front USB 2.0 cable PCA P27 (FRONT USB 2.0) yellow
Media card reader PCA P24 (USB2) blue
Front fan cable PCA P9 (FRNTFAN) white
Second serial port PCA P52 (COM) black
Chassis solenoid lock PCA P124 (SOL_LOCK) black
Chassis Intrusion Sender PCA P125 (I_SENSE) white

* If an audio card is installed, connect the front audio cable to the audio card connector.
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HP Z620 Workstation system cabling

See HP 2620 Workstation system board components on page 26 to determine the location of system

board connectors.

Cable To Cable/system board designator
PSU cable PCA P1(PWR) P1
PSU cable PCA P2(PWRMEM) P2
PSU cable First hard drive HDD BAY O
PSU cable Second hard drive HDD BAY 1
PSU cable Third hard drive HDD BAY 2
PSU cable First optical drive D1
PSU cable Second optical drive D2
PSU cable First graphic card Gl
PSU cable Second graphic card G2
Speaker PCA Pre-connected to FUI cable
CPU O HS fan cable PCA P8 (CPU O FAN) white
Rear fans cable PCA P11 (REAR FANS) white
MB memory fan cable PCA P91(MEM FAN) black blind-mate
Front fan cable PCA P9 (FRNTFAN) white
Front audio cable * PCA P28 (FRONT AUDIO) black
Front USB3.0 cable PCA P29 (FRNT USB3) blue
Front USB2.0 cable PCA P27 (FRNT USB2) yellow
Front Ul cable PCA P5(PB/LED) black
Front 1394 cable PCA 112 (1394) white
Media card reader PCA P24 (I-USB2.0) blue
SAS card LED cable PCA P127 black
eSATA external connection PCA P64 (SATA4) black, P65 (SATAS)
black
Hood lock cable PCA P124 (HOOD_LOCK) black
Hood sensor cable PCA P2 on FUI Cable, white
Serial option cable PCA P52 (COM) black
Second CPU PCA memory Riser PCA P9 (MEM_FAN) black blind-mate

fan cable

* If an audio card is installed, connect the front audio cable to the audio card connector.
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See HP 7820 Workstation system board components on page 33 to determine the location of system

HP Z820 Workstation system cabling

board connectors.

Cable To Cable/system board designator
PSU cable (C1) PCA (P1) P1
PSU cable (C3) PCA (P2) P2
PSU cable (C3) PCA (P3) P3
PSU cable (C3) PCA (P4) P4
PSU cable (C2) Graphics card Gl
PSU cable (C2) Graphics card G2
PSU cable (C2) Graphics card G3
PSU cable (C1) Hard drive cable H1

PSU cable (C1)

Optical drive / hard drive

D1 (SATA power)

PSU cable (C1) Optical drive / hard drive D2 (SATA power)
PSU cable (C1) Optical drive / hard drive D3 (SATA power)
PSU cable (C1) Optical drive D4 (IDE power)
PSU cable (C1) Optical drive D5 (IDE power)
Front fan cable (top) PCA P94 (FRONT FAN 1) white
Front fan cable (bottom) PCA P93 (FRONT FAN 2) white
Rear fan cable PCA P8 (REAR FAN) white
Front audio cable * PCA P28 (FRONT AUD) black
Front 1394 cable PCA J13 (FRONT 1394) white
Front Ul cable cable PCA P5 (FRONT PANEL) black
Front USB 2.0 cable PCA P27 (FRONT USB 2.0) yellow
Front USB 3.0 cable PCA P29 (FRONT USB 3.0) blue

* If an audio card is installed, connect the front audio cable to audio card connector.

Chapter 3 Component Replacement Information and Guidelines



4 Diagnostics and troubleshooting

This chapter describes the tools available for diagnosing and troubleshooting system issues, and
includes these topics:

Topics

Calling support on page 116

Locating ID labels on page 117

Locating warranty information on page 118

Diagnosis guidelines on page 118

Troubleshooting checklist on page 120

HP troubleshooting resources and tools on page 121

HP troubleshooting resources and tools on page 121

Self4roubleshooting with HP Vision Diagnostics on page 135

Selftroubleshooting with HP Advanced System Diagnostics UEFI
on page 144

Diagnostic codes and errors on page 149




Calling support

116

At times you might encounter an issue that requires support. When you call support:

Have the computer readily accessible.

Write down the computer serial numbers, product numbers, model names, and model numbers
and have them in front of you.

Note any applicable error messages.

Note any add-on options.

Note the operating system.

Note any third-party hardware or software.

Note the details of any blinking LEDs on the front of the computer (tower and desktop
configurations) or on the side of the computer (all-in-one configurations).

Note the applications you were using when you encountered the problem.

E/?’NOTE: When calling in for service or support, you might be asked for the product number (example:
PS988AV) of the computer. If the computer has a product number, it is generally located next to the 10-
or 12-digit serial number of the computer.

@NOTE: On most models, the serial number and product number labels can be found on the top or
side panel and at the rear of the computer (tower and desktop configurations) or on a pull-out card on
the side of the display (all-in-one configurations).

For a listing of all worldwide support phone numbers, go to http://www.hp.com/support, select your
region, and click Connect with HP in the upper-right corner.
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[ ]
Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each

computer.

e  All workstations have a serial number (unique for each workstation) and product number. Have
these numbers available when you contact support.

e The Certificate of Authentication (COA) is used only for systems preinstalled with Windows.

e A service label shows the build ID and Feature Byte strings, which are needed for system board
replacement.

In general (tower and desktop configuration), these labels can be found in the top, rear or bottom of
the chassis (your workstation might look different).

Figure 4-1 Tower and deskiop label locations

i
hu!" it

Locating ID labels 117



Locating warranty information

To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and expand a standard product warranty.

Diagnosis guidelines

If you encounter a problem with the computer, monitor, or software, the following sections provide a list
of general suggestions that help you isolate and focus on the problem before taking further action.

Diagnosis at startup

118

Verify that the computer and monitor are plugged into a working electrical outlet.
Remove all CDs, or USB drive keys from your system before turning it on.

Verify that the computer is turned on and the blue power light is blue (normal operation) and not
red (error state).

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

Verify that the monitor is turned on and the green monitor light is on. Note that not all monitors are
equipped with LED lights to indicate their functionality.

Turn up the brightness and contrast controls of the monitor if the monitor is dim.
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Diagnosis during operation

e Look for blinking LEDs on the side of the computer. The blinking lights are error codes that will
help you diagnose the problem. Refer to the Diagnostic LED and audible (beep) codes
on page 149 section of this document for information on interpreting diagnostic lights and
audible codes.

e  Check all cables for loose or incorrect connections.

e  Wake the computer by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the computer.

e  Reconfigure the computer after installing a non-plug and play expansion board or other option.

e  Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

e If you are working on a network, plug another computer with a different cable into the network
connection. There might be a problem with the network plug or cable.

e If you recently added new hardware, remove the hardware and verify if the computer functions
properly.

e If you recently installed new software, uninstall the software and verify if the computer functions
properly.

e If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.

e  Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

e  Press the Caps Lock key. If the Caps Lock LED toggles on or off, the keyboard is operating
correctly.
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Troubleshooting checklist

120

Before running diagnostic utilities, make sure that.

The computer is connected to a working electrical outlet and powered on, and the power light is
illuminated.

The monitor (for tower or desktop configurations) is connected to a working electrical outlet and
powered on, and the power light is illuminated.

The monitor brightness and contrast are properly adjusted.

The keyboard is operating correctly (press and hold any key and listen for a beep).

All cables are properly connected.

All necessary device drivers are installed

All external media (such as optical disks or USB drive keys) are removed before startup.

The latest version of BIOS, drivers, and software are installed.
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HP troubleshooting resources and tools

This section provides information on the HP Help and Support Center, Online support, and Helpful
Hints for troubleshooting.

HP Support Assistant

HP Support Assistant (Windows 7 systems only) helps you maintain workstation performance and
resolve problems. HPSA provides automated updates, onboard diagnostics, product information, and
guided assistance to help maintain optimum workstation performance. To access HPSA, click Start >
All Programs > HP Help and Support > HP Support Assistant.

E’%NOTE: HP Support Assistant is not available on Linux.

Online support

Online access and support resources include web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following websites are also available to you:

e  http://www.hp.com—Provides useful product information.

e  hitp://www.hp.com/support/workstation _manuals—Provides the latest online documentation.

e  http://www.hp.com/go/workstationsupport—Provides technical support information for
workstations.

e  hitp://www.hp.com/support—Provides a listing of the worldwide technical support phone
numbers. Access the telephone numbers by visiting the website, then select your region, and click
Contact HP in the upper-left corner.

e  http://www.hp.com/support/workstation swdrivers—Provides access to software and drivers for
workstations.
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Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to the workstation series
and model, and to the problem you are troubleshooting.

Instant Support and Active Chat

HP Instant Support is a set of web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.

Active Chat enables you to electronically submit a support ticket to HP over the web. When you submit
a support ticket, Active Chat collects information about the computer and pass it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case D, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, go to
http://instantsupport.hp.com/.

@NOTE: This feature is not available on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices

To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.
3. Under Resources for <your selected product>, sclect See more....
4

Under Self-Help resources: in the center of the window, choose the desired action and
appropriate information in the scroll list to view the index.

Product Change Notifications

122

Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30-60 day window of the effective date of the change in the manufacturing process. PCNs give
customers advanced notice of changes to their product, such as an updated BIOS version that they may

need to qualify prior to the change taking place. The latest PCNs are located at: http://www.hp.com
go/workstationsupport.
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Helpful hints

If you encounter a problem with the workstation, monitor, or software, the following general
suggestions might help you isolate and focus on the problem before taking further action.

At startup

e  Verify that the workstation and monitor are plugged into a working electrical outlet.
e  Remove all optical discs and USB drive keys from the drives before powering on the workstation.
e  Verify that the workstation is turned on and the power light is on.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

e  Verity that the monitor is turned on and the green monitor light is on.
e  Turn up the brightness and contrast controls of the monitor if the monitor is dim.

o If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation

e  Look for blinking LEDs on the workstation. The blinking lights are error codes that will help you
diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section of this
document for information on interpreting diagnostic lights and audible codes.

e Press and hold any key. If the system beeps, then your keyboard is operating correcily.
e  Check all cables for loose or incorrect connections.

e  Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again fo restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

e  Reconfigure the workstation after installing a non-plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

e  Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

e If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

e If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

e If you recently installed new software, uninstall the software and verify if the workstation functions
properly.
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e If the monitor connected to a tower, desktop or all-in-one computer is blank:

> Plug the monitor into a different video port on the computer if one is available. Alternatively,
replace the monitor with a monitor that you know is working properly.

o Verify that the computer and monitor are plugged into a working electrical outlet.
o Verify that the monitor is turned on and the green monitor light is on.
o Turn up the brightness and contrast controls of the monitor if the monitor is dim.

e If the internal display on an all-in-one computer is blank, open the computer and make sure the
graphics card is properly installed.

e Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

Customer self-repair

Under the Customer Self-Repair program, you can order a replacement part and install the part without
onsite HP technical assistance. Customer self-repair may be required for some components. See
http://www.hp.com/go/selfrepair for information on the program.

2»NOTE: Some components are not eligible for customer self-repair and must be returned to HP for
service. Call HP Support for further instructions before attempting to remove or repair these
components.
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Troubleshooting scenarios and solutions

This section presents troubleshooting scenarios and possible solutions for a Windows-based system.

Solving minor problems

Table 4-1 Minor problems

Problem

Cause

Possible Solution

Workstation appears frozen
and does not shut down when
the power button is pressed.

Software control of the power
switch is not functional.

1. Press and hold the power button for at least four
seconds until the computer shuts down.

2. Disconnect the electrical plug from the outlet.

3. Restart the computer.

Workstation seems to be
frozen.

Program in use has stopped
responding fo commands.

1. |If possible, use the Windows Task Manager to isolate
and terminate the offending process.

2. Attempt the normal Windows shutdown procedure.

3. Restart the computer using the power button.

Workstation date and time
display is incorrect.

Realtime clock (RTC) battery
might need replacement.

1. Reset the date and time in the Control Panel.

2. Replace the RTC battery.

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use the Computer Setup
(F10) Utility or the Microsoft Windows Device Manager to
disable the network controller.

Cursor does not move using
the arrow keys on the keypad.

The Num Lock key might be on.

Press Num Lock. The Num Lock key can be disabled or
enabled in the Computer Setup (F10) Utility.

Poor performance is
experienced.

Processor is hot.

1. Verify that airflow to the computer is not blocked.

2. Verify that chassis fans are connected and working
properly. Some fans operate only when needed.

3. Verify that the processor heatsink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on
the hard drive.
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Table 4-1 Minor problems (continued)

Problem Cause

Possible Solution

Workstation powered off
automatically and the Power
LED flashes red 2 times (once
every second), followed by a
2-second pause, and then two
simultaneous beeps sounded.

activated.

turning.

The processor heatsink is not
properly aftached to

the processor.

Processor thermal protection is

A fan might be blocked or not

5.

Verify that the computer air vents are not blocked.

Open the access panel and press the computer power
button.

Verify that the system fan is running.

Verify that the processor heatsink fan spins. If the fan is
not spinning, verify that the heatsink fan cable is
plugged into the system board connector and that the
heatsink is properly seated.

Replace the processor heatsink.

System does not power on,
and the LEDs on the front of
the computer are not flashing.

System cannot power on.

Press and hold the power button for less than four seconds.
If the hard drive LED turns green:

1.

OR

To find a faulty device, remove all devices one at a
time:

a. Disconnect AC power to the computer.
b. Remove a device.

c.  Reconnect AC power and power on the
computer.

Repeat this process until the faulty device is identified.
Remove the graphics card last. Replace the faulty
device.

If no faulty device is found, replace the system board.

Press and hold the power button for less than four
seconds. If the hard drive LED does not illuminate:

a. Verify that the computer is plugged into a
working AC outlet.

b. Verify that the power button harness is connected
to the inline front panel I/O device assembly
connector.

Verify that the power supply unit (PSU) cables are
connected to the system board.

Verify power supply unit PSU functionality:
a. Disconnect the AC power.

b. HP Z820 Workstation only—Remove PSU. All
other workstations, unplug cables connected to
the system board.

c.  Reconnect AC power

e Ifthe PSU fan spins and the BIST LED
illuminates, the PSU is good; replace the
system board.

e If the PSU fan does not spin or the LED does
not illuminate, replace the PSU.
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Solving hard drive problems

Table 4-2 Hard drive problems

Problem Cause Solution
Hard drive error occurs. Hard disk has bad sectors or  Locate and block the usage of bad sectors. If necessary,
has failed. reformat the hard disk.
If the drive is detected by the BIOS, run DPS Selfest.
Disk transaction problem. The directory structure is bad, 1.  Right-click Start, select Explore, and select a drive.
or there is a problem with a . .
file. 2. Select File>Properties>Tools.
3. Under Errorchecking, select Check Now.
Drive not found (identified). Improper cable connection On computers with discrete data and power cables,

ensure that the data and power cables are securely
connected to the hard drive. (See the Hard drive section of
this guide for connection details.)

Improperly seated hard drive

On systems with blind-mate drive connections, check for
connector damage on the drive and in the chassis.

Reseat the hard drive and its carrier in the chassis to
ensure a proper connection. (See the Hard drive section of
this guide for connection details.)

The system might not have
automatically recognized a
newly installed device.

1. Run the Computer Setup (F10) Utility.

2. |If the system does not recognize the new device,
verify that the device is listed in the Computer Setup
(F10) Utility.

If it is listed, the probable cause is a driver problem.
If it is not listed, the probable cause is a hardware
problem.

3. If this drive is newly installed, enter Setup and try
adding a POST delay under Advanced > Power-
On.

Drive responds slowly
immediately after power-up.

Run the Computer Setup (F10) utility and increase the
POST Delay in Advanced > Power-On Options.
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Table 4-2 Hard drive problems (continued)

Problem Cause Solution

Non-system disk or NTLDR missing ~ System is trying to start from Remove the optical disc or USB drive.
message. nonbootable media.

System is frying to start froma 1. Insert a bootable system optical disc or USB drive
damaged hard drive. and restart the computer.

2. |If the hard drive is still inaccessible and MBR Security
is enabled, try restoring the previously saved
MBR image by entering Setup and selecting
Security > Restore Master Boot Record.

System files missing or not 1. Insert a bootable system optical disc or USB drive
properly installed. and restart.

2. Verify that the hard drive is partitioned and
formatted.

3. Install the system files for the appropriate operating
system, if necessary.

Hard drive boot disabled in Run the Computer Setup (F10) Utility and enable the hard
Computer Setup. drive entry in the Storage > Boot Order list.

Workstation will not start. Hard drive is damaged. Replace the hard drive.
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Solving display problems

These suggestions apply to monitors connected to desktop and tower configurations, and to external

monitors connected to all-in-one configurations.

Table 4-3 Display problems

Problem Cause Solution
Blank screen (no video). The cable connections are not  Verify the cable connections from the monitor to the
correct. computer and to a working electrical outlet.

The monitor is off.

Turn the monitor on (LED is on). You might need to refer fo
the monitor manual for an explanation of LED signals.

Screen blanking utility installed
or energy saver features

enabled.

Press a key or the mouse button and, if set, enter your
password.

System ROM is bad; system is
running in FailSafe Boot Block
mode (indicated by 8 beeps).

Reflash the ROM using a SoftPaq.

Fixed-sync monitor does not
sync at the resolution
specified.

Verify that the monitor can accept the same horizontal
scan rate as the resolution specified.

Computer is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Workstation monitor seftings
are not compatible with the
monitor.

1.  When you see Press F8 in the bottom-right corner of
the screen, restart the computer and press F8 during
startup.

2. Using the keyboard arrow keys, select Enable VGA
Mode and then press Enter.

3. For Windows, double<lick the Display icon in the
Control Panel and then select the Settings tab.

4. Use the sliding control to reset the resolution.

The display works properly during  The display settings in the

the POST but goes blank when the  operating system are

operating system starts. incompatible with your
graphics card and monitor.

1. For Windows, restart your computer in VGA mode.

2.  Affer the operating system starts, change the display
settings fo match those supported by your graphics
card and monitor.

3. Refer to your operating system and graphics card
documentation for information about changing
display settings.
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Table 4-3 Display problems (continued)

Problem

Cause

Solution

Power LED flashes red 6 times
(once every second), followed by a
2-second pause, and then the
computer beeps 6 times.

Pre-video graphics error.

For systems with a graphics card:
1. Reseat the graphics card.

2. |If the card requires external power, make sure the
power cable is properly connected.

3. Replace the graphics card.
4. Replace the system board.

For systems with no graphics card installed, the CPU may
have no integrated graphics capability.

Monitor does not function when
used with Energy Saver features.

Monitor without Energy Saver
capabilities is being used with
Energy Saver features
enabled.

Disable the monitor Energy Saver feature.

Dim characters

The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is connected to the graphics
card and the monitor.

Blurry video or requested
resolution cannot be set.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit, or
download and install the latest drivers for your graphics
card from http://welcome.hp.com/country/us/en

support.html.

Monitor cannot display
requested resolution.

Change the requested resolution.

The picture is broken up, rolls,
jitters, or flashes.

The monitor connections might
be faulty, or the monitor might
be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a multiple CRT monitor system, ensure that the
monitors' electromagnetic fields are not interfering
with each other . Move them apart if necessary.

3. Move fluorescent lights or fans that are foo close fo
the CRT monitor.

Monitor must be degaussed.

Degauss the monitor.

Vibrating or rattling noise coming
from inside a CRT monitor when
powered on.

Monitor degaussing coil has
been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside
a CRT monitor.

Electronic relays have been
activated inside the monitor.

None. It is normal for some monitors to make a clicking
noise when turned on and off, when going in and out of
Standby mode, and when changing resolutions.

High pitched noise coming from
inside a flat-panel monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast seftings.
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Table 4-3 Display problems (continued)

Problem

Cause

Solution

Fuzzy focus; streaking, ghosting,
or shadowing effects; horizontal
scrolling lines; faint vertical bars;
or unable to center the picture on
the screen (flat-panel monitors
using an analog VGA input
connection only.)

Flat-panel monitor’s internal
digital conversion circuits
might be unable fo correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor's Auto-Adjustment option in the
monitor’s onscreen display menu.

2. Manually synchronize the Clock and Clock Phase
onscreen display functions.

3. Download SoftPaq SP22333 to assist with the

synchronization).

Some typed symbols do not
appear correctly.

The font you are using does
not support that symbol.

Use the Character Map to locate and select the
appropriate symbol.

Select Start>All Programs> Accessories>System
Tools>Character Map. You can copy the symbol from
the Character Map into a document.

Solving audio problems

Table 4-4 Audio problems

Problem

Cause

Solution

Sound does not come out of the
speaker or headphones.

Software volume control is
turned down.

Double-click the Speaker icon on the taskbar and use the
volume slider to adjust the volume.

The external speakers are not
turned on.

Turn on the external speakers.

External speakers plugged into

the wrong audio jack.

See your sound card documentation for proper speaker
connection.

Digital CD audio is
not enabled.

Enable digital CD audio:
1. From the Control Panel, select System.

2. On the Hardware tab, select the Device Manager
button.

3. Rightclick the €CD/DVD device and select
Properties.

4. On the Properties tab, select Enable digital CD
audio for this CD-ROM device.

Headphones or devices
connected to the line-out
connector have muted the
internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external
speakers.

Volume is muted.

1. From the Control Panel, select Sound, Speech and
Audio Devices, and then select Sounds and
Audio Devices.

2. Deselect the Mute checkbox.

Computer is in Standby mode.

Press the power button to resume from Standby mode.
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Table 4-4 Audio problems (continued)

Problem Cause Solution

Noise or no sound comes out of 1.

the speakers or headphones.

If you are using digital speakers that have a stereo
jack and you want the system to autoswitch to digital,
use a stereoo-mono adapter to engage the auto
sense feature, or use multimedia device properties

to switch the audio signal from analog to digital.

2. If the headphones have a mono jack, use the
multimedia device properties fo switch the system fo
analog out.

NOTE: If you set digital as the Output Mode, the
internal speaker and external analog speakers no
longer output audio until you switch back to an auto
sense or analog mode.
If you set analog as the Output Mode, external digital
speakers do not function until you change the output
mode back to an auto-sense or digital mode.
Sound occurs intermittently. Processor resources are being  Shut down all open processor-intensive applications.
used by other open
applications.
Workstation appears to be locked  The hard disk might be full. 1. Before recording, be sure there is enough free space
up while recording audio. on the hard disk.
2. Try recording the audio file in a compressed format.
L] o
Solving printer problems
Table 4-5 Printer problems
Problem Cause Solution
Printer does not print. Printer is not turned on and Turn the printer on and be sure it is online.

online.

The correct printer driver for 1. Install the correct printer driver for the application.
the application is not installed.

2. Try printing using the MS-DOS command:

DIR C:\> [printer port]
Replace printer port with the address of the printer
used. If the printer works, reload the printer driver.
If you are on a network, you Make the proper network connection to the printer.
might not have made a
connection to the printer.
Printer might have failed. Run printer self-test.

Printer does not turn on. The cables might not be
connected properly.
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Solving power supply problems

This section presents power supply troubleshooting scenarios.

Testing power supply

Before replacing the power supply unit (PSU), use the Built-In Self-Test (BIST) feature to learn if the power
supply still works.

E%?NOTE: Not all PSUs have the BIST functionality. Refer to the Rear panel components section of this

document to determine BIST availability for your workstation.

To test the power supply:

1. Unplug the AC power.

E/?’NOTE: For the HP Z820 Workstation, you must remove the power supply from the chassis.

2. Unplug all power cables to the system boards.
3. Plug in AC power and verify the following:

e If the green BIST LED on the rear of the workstation is illuminated and the fan is spinning, the
PSU is functional.

e If the green BIST LED is not illuminated or the fan is not spinning, replace the PSU.
See the Rear panel components section of this document to locate the BIST LED on your workstation.

Table 4-6 Power supply problems

Problem Cause Solution

PSU shuts down intermittently. Power supply fault. Replace the PSU.

Workstation powers off and the Processor thermal protectionis 1.  Ensure that the workstation air vents are not blocked.
Power LED flashes red 2 times activated.

2. Open the access panel and press the workstation
A fan might be blocked or not power button.
turning.

(once every second), followed by a
2-second pause.

3. Verify that the system fan is running.

OR
4. Verify that the processor heatsink fan spins.

The processor heatsink fan
assembly is not properly
attached to the processor.

If the heatsink fan is not spinning, verify that the fan
cable is plugged into the system board connector.
Verify that the fan is properly seated.

5. Replace the processor heatsink.

Power LED flashes red (once every ~ Power failure (power supply is 1. Determine whether a device is causing the problem
2 seconds). overloaded). by performing the following:

a. Disconnect AC power.
b. Remove all aftached devices.

¢. Power on the workstation.
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Table 4-6 Power supply problems (continued)

Problem Cause Solution

If the system enters the POST, perform the following:
a. Power off the workstation.

b. Replace one device at a time and repeat this
procedure until a failure occurs.

c. Replace the device causing the failure

d. Continue adding devices one at a time to verify
that all devices are functioning.

2. Verify power supply functionality.
a. Disconnect AC power.
b. Remove the Z820 PSU from the chassis.

c.  Unplug all system board power cables for the
7220 CMT, Z420, and Z620.

d. Plug in AC power.

e If the PSU fan spins and the LED
illuminates (see Testing power supply

on page 133), the power supply is good.
Replace the system board.

e Ifthe PSU fan does not spin or the LED
does not illuminate (see Testing power
supply on page 133), replace the power

supply.
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Self-troubleshooting with HP Vision Diagnostics

Hewlett-Packard Vision Diagnostics is a diagnostic tool that can be used by the end user or technical
support personnel to view information about the hardware configuration of the computer and perform
hardware troubleshooting on HP desktop and workstation systems. This diagnostic tool is used to
troubleshoot hardware failures. Accessible by either CD or USB key, these diagnostics run outside the
operating system and make it easy to isolate potential issues that may be related to the operating
system and not to the hardware.

HP Vision Diagnostics benefits:

e  Captures complete system configuration information that can be shared as an HTML file,
including:

o

o

o

o

o

System serial number, product number and BIOS revision
Memory size and configuration

Processor information

Storage device information and configuration

Graphics, audio, and communications information and configuration

e  Comprehensive list of diagnostic fests:

[

o

o

o

o

Highly configurable testing options: quick, complete, custom, interactive, non-interactive
Identifies specific failed memory DIMM
Tests video card memory

Launches DST SMART tests for both SATA and SAS drives

Many other tests and diagnostics

e Diagnostic Failure Code Output — A unique warranty code is generated for each failure and can
be used to validate diagnostic use for a specific system.

e Easy to use — Inferface is similar o previous field diagnostics, HP Insight Diagnostics.

e True End2End diagnostics — Same diagnostics modules used in factory.

e Easy to obtain:

o
o

o

Overview

Download from HP website.
Install on bootable USB key, CD or DVD.

Included with restore media.

HP Vision Diagnostics allows you to view information about the hardware configuration of the computer
and perform hardware diagnostic tests on the subsystems of the computer. The utility simplifies the
process of effectively identifying, diagnosing, and isolating hardware issues.

When started, HP Vision Diagnostics displays the Survey tab, which shows the current configuration
of the computer. Other tabs provide additional information, including diagnostic test options and fest
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results. The information in each tab can be saved as an HTML file and stored on an optical disc or USB
flash drive.

Use HP Vision Diagnostics to determine if all the devices installed on the computer are recognized by
the system and functioning properly. Running tests is optional but recommended after installing or
connecting a new device.

Before placing a call to the Customer Support Center HP recommends you run the fests, then save and
print the test results so that you have the reports available.

@NOTE: Third-party devices may not be detected by HP Vision Diagnostics.

Downloading and accessing HP Vision Diagnostics

Follow these steps to download the HP Vision Diagnostics utility from the HP website to a DVD or USB,
and then use it to perform diagnostics on the computer:

N oo s w N

9.
10.
11.

Go to hitp://www.hp.com.

Click the Support and Drivers link.

Click the Drivers and Software link.

Enter your product number in the text box, and then press Search.
Select your operating system.

Under the operating system section, select Diagnostic.

Locate HP Vision Diagnostics. Click Download next to the most recent version appropriate
for your target media (USB flash or ISO file for CD).

Copy the file to an optical disc or follow the instructions to install the diagnostics on a USB flash
drive.

While the computer is on, insert the disc or flash drive.
Shut down the operating system and turn off the computer.

Turn on the computer. The system will boot into HP Vision Diagnostics.

E%?NOTE: It the system does not boot to the disc in the optical drive or to the USB flash drive, you

12.

13.
14.

might need to change the boot order. Use the Computer Setup (F10) utility to change the boot
order, or press F9 to select the appropriate boot device.

At the boot menu, select either the HP Vision Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

If running HP Vision Diagnostics, select the appropriate language and click Continue.

In the End User License Agreement page, select Agree if you agree with the terms. The HP Vision
Diagnostics utility launches with the Survey tab displayed.

Accessing HP Vision Diagnostics on the computer

The following procedures describe how to access the HP Vision Diagnostics utilities that are included in
the computer software.
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Creating and using a bootable USB key

This section describes how to use a USB key to access the HP Vision Diagnostics.

2»NOTE: Using a USB key is the most convenient method to access the HP Vision Diagnostics. It is
faster than using a CD, and it accommodates both Memory and Vision diagnostics.

The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-alone
application, outside of HP Vision Diagnostics. If the computer is booted from a CD, a separate boot CD
will be required to use the memory diagnostic.

1.

4.

In the C:\VisionDiagnostics\ directory, double-click on VisionDiagUSB.exe. A setup menu
appears.

Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a USB key.

Turn off the computer and restart it with the USB key installed. The computer will boot to the USB
key and initiate the HP Vision Diagnostics utility.

Follow the HP Vision Diagnostic prompts to troubleshoot the computer.

Creating and using a bootable DVD

This section describes how to use a DVD to access the HP Vision Diagnostics.

1.

5.

In the C:\VisionDiagnostics\ directory, double-click on the VisionDiaglISO.exe file. A setup menu
appears.

Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a DVD.
Enable the computer to boot from DVD.

Turn off the computer and restart it with the DVD installed in the optical drive. The computer will
boot to the DVD and initiate the HP Vision Diagnostics utility.

Follow the HP Vision Diagnostic prompts to troubleshoot the computer.

Using the HP Memory Test utility

This section describes how to access the HP Memory Test utility.

r__":"/%"NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-alone
application, outside of HP Vision Diagnostics.

If the computer is booted from a CD, a separate boot CD will be required to use the memory
diagnostic. Hence, HP recommends that a USB key be used to boot the diagnostic utilities. It is faster
than using a CD, and it accommodates both Memory and Vision diagnostics.

1.

In the C:\VisionDiagnostics\ directory, double-click on the MemoryDiagISO.exe file. A setup
menu appears.

Follow the setup prompts to create a bootable ISO image of the memory diagnostic utility on a
DVD.

Turn off the computer and restart it with the DVD installed in the optical drive. The computer will
boot to the DVD and initiate the memory diagnostic utility.

Follow the diagnostic prompts to troubleshoot computer memory.
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User interface
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The HP Vision Diagnostics application provides six major functions, accessible through tabs:

Survey — Current system hardware information

Test — List of all diagnostics available for the system; tests are started here
Status — Progress and status of currently running diagnostics

History — Past diagnostics runs and status

Errors — Past diagnostics failures

Help — User help about HP Vision Diagnostics

Common operations include:

Exit Diagnostics button — Closes HP Vision Diagnostic application and reboots the system; any
running fest is aborted.

Reload button — If available, rescans your system hardware and reloads the diagnostics without
the need to restart the system.

Save button — If available, saves your system survey, test history or error data as an HTML file to
removable media.
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Survey tab

The Survey tab shows your system hardware information, organized into eleven Categories (for
example Processors) and device instances (for example Processor 1).

You can control the amount of information displayed by selecting a combination of View Level and

Category.

The View Levels include:

e Overview (default) — High-level summary of the system hardware

e Summary — limited configuration data for each specific category

e Advanced — More technical and low-level data for the computer-savvy user
The Categories Levels include:

e All — All categories

e Architecture — System architecture information such as high-level PCI devices, low-level
SMBIOS, CMOS, and PCl configuration space data

e Audio — All embedded and add-on audio devices

e Asset Control — Asset control related information such as product name, serial number, asset
tag, and universal unique ID information

e Communication — Communication devices such as serial, parallel, USB, network, IEEE-13%94q,
modem, and Bluetooth ports and devices

e Graphics — All embedded and add-on video cards

e Input Devices — User input devices such as all connected mice and keyboards
e Memory — System memory information

e Miscellaneous — Any device or data that doesn't belong to any other category
e Processors — System processors

e Storage — Mass storage devices such as floppy drives, optical drives, SATA, SAS hard disk
drives and controllers, as well as any RAID arrays

e System — Information about system board devices such as fans and cables
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Test tab
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The Test tab lists all available diagnostics. The lists have been tailored according to your system
configuration. Individual test may be selected or desselected.

Tests have three modes:
e  Quick — Test runs quickly while covering all hardware. Test parameters cannot be modified.

e Complete — Includes all available tests and may take a long time to complete. Test parameters
cannot be modified.

e Custom — Includes all available tests and may take a long time to complete. Test parameters
may be modified to fit specific needs. For advanced users only!

By default, the three test modes do not display prompts and require no interaction. Any errors are
displayed when testing is complete.

However, for each test type, you may also optionally add interactive fests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control
over the testing process. The diagnostic software will prompt you for input during tests.

@NOTE: Memory can not be tested from within the HP Vision Diagnostics application. To test the

memory in your computer, exit HP Vision Diagnostic, boot to either the CD or USB flash drive and
select HP Memory Test from the boot menu.

The Duration of Test options control the duration of the test sequence:
e Number of loops — Test runs specified number of times (default is 1).

e Total test time (hours:minutes) — Test runs for a specified amount of time; some tests might
not run if the specified time is not long enough to run all tests.

e Stop at first error — Test stops as soon as one error is encountered.
Test Controls provide additional functions:

o Select All, Unselect All — Select/unselect all tests in test selection tree
e Expand, Collapse — Expand/collapse fest selection tree

e Start Test — Starts executing selected tests and switches to the Status tab to display test
execution and status

/A WARNING! Once started, do not reboot or power off your computer until all the tests have been

completed.

To begin testing:

1. Select the Test tab.

2. Select the type of tests you want to run: Quick, Complete, or Custom.
3. Include optional interactive tests by selecting Include interactive tests.
4

Choose how you want the test to be executed, either Number of Loops or Total Test Time.
When choosing to run the test over a specified number of loops, enter the number of loops to
perform. If you want the diagnostic test for a specified time period, enter the amount of time in
minutes.
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6.

Status tab

Click the Start Test button. The Status tab, which allows you to monitor the progress of the

tests, automatically displays during the testing process. When the tests are complete, the Status tab
shows whether the devices passed or failed.

If errors are found, go to the Errors tab to view detailed information and recommended actions.

The color-coded Status tab displays the overall progress and status of the test scenario and of each test.

The states and colors are:

Waiting (black) — No test is running.
Running (blue) — At least one fest is currently running.

Passed (green) — All tests have run successfully, meaning that no hardware error or defect was
detected.

Failed (red) — The tests have detected at least one error with your system.

Canceled (orange) — The test scenario has been explicitly canceled, in which case no pass or
fail conclusion can be drawn.

The available data is:

Current Loop — Current execution loop out of total number of loops specified in the Test panel
Test Time — Total time elapsed since the beginning of the test execution

Test Complete — Number of tests successfully completed out of the total number of test to
execute

Cancel button — Immediately terminates all currently running tests

History tab

The History tab shows the history of the past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the number
of times failed, the date each test was executed, and the time it took to complete each test. The Clear
History button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to either floppy or USB flash drive by
clicking the Save button.
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Errors tab

The Errors tab displays detailed information about any errors found, as well as any recommended
actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following information:

e Device — Device tested

e Test — Type of test run

e Times Failed — Number of times the device has failed a test

o Defect Code — Numerical code for the failure (error codes are defined in the Help tab)
e  Description — Error the diagnostic test found

e Reason — likely cause of the error

e Recommended Repair — Recommended action that should be performed to resolve the failed
hardware

e  Warranty ID — A unique error code associated with the specific error on your computer; be
prepared to provide it when contacting the HP Support Center for assistance with a hardware
failure.

e Clear Errors — Clears the contents of the Error Log

Click the Save button to save the Error Log as an HTML file to removable media.

Help tab

The Help tab contains a Vision Help section and a Test Components section. This tab includes search
and index features. You may also review the HP End User License Agreement (EULA), as well as the HP
Vision Diagnostic application version information on this tab.

The Help sections are:
e Vision Help — Help on the major functions of HP Vision Diagnostics

e Test components — A description of each test, as well as the parameters that may be adjusted
when running in Custom test mode

o Defect codes — Descriptions of the numerical error codes that appear in the Errors tab

e Memory test tab — Information on the HP Memory Test application that can be launched from
the boot menu

e HP Support — How to obtain support from HP
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Saving and printing information in HP Vision Diagnostics

You can save the information displayed in the HP Vision Diagnostics Survey, History and Errors tabs to
removable media. You cannot save to the hard drive. The system automatically creates an HTML file
that has the same appearance as the information displayed on the screen.

1. Insert removable media.

2. Click Save in the bottom on any of the Survey, History or Errors tabs. The three log files are
saved regardless of where the Save button is clicked.

3. Select the removable media drive and click Save.

@NOTE: Do not remove the media until a message indicates the files have been written.

4. Print the desired information HTML file.

2»NOTE: To exit HP Vision Diagnostics, click Exit Diagnostics at the bottom of the screen. Be
sure to remove the removable media.
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Self-troubleshooting with HP Advanced System
Diagnostics UEFI

HP Advanced System Diagnostics is a Unified Extensible Firmware Interface (UEFI) based diagnostic
tool that can be used by the end user or technical support personnel to view information about the
system configuration and to perform hardware troubleshooting. The diagnostic tool runs outside of the
operating system to isolate hardware failures from issues that might be caused by the operating system
or other software components.

HP Advanced System Diagnostics:
e Easy to obtain:
> Installed on original image of every system hard drive (HDD)
o Core set of fests installed in the BIOS of every system
o Download to a USB key drive
e  Captures complete system configuration information, including:
o System serial number, product ID number, asset tag, and model
° Memory size and configuration
o Processor information (including, type and speed)
o Storage device information
o HDD: Launches Drive Self Test (DST) SMART tests for SATA drives
o Keyboard controller revision
o Bundles of tests to perform a quick test or extensive test of the entire system
> BIOS date and revision
e  Diagnostic fests:
o System tests (Start-up, Run-In and System Tune-Up)
> Individual component tests (Hard Disk Test and Memory Tests)

e Diagnostic Failure Code Output — A unique, 24—-digit Failure ID code is generated for each
failure:

> Randomly generated, unique each occurrence
o Identifies the specific components that did not pass validation
o Includes warranty information with information about the customer’s service entitlement

0 Provides information about the model, serial number, test time stamp, and failure
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0 Includes recommended actions with URL information on whom to contact

o Generation of the failure code indicates a definite hardware failure — no additional
troubleshooting is required

e Error Log — The tool automatically saves an error log on the device from which the test was run
(either the hard drive or USB drive). This log is available for future access from the tool and
includes the test that was run, date of the test, and Pass/Fail information including the Failure ID if
one was generated.

Downloading HP Advanced System Diagnostics

@NOTE: The most likely cause of the diagnostics file being unavailable on the hard drive is a hard
drive fault, or a missing or corrupted HP_TOOLS partition. For example, some corporate customers
reimage the workstation with their own custom image, which can remove the HP_TOOLs partition. In
this case, a SoftPaq is available from the HP website.

The HP UEFI Support Environment must be installed on and run from a FAT or FAT32 partition with a
volume name of HP_TOOLS. The installer gives you the option to install to the HDD or a USB drive. If
you install to the hard drive and the HP_TOOLS partition is not present, the installer prompts you to
create the HP_TOOLS partition. If you install to a USB drive, the installer renames the partition on the
USB drive to HP_TOOLS. If you use a custom image, you can create the HP_TOOLS partition manually
with FAT32 and make the volume name HP_TOOILS.

Follow these steps to download the HP Advanced System Diagnostics utility from the HP website to a
USB key:

1. Navigate to www.hp.com and select Support & Drivers.

Select Drivers & Software.

Enter the product name: Z220 to search for the Z220 product media.

Select the specific model of HP Z220 Workstation.

Choose the software/driver language. English (International) is the default.
Select the appropriate operating system.

On the Quick jump to downloads by category list, click Diagnostic.

Next to HP UEFI Support Environment, click Download and save the file.

0P N> RN

Double-click the downloaded file and follow the on-screen instructions to expand the contents of
the SoftPaq onto a USB key drive.

/\ CAUTION: The HP_TOOLS partition is not protected and can therefore be deleted. For these
reasons, HP recommends that you do not place additional data on the HP_TOOLS partition. Because
the partition is not backed up, corruption or failure of the partition will result in loss of all data on the
partition, plus loss of UEFI functionality. You can find more information on www.hp.com/go/
techcenter/startup.
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Accessing HP Advanced System Diagnostics

The process to access the diagnostics tool is the same regardless of the location from which it is run.
The user presses ESC, while the system boots. This brings up the BIOS menu, which include an option
to run diagnostics (F2). Once selected, the BIOS searches for a diagnostic signature. The diagnostic
tool runs from the first location where the file is found.

The system searches for the file in the follow sequence: USB device, hard drive (HDD), and BIOS.

If the system does not find the diagnostics on either a USB device or the hard drive, the system presents
a core set diagnostics (memory and HDD) that are located in the BIOS. The BIOS version is only
accessible if the USB or hard drive versions are not available.

User interface

146

The first screen to appear is the Main Menu, which includes:

e The current version of the diagnostics

e  The URL at which you can find more documentation about the diagnostics
It also includes the following options:

e  System Information— Includes complete system, memory, and HDD

e System Tests— Bundles of component tests to run in a sequence: Includes options for Quick and
Extensive tests

e  Component Tests— HDD, memory

e  Error lLog— Results of current and previous diagnostic tests

e language— 34 languages are supported

e  Exit button— Closes Diagnostic application and reboots the system

e  Esc key—Stops a diagnostics test while it is running
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Running HP Advanced System Diagnostics

The System information screen provides extensive system information, which is retrieved from the
SMBIOS tables if they are available. Otherwise it is retrieved directly from the BIOS hardware.

System information

To display the system information, click System Information on the Main Menu.

System information includes:

Memory information

Number of DIMMs installed

o

o

o

o

o

Device locator
Manutfacturer
Serial number
Part number
Memory size
Memory speed
Memory type

Hard driveinformation

o

o

o

Type

Model

Firmware version
Serial number
Capacity

LBA48 support

Self-Monitoring, Analysis, and Reporting Technology (SMART) (Enabled/Disabled)

Sector type
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Hardware diagnostic tests

148

HP Advanced System Diagnostics provides five sets of hardware diagnostic tests to validate the
functionality of hardware components (including the CPU, memory, graphics, and system board) prior
to booting the operating system.

If the operating system cannot load because of a hardware failure, the diagnostics can be used to
determine which hardware component has failed.

In the case of system failure, the diagnostics generate a unique 24—digit Failure ID code to identify the
specific components that did not pass validation.

Table 4-7 Hardware diagnostics tests

Test Function
Start-Up Analyzes the main components to make sure they are functioning properly to start the computer, the processor
Test (CPU), the memory modules, and the hard drive. It checks the SMART attributes of the hard drive and

performs the builtin Self-Test.

Run-In Test  Repeats the Start-up Test and checks for intermittent problems that the start-up test does not detect. Use this test
if the computer is having intermittent problems while running, that do not appear to be related to system
startup.

System Similar to the Start-Up Test, the System Tune-Up performs the Start-Up Test plus tests the video memory.
Tune-Up

Hard Disk The Hard Disk Test allows the selection of the Quick Extensive Test or Extensive Test of user selected drives in
Test the system. The user can select a single drive, or they can select all of the drives in the system to run
concurrently. The tests consists of the following subtests:

o  Quick Test
o Hard Disk SMART Check
o Hard Disk Short DST
e  Extensive Test
o Hard Disk SMART Check
o Hard Disk Short DST
o Hard Disk Optimized DST Check

o Hard Disk Long DST

Memory Analyzes the physical condition of the memory modules and reports any faulty modules. If this test reports an
Test error, the faulty memory module(s) should be replaced immediately.

The Memory Test allows selection of the Quick Memory Test or Extensive Memory Test.

The Quick Test is the same version run in the Start-Up Test, and takes around five minutes for 4GB of memory
to complete.

The Extensive Test runs a longer version of the Memory Test, which adds additional pattern and transfer types
to make it a more comprehensive test of the memory. This test normally runs approximately eight minutes/GB.
Test times varies depending on system architecture, processor speed, and amount of memory.
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Diagnostic codes and errors

This section presents information about diagnostic LED codes, LED color definitions, and POST error
messages fo help you troubleshoot problems.

Diagnostic LED and audible (beep) codes

This section describes the front panel LED error and operation codes as well as the audible codes that
might occur before or during the POST.

Table 4-8 Diagnostic lights and audible codes

Activity

Possible cause

Recommended action

Blue Power LED" on. No
beeps.

Computer on.

Blue Power LED" blinks
every two seconds.” No
beeps.

Computer in Sleep mode
(S3-Suspend to RAM).
Select models only.

Blue Power LED" is off.”
No beeps.

Computer in Hibernate
mode (S4-Suspend to
disk) or system is off
(S5).

Blue Power LED" blinks
three times*, once per
second.” No beeps.

Computer in Sleep mode
(S3-Suspend to RAM).
Select models only.

Blue Power LED" blinks
four times*, once per
second.” No beeps.

Computer in Hibernate
mode (S4-Suspend to
disk).

*User-selectable. See The Computer Setup (F10)

Utility menu on page 44 for details.

N/A

For the following LED activity and beeps, the beeps are heard through the chassis speaker. Blinks and beeps repeat for five
cycles, after which, only the blinks continue to repeat.

Red Power LED blinks two
times, once every second,
followed by a two-second
pause. Two beeps.

CPU thermal protection ~ CAUTION: Internal components might be powered even when
activated by either of the  the computer is off. To prevent damage, disconnect the computer
following methods: power cord before you remove a component.

o A fan might be 1. Ensure that the computer air vents are not blocked and the
blocked or not cooling fan is running.
turning.

2. Open the access panel, press power button, and verify that
the CPU fan is spinning. If the CPU fan is not spinning, make
sure the fan cable is plugged into the computer board
header. Ensure the fan is fully and properly seated or

e  The heatsink and
fan assembly is not
properly attached

to the CPU. installed.

3. |Iffan is plugged in and seated properly, but is not spinning,
the problem might be in the CPU fan. Contact HP for
assistance.

4. Verify that the fan assembly is properly attached. If problems
persist, there might be a problem with the CPU heatsink.
Contact HP for assistance.
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Table 4-8 Diagnostic lights and audible codes (continued)

Activity

Possible cause

Recommended action

Red Power LED blinks
three times, once every
second, followed by a
two-second pause. Three
beeps.

CPU not installed (not an
indicator of bad CPU).

1. Verify that the CPU is present.

2. Reseat the CPU.

Red Power LED blinks four
times, once every second,
followed by a two-second
pause. Four beeps.

Power failure (power
supply is overloaded).

CAUTION: Infernal components might be powered even when
the computer is off. To prevent damage, disconnect the computer
power cord before you remove a component.

1. Open the access panel and ensure that all power
connections are secure on the system board.

2. Check if a device is causing the problem by removing all
attached devices (such as hard, diskette, or optical disk
drives, and expansion cards.) Power on the computer. If the
system enters the POST, power off and replace one device at
a time; repeat this procedure until failure occurs. Replace the
device that is causing the failure. Continue adding devices
one at a time to ensure all devices are functioning properly.

Red Power LED blinks five
times, once every second,
followed by a two-second
pause. Five beeps.

Pre-video memory error.

CAUTION: Infernal components might be powered even when
the computer is off. To prevent damage, disconnect the computer
power cord before you remove a component.

1. Reseat DIMMs.
2. Replace DIMMs one at a time to isolate faulty module.
3. Replace third-party memory with HP memory.

4. The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks six
times, once every second,
followed by a two-second
pause. Six beeps.

Pre-video graphics error.

CAUTION: Internal components might be powered even when
the computer is off. To prevent damage, disconnect the computer
power cord before you remove a component.

1. Reseat the graphics card.

2. Verify the graphics auxiliary power cable is connected (if
applicable).

3. Confirm the graphics card is in the appropriate slot (PCle
x16).

4. The problem might be on the graphics card. Contact HP for
assistance.

Red Power LED blinks
seven fimes, once every
second, followed by a
two- second pause. Seven
beeps.

System board failure
(ROM detected failure
prior to video).

1. Clear CMOS.

NOTE: Refer to the Maintenance and Service Guide for
the computer model for detailed information on clearing
CMOS.

2. The problem might be on the system board. Contact HP for
assistance.
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Table 4-8 Diagnostic lights and audible codes (continued)

Activity

Possible cause

Recommended action

Red Power LED blinks
eight times, once every
second, followed by a
two-second pause. Eight
beeps.

Invalid ROM based on
bad checksum.

CAUTION: Internal components might be powered even when
the computer is off. To prevent damage, disconnect the computer
power cord before you remove a component.

1.

Clear CMOS.

NOTE: Refer to the Mainfenance and Service Guide for
the computer model for defailed information on clearing

CMOS.

Upgrade the ROM using SoftPaq, either from the hard disk
drive, CD, diskette, or USB removable device (for example,
HP Drive Key). See the ROM Flash section of the
Maintenance and Service Guide at http://www.hp.com

support/workstation_manuals. SoftPaq is a self-extracting

executable, which contains instructions for its use, that
enables you to upgrade the ROM. To download the Softpaq
executable, visit http://www.hp.com/go

workstationsupport.

The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks nine
times, once every second,
followed by a two-second
pause. Nine beeps.

System powers on but
does not start.

The problem might be on the system board. Contact HP for
assistance.

The problem might be in the CPU. Contact HP for assistance.
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Table 4-8 Diagnostic lights and audible codes (continued)

Activity

Possible cause

Recommended action

System does not power-on
and LEDs are not blinking.  on.
No beeps.

System unable to power

CAUTION:

Internal components might be powered even when

the computer is off. To prevent damage, disconnect the computer
power cord before you remove a component.

To resolve the problem, choose one of the following options:

Press and hold the power button for less than four seconds. If the

hard disk drive LED turns green, then:

1.

Remove the expansion cards one at a time and try holding
the power button again for less than four seconds.

The problem might be on the system board. Contact HP for
assistance.

Press and hold the power button for less than four seconds. If the
hard disk drive LED does not turn on green then:

1.
2.

Check that unit is plugged into a working AC outlet.

Open the access panel and check that the power button
harness is properly connected to the system board.

Check that all power supply cables are properly connected
to the system board.

Check the power supply functionality.

b.

Disconnect the AC power.

HP 2820 Workstation only—Remove the power supply
from the chassis. All other workstations, unplug cables
connected to system board.

Plug in AC power.

o If the power supply fan spins and the BIST LED
illuminates, the power supply is good; replace the
system board.

e If the power supply fan does not spin or the LED
does not illuminate, replace the power supply.

*
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LED color

definitions

The following table describes what each LED light on the computer front panel signifies.

Table 4-9 LED color definitions

LED state LED color System status

Solid Blue System is on.

Flashing Blue System is in Standby.

Solid or flashing ~ Red System has experienced an error. (See POST error

messages on page 153.)

None No light System is in Hibernate, or is off.

POST error messages

The Power-On Self Text (POST) is a series of diagnostic tests that runs automatically when the computer
is powered on.

Audible and visual messages occur before the operating system starts if the POST encounters a
problem. POST checks the following items to ensure that the computer system is functioning properly:

The table shown next describes the POST error messages.

Keyboard

DIMMs

Diskette drives

All mass storage devices
CPUs

Controllers

Fans

Temperature sensors

Cables (front/rear panels, audio, and USB ports)

Table 4-10 POST error messages

Screen message Probable cause

Recommended action

102—System Board Failure

Potential system board problem; contact HP Support.

110—Out of memory space Option ROM for a device could not
for option ROMs run because of memory constraints.

Run the Computer Setup (F10) Utility to disable
unneeded option ROMs, and to enable ACPI/USB
Buffers at Top of Memory.

161 —Real-Time Clock Power

Loss

1. Run the Computer Setup (F10) utility and set
default settings.

2. Replace the CMOS battery.

3. Replace the system board.
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Table 4-10 POST error messages (continued)

Screen message

Probable cause

Recommended action

162—Systems Options Error

1. Run the Computer Setup (F10) utility and set
default seftings.

2. Replace the CMOS battery.

3. Replace the system board.

163 —Time and Date Not Set

e Invalid time or date in
configuration memory.

e  RTC battery might need
replacement.

e  CMOS jumper might not be

properly installed.

1. Set the date and time from the Control Panel or in
the Computer Setup (F10) Utility (depending on
the operating system).

2. |f the problem persists, replace the RTC battery.

164—Memory Size Error

Memory configuration is incorrect.

Confirm that the correct memory is installed in the
system.

201—Memory Error

RAM failure.

1. Run the Computer Setup (F10) utility or the
Windows utilities.

2. Be sure that memory modules are installed
correctly.

3. Verify the memory module type.

4. Remove and replace memory modules one at a
time to isolate faulty modules.

5. Replace faulty memory modules.

6. If the error persists after replacing memory
modules, replace the system board.

214—DIMM Configuration
Warning

DIMMs are not installed correctly (not

paired correctly).

See the service label on the computer access panel for
the correct memory configurations, and reseat the
DIMMs accordingly.

301 —Keyboard Error

Keyboard failure.

1. Reconnect the keyboard with the computer
powered off.

2. Connect a keyboard directly to the computer
(instead of through a switch box).

3. Be sure that none of the keys are pressed.

4. Replace the keyboard.

303 —Keyboard Controller
Error

I/O board keyboard controller is

defective or is not set properly.

1. Reconnect the keyboard with the computer
powered off.

2. Connect a keyboard directly to the computer
(instead of through a switch box).

3. Replace the system board.
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Table 4-10 POST error messages (continued)

Screen message

Probable cause

Recommended action

304 —Keyboard or System
Unit Error

Keyboard failure.

1.

Reconnect the keyboard with the computer
powered off.

Connect a keyboard directly to the computer

(instead of through a switch box).
Be sure that none of the keys are pressed.
Replace keyboard.

Replace system board.

510—Splash Screen image
corrupted

Splash Screen image has errors.

Update system BIOS/UEFI.

511—CPU Fan not detected Fan is not connected or is defective. 1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.
512—Rear chassis fan not Fan missing, disconnected, or 1. Reseat the fan cable.
detected defective.

2. Reseat the fan.

3. Replace the fan.
513—Front Chassis fan not Front fan missing, disconnected, or 1. Reseat the fan cable.
detfected defective.

2. Reseat the fan.

3. Replace the fan.

514—Power supply wattage
insufficient for hardware
configuration

Computer configuration requires more
power than the power supply can
provide

Reduce the computer power consumption.

515—Power supply fan not Power supply fan is disconnected or 1. Reseat the power supply cables.
detected defective.

2. Replace the power supply.
517 —Memory fan not Memory fan missing, disconnected, or 1. Reseat the fan cable.
detected defective.

2. Reseat the fan.

3. Replace the fan.
518—PCl fan not detected PCl fan missing, disconnected, or 1. Reseat the fan cable.

defective.

2. Reseat the fan.

3. Replace the fan.
519—Hard drive fan not Hard drive fan missing, disconnected, 1. Reseat the fan cable.
detected or defective.

2. Reseat the fan.

3. Replace the fan.
520—Memory fan (2) not Memory fan (2) missing, disconnected, 1. Reseat the fan cable.
detected or defective.

2. Reseat the fan.

3. Replace the fan.
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Table 4-10 POST error messages (continued)

Screen message

Probable cause

Recommended action

521—Memory fan (3) not
detected

Memory fan(3) missing, disconnected,
or defective.

Reseat the fan cable.
Reseat the fan.

Replace the fan.

522—Memory fan (4) not
detected

Memory fan(4) missing, disconnected,
or defective.

Reseat the fan cable.
Reseat the fan.

Replace the fan.

523—CPU fan (2) not
detected

CPU fan(2) missing, disconnected, or
defective.

Reseat the fan cable.
Reseat the fan.

Replace the fan.

524—Rear chassis fan(2) not

detected

Rear chassis fan(2) missing,
disconnected, or defective.

Reseat the fan cable.
Reseat the fan.

Replace the fan.

525—Front chassis fan(2) not

detected

Front chassis fan(2) missing,
disconnected, or defective.

Reseat the fan cable.
Reseat the fan.

Replace the fan.

526—CPU Liquid Cooling
pump not detected

Liquid cooling pump on CPU1 is not
detected.

Reseat the pump cable.

Replace the pump.

527 —CPU Liquid Cooling
pump (2) not detected

Liquid cooling pump on CPU2 is not
detected.

Reseat the pump cable.

Replace the pump.

528—CPU requires Liquid
Cooling solution

Invalid system configuration.

Remove incorrect processor and reinstall original
processor.

Remove incorrect cooling solution and reinstall
original liquid cooling solution.

529 —Unsupported WiFi
Device(s) Detected

An unsupported WiFi device has been
installed into an internal slot.

Remove the unsupported device.

917 —Front Audio Not
Connected

Front Audio mechanism is missing or is
not connected.

Replace or reconnect the missing front audio
mechanism to the system board.

Reseat or replace the missing mechanism cable.

918—Front USB Not
Connected

Front USB mechanism is missing or is
not connected.

Replace or reconnect the missing Front USB
mechanism to the system board.

Reseat or replace the missing mechanism cable.

921 —Front USB Not
Connected

Front USB mechanism is missing or is
not connected.

Replace or reconnect the missing Front USB
mechanism to the system board.

Reseat or replace the missing mechanism cable.
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Table 4-10 POST error messages (continued)

Screen message

Probable cause

Recommended action

922—Front USB 2 Not
Connected

Front USB 2 mechanism is missing or
is not connected.

1. Replace or reconnect the missing Front USB 2
mechanism to the system board.

2. Reseat or replace the missing mechanism cable.

923 —Fatal IRPP error.

Potential system problem; contact HP Support.

924 —Fatal IO error

Potential system problem; contact HP Support.

927 —Fatal error on DIMM in
slot CPU X DIMM Y

Fatal multibit ECC error detected on
the DIMM in the slot labeled DIMM Y
(where Y is a number), as labeled on
the system board.

Replace the DIMM in the identified slot.

928 —Fatal error occurred in
the designated slot.

Fatal error occurred in the designated
slot.

Move the card to a different slot. If the problem
persists, replace the card.

939 —Front USB 3.0 Not
Connected

Front USB 3.0 mechanism is missing
or is not connected.

1. Replace or reconnect the missing Front USB 3.0
mechanism to the system board.

2. Reseat or replace the missing mechanism cable.

940—Front 1394 Not
Connected

Front 1394 mechanism is missing or is
not connected.

1. Replace or reconnect the missing Front 1394
mechanism to the system board.

2. Reseat or replace the missing mechanism cable.

941 —PCle Device(s) installed
in slots 3 or 4 with a single
CPU

Invalid system configuration.

1. Move the PCle device from PCle slots 3 and/or 4
to other PCle slofs.

2. Add a second processor using appropriate HP
accessory kit.

1801 —Microcode Update
Error

Unknown or unsupported processor
stepping.

The microcode update failed. If the processor stepping
is supported, contact HP Support.

1802 —Processor Not
Supported

The system board does not support the
processor.

Replace the processor with a compatible one.
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5 Configuring password security and
resetting CMOS

This chapter describes how to configure password security and to reset CMOS, and includes these
topics:

e Preparing to configure passwords on page 158

e  Resetting the password jumper on page 159

e Clearing and Resetting the CMOS on page 160

Preparing to configure passwords

The Computer Setup (F10) Utility enables you to create setup and power-on passwords.
There are three possibilities for setting passwords:

o Define a setup password only. You will need the password to enter the Computer Setup (F10)
Utility, but do not need a password to start the workstation.

e Define a power-on password only. This password lets you start the workstation or enter the setup
utility.

e  Define both. In this case, the setup password lets you start the workstation and enter the setup
utility. The power-on password starts the workstation but does not let you enter the setup utility,

After you create both passwords, you can use the setup password in place of the power-on password
as an override fo log into the computer (a useful feature for a network administrator).

2»NOTE:  You can only clear the passwords with the password jumper. Clearing CMOS does not clear
the passwords.

/\ CAUTION: Before pressing the Clear CMOS button, back up your computer CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized
information, including asset numbers and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to Diskette
from the File menu.
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Resetting the password jumper

Use the following procedure to disable the power-on or setup password features and clear the power-
on and setup passwords.

/\ WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to
disconnect the power cord from the wall outlet and allow the internal system components to cool before

touching.

/\ CAUTION: When the computer is plugged in, the power supply has voltage applied to the system
board, even when the computer is turned off. Failure to disconnect the power cord can result in
damage to the system.

/\ CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by
briefly touching a grounded metal object.

1.

No u bk

Access the jumper:

Shut down the operating system, power off the computer and external devices, and
disconnect the computer power cord and external devices from power outlets.

Disconnect any external devices.

Verify that the AC power cord is disconnected from the power outlet.
Open the workstation.

Locate the password header and jumper.

The password header is E49. The password jumper is blue so it can be easily identified.

Remove the jumper from pins 1 and 2. Do not lose the jumper.

Restart the computer:

a.
b.

C.

Close the workstation.
Reconnect the AC power cord to the computer.

Power on the computer and wait for the workstation to display the HP splash screen.

Repeat step 1.

Replace the jumper on pins 1 and 2.

Repeat step 3, except press the F10 key during startup to access the Computer Setup (F10) Utility.

Use the Setup Utility to create new passwords.
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Clearing and Resetting the CMOS

This section describes the steps necessary to successfully clear and reset the CMOS. The CMOS of the
computer stores password information and information about the computer configuration.

Using the CMOS Button to Reset CMOS

To clear CMOS using the Clear CMOS button, use the following procedure:

/\ WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

/\ CAUTION: When the computer is plugged in, the power supply has voltage applied to the system
board, even when the computer is powered off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, be sure that you are discharged of static electricity by briefly touching a
grounded metal object.

1. Back up your computer CMOS settings Run the Computer Setup (F10) Utility, and select File >
Save to Disk.

/\ CAUTION: Pressing the Clear CMOS button resets CMOS values to factory defaults and erases

customized information, including asset numbers and special settings.

2. Shut down the operating system, power off the computer and external devices, and disconnect
peripheral devices.

3. Disconnect the AC power cord from the power outlet.

@NOTE: The CMOS button does not clear CMOS if the power cord is connected.

4. Open the workstation.
Locate, press, and hold the CMOS button for five seconds.

For assistance locating the CMOS button and other system board components, see the system
board layout in HP Z820 Workstation system board components on page 33.

6. Close the workstation, reconnect external devices, connect the power cord and power on the
workstation.

7. The system boots to an F1 prompt and displays a message that the date/time has changed and
that system options have changed.

Press F1. The system shuts down for three seconds and then powers on again.

9. Use the F10 (Setup) Utility to reset the date and time.
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Using the Computer Setup (F10) Utility to Reset CMOS

1. Access the Computer Setup (F10) Utility menu.

2. When the Computer Setup message appears in the lower-right corner of the screen, press F10,
and then press Enter to bypass the title screen, if necessary.

If you do not press F10 while the message is displayed, the computer must be rebooted to access
this utility.

3. From the Computer Setup (F10) Utility menu, select File > Default Setup.

This restores the seftings that include boot sequence order and other factory settings. However, it
does not force hardware rediscovery.

4. Choose Restore Factory Settings as Default, and the press F10 to accept.
Select File > Apply Defaults and Exit, and then press F10 fo accept.

6. Reset the computer passwords and configuration information, such as the system date and time.

@NOTE: This step does not clear the passwords.
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Linux technical notes

HP offers a variety of Linux solutions for HP workstation customers:

e  HP certifies and supports Red Hat Enterprise Linux (RHEL) on HP workstations.
e  HP certifies SUSE® Linux Enterprise Desktop (SLED) on HP workstations.

e HP offers a SLED 11 preload on some Z series Workstations.

For Linux set up and restore procedures, see the user guide for your workstation at
http://www.hp.com/support/workstation_manuals.

Topics

System RAM on page 162

Audio on page 162

Network cards on page 163

Hyper-Threading Technology (HTT) on page 163

NVIDIA® Graphics Workstations on page 164

E/?’NOTE: After you set up the operating system, make sure the latest BIOS, drivers, and software

updates are installed.

/\ CAUTION: Do not add optional hardware or third-party devices to the workstation until the

operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

System RAM

HP supports different amounts of total RAM in various HP workstations based on the number of
hardware DIMM slots and the capabilities of the system. The total memory supported for each
configuration is listed in the Hardware Support Matrix for HP Linux Workstations at
http://www.hp.com/support/linux_hardware_matrix.

Audio

162

All HP workstations come with builtin audio hardware. The audio hardware is supported by the
Advanced Linux Sound Architecture (ALSA) drivers included with all modern Linux distributions.

The audio hardware provides basic playback and recording features. The ability to simultaneously play
audio from multiple sources, such as applications and CDs, is provided by software mixing functionality
in the ALSA driver. The performance of software audio mixing and playback functionality is greatly
improved in ALSA version 1.0.13 and later drivers.
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The optional Nvidia and AMD graphics supported in HP Personal workstations also provide audio
functionality over HDMI, which can be passed through the DisplayPort connector to a monitor with
audio capabilities. The vendor proprietary driver must be installed. Such a configuration may present
two audio hardware choices. If you do not hear sound through the speakers, one possible reason is

that the graphics card has been chosen by default. Check the audio settings (for example, Sound in
gnome-control-center).

In some systems, embedded Intel HD graphics may also present a similar HDMI audio device that can
be used through the DisplayPort interface. No proprietary driver is needed for this device, just a
sufficiently-recent kernel.

Network cards

All HP workstations include one or two integrated network interface controllers. Some support optional
NICs. Most Linux distributions have drivers for these interfaces.

Hyper-Threading Technology (HTT)

The Z series Workstations support HTT, an Intel-proprietary technology that improves processor
performance through parallelization of computations (doing multiple tasks at once). The operating
system treats an HTT-enabled processor as two virtual processors and shares the workload between
them when possible. This feature requires that the operating system support multiple processors and be
specifically optimized for HTT.

To enable HTT:

During startup, press F10 to enter the Computer Setup (F10) Utility.

Select Advanced > Device Options.

Use the arrow keys to set Hyper-Threading to Enable, and then press F10 to exit the menu.

W=

Select File > Save Changes and Exit.

5. Restart the system to enable HTT.

2»NOTE:  On most recent Linux distributions (including RHEL 5, RHEL 6, SLED 11, and updates to those
streams), the kernel automatically detects that HTT is enabled and works correctly.
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NVIDIA® Graphics Workstations

164

Some workstation configurations come with NVIDIA® Quadro™ graphics hardware. HP recommends
use of NVIDIA proprietary graphics drivers for best results on Linux systems.

HP provides recommended versions of the drivers with RPM-compatible installers for RHEL and SLED
distributions. These are available from the HP Installer Kit for Linux and from workstation driver
repositories on hp.com. When HP installers are used, their contents and documentation links are
installed in the /opt/hp/nvidia folder.

When installing Linux on a workstation that has an NVIDIA card, administrators should select a VESA-
compatible driver to avoid instability experienced with some open-source versions of the Nouveau and
DRM drivers.

Open source versions of Nouveau drivers and NVIDIA proprietary graphics drivers cannot coexist in
the same runtime environment because they use the same hardware resources. If administrators create
their own Linux environments using NVIDIA proprietary graphics drivers but choose not to use HP-
packaged versions, HP recommends that they manually append the following boot loader parameters
to properly suppress the Nouveau driver at runtime (grub example below):

kernel /vmlinuz ... rdblacklist=nouveau nouveau.modeset=0
This action is applied by HP installers but must be applied/restored under other circumstances.

To customize the display characteristics and resolutions of an NVIDIA proprietary graphics driver
environment, execute:

/usr/bin/nvidia-settings
To create and manipulate the /etc/X11/xorg.contf file, execute:

/usr/bin/nvidia-xconfig
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AMD® Graphics Workstations

Some workstation configurations include AMD® graphics hardware. HP recommends use of AMD
proprietary graphics drivers for best results on Linux systems.

HP also provides recommended versions of AMD proprietary graphics drivers with RPM-compatible
installers for RHEL and SLED distributions. These are available from the HP Installer Kit for Linux and
workstation driver support packages on hp.com.

The open source RADEON and RADEONHD drivers can conflict with the AMD proprietary graphics
drivers, by claiming the hardware early in the boot process. The AMD driver installation process usually
blacklists conflicting drivers and turns off kernel mode-setting in the initial RAM image.

Administrator customization of the display characteristics and many other aspects of an AMD
proprietary graphics driver environment is available through the following command, which starts the
Catalyst Control Center:

/usr/bin/amdcccle

Some settings for AMD graphics, including reconfiguration of the /etc/X11/xorg.cont file, can be
accomplished through the many options provided by the command:

/usr/bin/aticonfig

Information can be found in these directories after the driver is installed:
/opt/hp/ati

/usr/share/ati

/usr/share/doc/fglrx

If the automatic init script attempts to rebuild the kernel module, the log file is:

/var/log/fglrx-build.log
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B Configuring RAID devices

This appendix explains how to configure RAID arrays on your workstation. It includes these topics:

Topics

Supported hard drive maximum and storage controller options on page 166

Supported RAID configurations on page 167

Configuring Intel SATA RAID on page 168

Configuring RAID on an LS| 2308 or LS| 9212-4i controller on page 171

Configuring RAID on an LS| 9260-8i MegaRAID controller on page 174

Software RAID solution on page 176

For additional information about RAID configuration, go to http://www.hp.com/support/RAID_FAQs.

Supported hard drive maximum and storage
controller options

This section lists the maximum number of hard drives supported on HP workstations for RAID
configurations and storage controller options.

2»NOTE: This section applies to internal workstation configurations that do not use add-in cards and
external enclosures.

Table B-1 Maximum hard drives allowed

Hard Drives Storage Controllers
SATA SAS Onboard Optional

85mm 6.3mm 85 mm 6.3 mm RST RSTe LSl LSl LSl

(3.5in) (2.5in) (3.5in) (2.5in) 2308 9212-4i 9260-8i
7220 SFF 2 2 — — Yes — — — —
7220 3 3 — — Yes — — — —
CMT
7420 4 4 4 4 - Yes - Yes Yes
7620 4 4 4 4 - Yes - Yes Yes
7820 6 8 6 8 - Yes Yes - Yes
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All workstation platforms have Intel controllers. Three LS| controllers are supported on some platforms:

Supported RAID configurations

e LSI 2308 — HP Z820 Workstations
e LSI9212-4i — HP Z420 and Z620 Workstations (optional)
e LSI9260-8i — HP 2420, Z620, and Z820 Workstations (optional)

The following RAID configurations are supported.

Table B-2 RAID configuration details

Configuration

Description

Controllers

RAID 0

Integrated striped disk
array

Two drive minimum.
Improved 1/O performance.
No fault tolerance.

Failure of any disk in the array results in
complete data loss.

Used to increase disk performance.

e Intel with RSTe or RST

e LSI2308
o LSI9212-4i
o LSI9260-8i

RAID 1

Mirrored disk array

Two drive maximum.

100% redundancy: all data from one drive is
duplicated on a second drive.

Can recover from single drive failure.

Good entry-level redundant system.

e Intel with RSTe or RST

e LSI2308
o LSI9212-4i
e LSI9260-8i

RAID 5

Striped disk array with
distributed parity

Three or more drives (for workstations that
support three or more hard drives).

Fault tolerant and provides 1/O performance
improvement, especially for write-biased
applications.

Single drive failure does not cause data loss
(performance is compromised until the failed
drive is replaced and the array rebuilt).

e Intel with RSTe or RST

o LSI 9260-8i

RAID 10

Four or more disks (for workstations that support
four or more hard drives).

e Intel with RSTe or RST

Striped and mirrored e 1SI 2308
disk array Excellent performance.
e LSI9212-4i
Uses several drives to stripe data, then copies the )
striped drives to provide redundancy. o LSI926038i
Offers high data transfer of striped arrays and
increased data accessibility (reads).
RAID 1E Similar to RAID 10. e LSI12308
Two-way mirroring Must have an odd number of disks. o LSI9212:4i

Improved read performance.

Supported RAID configurations
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Configuring Intel SATA RAID

This section describes how to use Intel® Rapid Storage Technology enterprise (Intel® RSTe) or Intel®
Rapid Storage Technology (RST) to set up and manage SATA RAID volumes.

E/?’NOTE: These instructions apply to Windows. They also apply to Linux distributions that include the
isci kernel driver support for the RSTe technology. This driver is included on recent releases of most
upstream and enterprise distributions, and may be available to be added to some previous releases. If
this driver is not available in the distribution, or is not applicable to the platform (e.g. the RST
controller), the Software RAID solution is recommended.

You can create a SATA RAID array that contains up to the maximum number of internal SATA hard disk
drives and eSATA drives (if you use an optional eSATA bulkhead cable) supported on your workstation.

Two or more hard drives must be attached to a controller (AHCI or SCU) for that controller's option
ROM to run. If two or more drives are on each controller, a unique option ROM executes for each
controller.

The Intel SATA AHCI option ROM and SCU option ROM configuration utilities run when you select
RAID+AHCI for the SATA emulation mode.
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Configuring system BIOS

To set up a RAID configuration, the emulation mode must be set to RAID+AHCI in the Computer Setup

(F10) Utility. This is the default setting. If the mode has been changed, follow these steps to change it
back.

1. During startup, press F10 to enter the Computer Setup (F10) Utility.
2. Using the arrow keys, navigate to:

a. Desired language, then press Enter.

b. Storage > Storage Options, then press Enter.

c. SATA Emulation > RAID+AHCI, then press F10 to accept the new seftings.
3. Navigate fo:

a. Advanced > Power-On Options, then press Enter.

b. POST Messages > Enable, then press F10 to accept the new settings.
4. Navigate fo:

a. Advanced > Device Options, then press Enfer.

b. SATA RAID Option ROM Download, then press Enter.

c. Enable, then press F10 to accept the new settings.

Navigate to File > Save Changes and Exit, then press Enter.

6. Press Entfer to accept the changes when prompted.
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Configuring RAID with the Intel utility
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Follow these steps to create RAID volumes.

E/?’NOTE: The option ROM displays once for each controller. For example, if you have two drives on the
AHCI controller and two on the SCU controller, then both option ROMs will display. Select Ctrl+l when
prompted to choose the controller.

1. Press Cirl+l when prompted to enter the Intel Rapid Storage Technology enterprise utility (RSTe).

@NOTE: It only one hard drive is attached, the utility does not display.

E‘%NOTE: On the HP Z220 Workstations, the Intel Rapid Storage Technology utility (RST) is used.

2. Use the arrow keys to navigate to 1. Create RAID Volume, then press Enter.
3. Enter the desired RAID volume name in the Name field, then press Tab.
4. Select to a level in the RAID Level field, then press Tab.
5. If three or more hard drives are installed (for workstations that support this configuration):
a. Press Enter to display the Select dialog.
b. Use the up/down arrow keys and the space bar to mark individual physical as members of
the volume.
c.  Press Enter to exit the Select dialog and return to the Create Volume Menu dialog.
6. If appropriate, select a size in the Stripe Size field, then press Tab.
7. Enter the desired volume size in the Capacity field, then press Tab.
8. Press Enter to initiate volume creation.

9. When prompted, press Y to acknowledge the warning message and create the volume.
10. Navigate to 5. Exit, then press Enter.

11. Press Y when prompted to confirm the exit.
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Configuring RAID on an LSI 2308 or LSI 9212-4i
controller

This section explains how to use the LS| Logic Configuration Utility to set up a SATA or SAS RAID array
on the LSI 2308 or LSI 9212-4i controllers.

E/?NOTE: These instructions apply to Windows and Linux.

RAID O configuration

Follow these steps to configure an Integrated Striped (IS) volume with the BIOS-based configuration
utility. The procedure assumes that the system has the required disk and disk controllers.

1. During startup, press Cirl-C when prompted to start the LS| Logic Configuration Utility.
2. Using the arrow keys, navigate to:

a. An appropriate adapter, then press Enter.

b. RAID Properties, then press Enter.

c. Create IS Volume, then press Enter.

3. Inthe Create New Array screen, select the first disk for the IS volume. Move to the RAID Disk
column for this disk, and use the Space bar and + or — arrows to select Yes.

@NOTE: If partitions are defined on the selected disk, a message warns you that data on the disk
will be lost when the striped volume is created.

4. To select additional drives for the striped volume (up to the maximum number allowed for the
workstation), repeat step 3.

5. When all drives are selected, press C to create the array. Navigate to Save changes then
exit this menu and press Enter.

6. When the new array is created, the Adapter Properties screen appears. Press Esc twice, then
select Exit.
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RAID 1 configuration
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Follow these steps to configure an Integrated Mirroring (IM) volume with the BIOS-based configuration
utility. The procedure assumes that the system has the required drives and drive controllers.

1. During BIOS startup, press Ctrl-C when prompted to start the LS| Logic Configuration Utility.
2. Using the arrow keys, navigate to:

a. An appropriate adapter, then press Enter.

b. RAID Properties, then press Enter.

c. Create IM Volume, then press Enter.
3. To configure a two-disk mirrored volume with an optional hot spare disk:

a. Inthe Create New Array screen, select the primary disk for the IM volume (the disk with
the data you want fo mirror.)

b. Navigate to the RAID Disk column for this disk, then use the Space bar and + or — arrows
to select Yes. The value in the Array Disk column changes to Primary.

2 NOTE: If partitions are defined on the selected disk, a message warns you that data on the
disk will be lost when the mirrored volume is created.

c. Navigate to the secondary (mirrored) disk for the IM volume and set the Array Disk column
value to Yes.

%/%"NOTE: It partitions are defined on the selected disk, a message warns you that data on the
disk will be lost when the mirrored volume is created.

d. Press Delete to confirm that the data on the disk can be erased, or press any other key to
deselect the disk.

4. When all drives are selected, press C to create the array. Navigate to Save changes then
exit this menu and press Enter.

5. When the new array is created, the Adapter Properties screen appears. Press Esc twice, then
select Exit.
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RAID 1E/10 configuration

Follow these steps to configure an Integrated Mirroring Extended (IME) volume. The procedure assumes
the system has the required disk and disk controllers.

[ NOTE: If an odd number of drives are used, a RAID 1E array is created. If an even number of drives
are used, a RAID 10 array is created.

1. During BIOS startup, press Cirl-C when prompted to start the LS| Logic Configuration Utility.
2. Using the arrow keys, navigate to:

a. An appropriate adapter, then press Enter.

b. RAID Properties, then press Enter.

c. Create IME Volume, then press Enter.

3. To configure a mirrored volume or an optional hot spare drive with up to the maximum number of
drives allowed for the workstation:

a. Inthe Create New Array screen, select the primary disk for the IME volume (the disk with
the data you want to mirror.)

b. Navigate to the RAID Disk column for this disk, then use the Space bar and + or — arrows
to select Yes. The value in the Array Disk column changes to Primary.

2% NOTE: If partitions are defined on the selected disk, a message warns you that data on the
disk will be lost when the mirrored volume is created.

c. Navigate to the next disk for the IME volume (mirrored) disk for the IM volume and set the
Array Disk column value to Yes.

2% NOTE: If partitions are defined on the selected disk, a message warns you that data on the
disk will be lost when the mirrored volume is created.

d. Press Delete to confirm that the data on the disk can be erased, or press any other key to
deselect the disk.

4. Repeat step 3 to select up to the workstation-specific maximum number of drives for the IME
volume, including configuration of a hot spare.

5. When all drives are selected, press C to create the array. Navigate to Save changes then
exit this menu and press Enter.

6. When the new array is created, the Adapter Properties screen appears. Press Esc twice, then
select Exit.
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Configuring RAID on an LSI 9260-8i MegaRAID
controller

This section explains how to use the LSI Logic Configuration Utility to set up SATA or SAS RAID arrays
on the LS| 9260-8i MegaRAID controller.

@NOTE: This section applies to Windows and Linux.

RAID O

Follow these steps to configure a RAID O volume with the BIOS-based configuration utility. The
procedure assumes that the system has the required disk and disk controllers.

2»NOTE: For more information about the 9260-8i RAID controller, see the MegaRAID SAS Software
User Guide at http://www.lsi.com/downloads/Public/MegaRAID%20Common%20Files
51530-00_RevE.pdt, particularly the “Introduction to RAID” and WebBIOS Configuration Utility”

sections.

1. Make sure the drives you want to configure are connected to the LSI 9260-8i MegaRAID
controller.

E%?NOTE: For details, see LSI MegaRAID SAS 9260-8i Card Installation ot
http://bizsupport1.austin.hp.com/bc/docs/support/SupportManual /c02027249

c02027249.pdt.

2. During startup, press Cirl-H to enter the LSI 9260-8i WebBios utility.
3. Configure the array:
a. Inthe left pane, click Configuration Wizard.
b. Select Add Configuration, then click Next.
c. Select Manual Configuration, then click Next.
d. Select the drives to include in the RAID array, then click Add To Array.
e. Click Accept DG, then click Next.
f. Click Add to SPAN, then click Next.
4. Select the desired options for your RAID array. Available options:

e RAID Level (available options depends on the number of disks in your RAID volume): RAID
0, RAID 1, RAID 5, RAID 6

e  Strip Size: 8KB, 16KB, 32KB, 64KB, 128KB, 256KB, 512KB, TMB

e Access Policy: RW (Read/Write), Read Only, Blocked

e Read Policy: Normal, Ahead

e  Write Policy: Write Through, Always Write Back, Write Back with BBU
e 10 Policy: Direct, Cached

e Drive Cache: No Change, Enable, Disable
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e Disable BGI: No, Yes

e Select Size: Specify the size of the RAID array

Click Next.

A dialog warns you that if your Write Policy is set to:

e  Write Through, the configuration may result in slower performance.

e Always Write Back, the configuration will result in optimal performance, but there is a
risk of data loss in the event of power failure.

e  Write Back with BBU and you do not have BBU installed, write back is only enabled
when the battery has a sufficient charge, and that during a learning cycle the caching policy
will revert to write through until the learning cycle is complete.

Click Yes to accept the warning, then click Next.
Click Accept, then click Yes to save the configuration.

Click Yes to initialize the virtual drive you just created.
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Software RAID solution

This section provides a summary of software RAID considerations when running the Linux operating
system, as well as references to configuration procedures.

Software RAID considerations

The Linux kernel software RAID driver (called md, for multiple device) offers integrated software RAID
without the need for additional hardware disk controllers or kernel patches. All that is required are
multiple hard disks and a small amount of setup. Unlike most hardware RAID solutions, software RAID
can be used with all types of disk technologies, including SATA, SAS, SCSI and solid state drives.

Compared to hardware-based RAID, software RAID has disadvantages in managing the disks,
breaking up data as necessary, and managing parity data. The CPU must assume some extra loading:
disk-intensive workloads result in roughly double the CPU overhead (for example, from 15% to 30%).
For most applications, this overhead is easily handled by excess headroom in the processors. But for
some applications where disk and CPU performance are very well balanced and already near-
bottleneck levels, this additional CPU overhead can become troublesome. Hardware RAID offers
advantages because of its large hardware cache and the capability for better scheduling of operations
in parallel. However, software RAID offers more flexibility for disk and disk controller setup.
Additionally, hardware RAID requires that a failed RAID controller must be replaced with an identical
model to avoid data loss, whereas software RAID imposes no such requirements.

Some software RAID schemes offer data protection through mirroring (copying the data to multiple disks
in case one fails) or parity data (checksums that allow error detection and limited rebuilding of data in
case of a failure), but all software RAID solutions on HP workstations require the shutdown of the system
so that the failed drive can be replaced before redundancy can be restored. The replacement of failed
drives in software RAID requires only a minimum amount of work.

Performance considerations
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Disk /O bandwidth is typically limited by the system bus speeds, the disk controller, and the disks
themselves. The balance of these hardware limitations, as affected by the software configuration,
determines where the real bottleneck is in the system.

Several RAID levels offer improved performance relative to a standalone disk. If the disk throughput is
lessened by a single disk controller, there is probably little you can do with RAID to improve the
performance without adding another controller. On the other hand, if the raw disk performance is the
bottleneck, a tuned software RAID solution can dramatically improve the throughput. The slower the
disk is relative to the rest of the system, the better RAID performance will scale, because the slowest
piece of the performance pipeline is being directly addressed by moving to RAID.
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Configuring software RAID

See the following sites for additional information on configuring software RAID on Red Hat Enterprise
Linux (RHEL) or SUSE Linux Enterprise Desktop (SLED).

e Red Hat Enterprise Linux 6 — See the Storage Administration Guide at
http://docs.redhat.com/docs/en-US/Red Hat Enterprise Linux/6/html/
Storage Administration Guide/index.html

e Red Hat Enterprise Linux 5 — See the Deployment Guide at http://docs.redhat.com/docs/
en-US/Red_Hat_Enterprise_Linux/5/html/Deployment_Guide/ch-raid.html

e SLED 11 — See the Deployment Guide at http://www.suse.com/documentation/sled 11/
book sle deployment/?page=/documentation/sled11/book sle deployment/data/
book sle deployment.html

See the following site for more information:

e  Open Source and Linux at HP: http://h10018.www 1.hp.com/wwsolutions/linux/index.html
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C System board designators

HP Z220 SFF Workstation

Designator Silk screen Component/Description

E15 E15 Crisis recovery header/jumper

E49 E49 Clear password header/jumper

19 RJ45/USB LAN/DUAL USB 2.0

110 110 Quad rear USB 3.0

120 PCI1J20 PCl slot (white)

131 J31 X1PCIEXP1 PCle2 x1 slot (black)

141 141 X16PCIEXP PCle3 x16 slot (black)

142 142 X4PCIEXP PCle2 x16(4) slot (black)

153 VGA/COMA Serial port connector stacked over VGA port
164 DISPLAYPORT Display port connector

168 PS2 Mouse connector stacked over keyboard connector
178 IN/OUT Audio line in stacked over audio line out
SW50 SW50 CMOS Clear CMOS switch/push button

P1 PWR Power supply, 6-pin (white)

P2 PWRCMD Power command, 6-pin (white)

P3 PWRCPU Power supply, 4-pin (white)

P5 P5 PB/LED Front power button/LED (black)

P6 SPRK Internal speaker (white)

P9 CHFAN1 Front chassis fan

P23 FRONT AUD Front audio (blue)

P24 FRONT USB Front I/O USB (yellow)

P25 FRONT USB2 Front I/O USB (green)

P52 COMB Serial port

P124 HLCK Hood lock solenoid (black)

P125 HSENSE Hood sensor

P126 PAR Flying parallel port (black)

P150 MEDIA Media card reader
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Designator Silk screen Component/Description
P151 MEDIA2 Media card reader
P160 SATAPWRI HDD power (black)
XBT1 XBT1 BAT Battery holder
XMM1 - XMM4 XMM1 - XMM4 Memory slots
DIMM1 - DIMM4
XU1 XU1 CPU socket

HP Z220 CMT Workstation

Table C-1 HP Z220 CMT Workstation system board designators

Designator Silk screen Component

E15 E15 Crisis recovery header/jumper
E49 E49 Clear password header/jumper
19 J9 RI/USB LAN/DUAL USB

J10 J10 QUAD USB Dual USB3.0/Dual USB2.0

J20 120 SLOTé PCI 32/33 PCl slot

121 J21 SLOT7 PCI 32/33 PCl slot

131 131 SLOT3 PCle2 x1 PCle2 x1 slot

132 132 SLOT5 PCle2 x1 PCle2 x1 slot

133 133 SLOT1 PCle2 x8(4) PCle2 x8(4) slot

134 134 SLOT4 PCle2 x16(4) PCl slot

141 141 SLOT2 PCle3 x16 75W PCle3 x16 slot

164 DP Display port connector

165 DVI DVH connector

168 J68 PS2 Stacked keyboard/mouse connector
183 183 Triple stacked audio jacks

186 186 Slot2 PCle x16 retention clip
MTG1-MTG10 N/A Mounting holes

P1 P1 Power supply connector (18-pin)
P3 P3 CPU PWR CPU power connector (4-pin)

P5 P5 Power button/HDD LED/Power LED switch/Side

access panel sensor/Temperature header

HP Z220 CMT Workstation
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Table C-1 HP Z220 CMT Workstation system board designators (continued)

Designator Silk screen Component
P6 SPKR Speaker
P8 P8 CHFAN Rear system fan
P9 P9 Front fan header
P24 P24 FRONT USB Front panel USB header
P25 P25 INTERNAL USB2 Dual internal USB header
P26 P26 INTERNAL USB3 Single internal USB header
P27 DASH/USB1 DASH/Dual internal USB
P29 P29 HDD LED Hard disk drive LED connector
P54 COM Serial port header
P60-P64 SATAO - SATA4 SATA connectors
P65 eSATA eSATA connector
P66 - P67 P66 - P67 SATA connectors
SATA4 - SATAS
P70 P70 CPUO FAN Primary CPU fan header
P124 P124 HOOD LOCK Side access panel solenoid lock header
P126 PAR Parallel port header
SW50 SW50 CMOS Clear CMOS switch/push button
XBT1 XBT1 BAT Battery holder
XMMT - XMM4 XMMT1 - XMM4 Memory slots
DIMM1 - DIMM4
XU1 XU1 Primary CPU socket

HP Z420 and Z620 Workstation system

board

designators
Table C-2 HP Z420 and Z620 Workstation system board designators
Designator Name on board Component
E14 BB ROM bootblock header
E15 BBR ROM bootblock recovery header
E16 ROM RCVRY ROM Recovery header,/jumper
E17 LPC LPC Debug
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Table C-2 HP Z420 and Z620 Workstation system board designators

(continued)

Designator Name on board Component

E49/]P49 PSWD Clear Password header

19 RJ45/USB Stacked RJ45/Dual USB

J10 usB Quad Stacked USB

120-22 PClIx (x=1-3) PCl slots

131-32 XTPCIEXPx (x=1-2) PCI Express X1 slot

141 X16PCIEXP or MXM PCl Express x16 or MXM graphics slot
142 X4PCIEXP PCl Express x4 graphics slot

168 PS2 Stack keyboard/mouse connector
169 VGA or VGA/COMA VGA connector or VGA+serial port
J70 usB Primary Single USB

171 usB Secondary Single USB

190 usB 3rd Single USB

191 USB 4th Single USB

172 MIC Microphone jack

173 IN Line-In audio jack

174 ouT Line-out audio jack

176 HDPH Headphone jack

177 PH/MIC Double Stacked PH/MIC

178 IN/OUT Double Stacked Line-in/out

180 SER/AUD Stacked Serial/Audio

181 usB Primary Double USB

182 usB Secondary Double USB

183 AUD Triple Stacked Audio

J103 PWR DC Input Power

P1 PWR P/S connector

P2 PWRMEM P/S memory power connector

P3 PWRCPU VCCP 12V header

P4 (2620 only) PWRCPU2 P/S 2nd CPU & Memory 12V Connector
P5 PB/LE Control panel

P6 SPKR Speaker connector

P8 CPUFAN CPU fan header

HP Z420 and Z620 Workstation system board designators
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Table C-2 HP Z420 and Z620 Workstation system board designators

(continued)
Designator Name on board Component
P9 CHFAN Front chassis fan header
P10 FLOPPY Floppy header
P11 CHFAN2 Rear chassis fan header (Z620)
P23 FRONT AUD Header for Front Panel Audio
P24/25 FRONT USB/FRONT USB2 Header for Front Panel USB
P52 COMAB Header/Connector for 2nd Serial Port
P54 COMA Header/Connector for 1st Serial Port
P60 SATAO SATAO connector
P61 SATA1 SATA1 connector
P626 SATA2 SATA?2 connector
P63 SATA3 SATA3 connector
P66 SATA4 SATA4 connector
P91 P91 2620 memory fan
P92 P92 7420 memory fan
P95 CHFAN2 Rear chassis fan header (Z420)
P125 SATA4 Hood sense (Z420)

HP Z820 Workstations

Table C-3 HP Z820 Workstation system board designators

Designator Name on board Component

E1/JP1 SPI BIOS ME/AMT Flash Override Header
E15/JP15 BIOS Crisis Recovery Header
E49/)P49 PSWR Password Clear Jumper

12 SAS OPT SAS Option ROM Header

19 RJ-45/USB Stacked RJ-45/Dual USB 2.0

1 RJ-45/USB2.0 Stacked RJ-45/Dual USB 2.0

n2 1394A/USB3.0 Stacked 1394a/Dual USB 3.0

13 FRONT 1394A Front 1394a

120 J20 SLOT7-PCI PCl 32/33 Slot

131 131 SLOT1-PCle3 x8(4) PCl Express Gen 3 x8(4) Slot, Open-Ended
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Table C-3 HP Z820 Workstation system board designators (continued)

Designator Name on board Component

132 132 SLOT5-PCle2 x8(4) PCl Express Gen 2 x8 (4) Slot, Open-Ended
J33 J33 SLOT4-PCle3 x16 PCl Express Gen 3 x16 Graphics Slot
134 134 SLOT3-PCle3 x16(8) PCl Express Gen 3 x16(8) Slot

141 141 SLOT2-PCle3 x16 PCl Express Gen 3 x16 Graphics Slot
142 142 SLOT6-PCle3 x16 PCl Express Gen 3 x16 Graphics Slot
168 PS2 Stacked Keyboard/Mouse

183 Triple Stacked Audio

P1 MAIN POWER Main Power Connector

P2 MEM PWR Memory Power Connector

P3 CPUO PWR CPUO Power Connector

P4 CPUT PWR CPU1 Power Connector

P5 FRONT Ul Front Power Button/LED/Speaker Header
P8 REAR FANS Rear Chassis Fans Header

P24 USB 2.0 Internal USB 2.0 2x5 Header

P25 USB 2.0 Internal USB 2.0 2x5 Header

P26 USB 2.0 DASH Internal USB 2.0 2x5 Header

P27 FRONT USB 2.0 Front USB 2.0 Header

P28 FRONT AUDIO Front Audio

P29 Front USB 3.0 Front USB 3.0 Header

P54 SERIAL Serial Port

P60 SATAO AHCI SATAQ Connector

P61 SATAT AHCI SATAT Connector

P62 SCU3 SCU SATA3 Connector

P63 SCU2 SCU SATA2 Connector

P64 SCU1 SCU SATAT Connector

P65 SCUO SCU SATAQ Connector

P70 CPU+MEM FANS CPU and Memory Fans

P80 SASO SAS/SATA Port O

P81 SAS1 SAS/SATA Port 1

P82 SAS2 SAS/SATA Port 2

P83 SAS3 SAS/SATA Port 3

P84 SAS4 SAS/SATA Port 4
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Table C-3 HP Z820 Workstation system board designators (continued)

Designator Name on board Component

P85 SAS5 SAS/SATA Port 5

P86 SAS6 SAS/SATA Port 6

P87 SAS7 SAS/SATA Port 7

P93 FRNT FAN2 Front Fan 2 Header
P94 FRNT FAN1 Front Fan 1 Header
P125 LC1 Liquid Cooling Header 1
P126 LCO Liquid Cooling Header O
SW3 SW3 Rear Power Button/LED
SW50 CMOS Clear CMOS Button
XBT1 XBT1 Battery

XMM1 CPUO-DIMMS8 CPUO Memory DIMM8
XMM2 CPUO-DIMM7 CPUO Memory DIMM7
XMM3 CPUO-DIMMé CPUO Memory DIMM6
XMM4 CPUO-DIMM5 CPUO Memory DIMM5
XMM5 CPUO-DIMM1 CPUO Memory DIMM1
XMM6 CPUO-DIMM2 CPUO Memory DIMM2
XMM7 CPUO-DIMM3 CPUO Memory DIMM3
XMM8 CPUO-DIMM4 CPUO Memory DIMM4
XMM9 CPU1-DIMM1 CPUT Memory DIMM1
XMM10 CPU1-DIMM2 CPU1 Memory DIMM2
XMM11 CPU1-DIMM3 CPU1 Memory DIMM3
XMM12 CPU1-DIMM4 CPU1 Memory DIMM4
XMM13 CPU1-DIMM8 CPUT Memory DIMM8
XMMT14 CPU1-DIMM7 CPU1 Memory DIMM7
XMM15 CPU1-DIMMé CPU1 Memory DIMM6
XMM16 CPU1-DIMM5 CPU1 Memory DIMM5
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